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Overview 

How this Document is Organized 
This document is organized so that you can go quickly to the section you need. Use Ctrl+F to easily find 
the term you are searching for, or see the table below to find the section to help you. 

Section Description Use it when… 

Install Steps to enable BPM in 
Maconomy and People Planner, 
as well as install SAP Business 
Object, and set up Pentaho. 

 You must perform an 
installation and enable BPM in 
Maconomy and People Planner. 

Upgrade Steps to upgrade BPM, including 
ETL, universes and documents, 
and customizations. 

 You must upgrade your BPM 
system. 

Setup and Configuration Provides setup and 
configurations for your BPM 
system, including  

 You need to set up particular 
aspects of your system, such 
as. 

Statutory Provides general statutory setup 
steps as well as country-specific 
setup.  

 You must install or upgrade 
statutory reports or 
components. 

Customizations Details all the ways you can 
extend your BPM system 
through different customizations 
and localization. 

 You want to maximize your 
Maconomy system through the 
various customizations and 
extensions available. 

 You need localization steps.  

System Maintenance and 
Regular Use 

Includes details for performing 
overall maintenance on your 
BPM system, including…. 

 You need to perform routine 
system admin duties, such as 
running regular maintenance. 

Other Setup Miscellaneous setup material.   Review non-typical procedures, 
such as USync installation, and 
using a non-standard web 
server port.  

Troubleshooting Includes troubleshooting as well 
as frequently asked questions 
for key areas of BPM. 

 You have issues or questions 
when running BPM or related 
systems or processes.  

 

 



INSTALL 

BPM Admin Guide 2 

 

INSTALL 
Business Performance Management (BPM) Reporting consists of a collection of universes and standard 
reports. Universes provide actuals, budget amounts, and dimensions for producing standard reports and 
ad hoc queries in Business Objects Web Intelligence. All standard reports run on Maconomy’s 
transactional database through one or more universes. 

This section provides steps for installing BPM Reporting and setting up Maconomy. This process 
includes: 

 Installing and configuring SAP BusinessObjects.  

 Importing universes and reports that are contained in Business Intelligence Archive Resource 
(BIAR) files. 

 Managing users and single sign-on settings. 

 Entering the necessary setup data in Maconomy. 

This data is required for the universes and reports to work correctly. Detailed explanations of the 
setup procedures are included in appendices to this document. 

For specific requirements for hardware, see the documentation for BusinessObjects, Pentaho, 
Maconomy, Oracle, and SQL Server. 

 

 

Tip: This document does not contain information about hardware, sizing, performance tuning, 
or maintenance. 

Note: Access Control 

In BPM, access control applies in the same way as in Maconomy. In BPM Analysis, access 
control is not applied on dimension tables. The reason is that the analysis universes are used 
in another why where fact tables are typically involved in queries. When doing so, access 
control applies in the same way as in Maconomy. 
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Installation Files 

SAP BusinessObjects 
SAP BusinessObjects is required for BPM Reporting, BPM Analysis, and BPM People Planner. 

Installation files for SAP BusinessObjects (including SAP LiveOffice), are located on the download server: 

\\dl\applications\Released\BPM\Business Objects\BO BI 4.2\4.2 SP 8  

Pentaho Data Integrator 
Pentaho Data Integrator is required for BPM Analysis and BPM People Planner. 

Installation files for Pentaho Data Integrator are located on the download server: 

\\dl\applications\Released\BPM\Pentaho\Pentaho Data Integration\Pentaho-8.2-InstallationBundle  

Reporting Packing Unit (RPU) 
The installation package containing BPM is comprised in a zipped folder called a Reporting Packing Unit 
(RPU).  

RPUs are available in zipped format on the DSM under the matching Maconomy version as a sub-
product. 

An RPU is named after the version and solution it contains. For example, 

 rpu.21.sp101.cu001.1.s-std.zip 

The general format of the folder name is: 

rpu.<main version>.<service pack>.<cumulative update>.<build number>.<solution>.zip 

The solutions available are: 

 Standard 

 PSO 

 CPA 

A packing unit has the following content: 

biars This folder contains a BIAR file for Oracle and one for MS SQL Server: 

Example format: 

bpm-<product>.<main version>.<sp>.<cu>.<build 
number>.<solution>.<database>.biar 

 

Furthermore, it contains a file bpmtoc.txt, which is a table-of-content file 

listing the CMS folders, documents, and universes the bpm BIAR files contain. 

css This folder contains the file bpmdefault.css which provides WebI document 

the default BPM style. The file is only necessary to install if changes need to be 
made to the style of documents (see section 0) 

file://///dl/applications/Released/BPM/Business%20Objects/BO%20BI%204.2/4.2%20SP%208%20
file://///dl/applications/Released/BPM/Pentaho/Pentaho%20Data%20Integration/Pentaho-8.2-InstallationBundle%20
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dashboards This folder contains the JSP files and additional files to be installed on the web 

server in order for BPM Reporting Dashboards to function (see section 0) 

dbcheckscripts This folder contains SQL scripts that can be executed on the Maconomy 

database in order to check that Maconomy setup supports BPM. The scripts are 
divided into two sub-folders - one for Oracle and one for MS SQL Server (see 
Deltek Maconomy BPM Functional Setup Guide for details).  

documentation This folder contains detailed documentation of the BPM universes. The 

documentation consists of an HTML file for each universe. This HTML file can be 
viewed in a browser and lists the folders, dimension objects, measure objects, 
attribute objects, and filters that the universe offers. For each object, a 
description is provided. 

etl This folder contains XML files for the ETL of BPM Analysis and BPM People 

Planner, respectively. 

Example format: 

bpm-analysis-etl.<main version>.<service pack>.<cumulative update>.<build 
number>.xml 

performanceviews This folder contains drop and create scripts for the performance views of BPM 

Reporting. Furthermore, it contains scripts for installing the flush mechanism of 
the shared pool. Both performance views and the flush mechanism are installed 
using MConfig. It also contains drop scripts of the old MV-named performance 
views. The files in the folder are merely for documentation or relevant if manual 
installation or deinstallation is needed. 

Licenses 
SAP BusinessObjects installation and Pentaho Installation require license keys and license files, 
respectively. 

All licenses can be requested by contacting Deltek Distribution at HQ-Distribution@deltek.com. 

Certified Versions 
All certified versions of SAP BusinessObjects, Pentaho, and other BPM related tools and platforms are 
stated in the Deltek Maconomy Supported Products document. Specific updates are announced in 
TechNews. 

file:///C:/Users/jennifercarr/AppData/Roaming/Microsoft/Word/HQ-Distribution@deltek.com
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New Installation 

Workflow 
This process of new installation is divided into four main steps, described below. 

 

Enable BPM in Maconomy 
Enabling BPM in MConfig is required for BPM Reporting and BPM Analysis. 

To prepare the Maconomy database for BPM, enabling is needed. The enabling will install the necessary 
database views, triggers, and indexes that BPM uses, on the Maconomy database. 

1. Start MConfig and then select the relevant Maconomy application. 

2. On the Application Configuration dialog box, select the relevant shortname, and click Edit. 

3. On the Shortname Configuration dialog box, enable  

 Reporting to prepare for installing BPM Reporting 

 Business Intelligence to prepare for installing BPM Analysis. 
 
Enabling Reporting will install EX-views and access control views for BPM Reporting. It will 
also install the necessary performance views and for Oracle databases a flushing mechanism 
that automatically cleans up in the shared pool. 
Enabling Business Intelligence will install EX-views, apply transaction time stamps, and 
trigger managing the marking of deleted records in Maconomy for certain tables. 

4. Set a time for when the flushing mechanism is to run.  

 

1
• Enable BPM in Maconomy

2
• Enable BPM in People Planner

3
• Install SAP BusinessObjects

4
• Set up Pentaho Data Integrator

Note: If BPM Reporting or BPM Analysis is already enabled, but there are problems with the 
views, disable it, complete the installation change, and then complete the above steps again 
to reinstall the reporting views, transaction time stamps, and delete triggers. 
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Enable BPM in People Planner 
Enabling BPM in People planner is required for BPM People Planner. 

You have to create a task in PeoplePlanner preparing data for ETL. Follow these steps:  

1. Run CreateExternalViewsMSSQL.sql. This will create the required Views.  

2. Select New Scheduled Task from the ScheduledTasks node in the Views: 

 

3. Create a scheduled task with type Update Reporting Tables: 

 

4. Set schedule for the Task. 

5. Install the PeoplePlannerService (if it is not installed already.) 

To refresh the data immediately, you can open the Scheduled Tasks window. There you can see your 
tasks and you can select the task and press the Execute button. 

Install SAP BusinessObjects 
SAP BusinessObjects is required for BPM Reporting, BPM Analysis, and BPM People Planner. 

Complete the steps of installing SAP BusinessObjects on the reporting server.  

 

To install SAP BusinessObjects: 

1. It is strongly recommended that all Windows programs be closed before running the installation. 
Then, run the installer. 

2. Check prerequisites. Failed critical dependencies must be addressed before the installation can 
continue, while failed optional dependencies might result in some components not installing. 

3. Enter the SAP BusinessObjects BI platform 4.2 product key. 

Note: We are now using “One-Installer” starting from BO 4.2 SP8 Patch 1. You can use this 
installer for Upgrading or Full Installation. For example, you can install BO 4.2 SP8 Patch 1 
directly without the need for BO 4.2 SP8 base. 
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4. Select "Full" for the type of installation. 

5. Select "Configure and install a Sybase SQL Anywhere database." This will serve as the storage 
of data for the SAP BusinessObjects BI platform. 

6. For the Java Web Application Server solution, select "Install the default Tomcat Java Web 
Application Server and automatically deploy web applications." 

7. For the version management, select "Do not configure a version control system at this time." 

8. The succeeding steps will be asking for port numbers but the standard for those are already 
preset in the setup. 

9. Set a name and port number for the SIA node. The node name is usually the name of the 
machine. 

10. Set a port number for the CMS. 

11. Set the administrator account password and cluster key for the CMS. The cluster key is used to 
connect multiple CMS servers together. 

12. If Sybase SQL Anywhere was set to be installed, set the server port and administrator password 
for the Sybase SQL Anywhere database. 

13. Set port information for Tomcat. 

14. Set the HTTP listening port for connecting to WACS and RESTful Web Services. 

15. For the server profiling and diagnostics, select "Do not configure connectivity to SMD Agent." 

16. Select "Do not configure connectivity to Introscope Enterprise Manager." 

17. After the setup, the program is ready to begin the installation of SAP BusinessObjects BI platform 
4.2 SP8 Patch 1. 

 

 

Tip: See the material at the link below for SAP Business Object tutorials. 

http://scn.sap.com/docs/DOC-7725 

http://scn.sap.com/docs/DOC-7725
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When you upgrade to SAP BusinessObjects 4.2 SP8 Patch 1, you must enable JavaScript content in 
Web Intelligence to ensure links to the workspace client work. 

Enable JavaScript Content 

To enable JavaScript content in Web Intelligence, follow these steps: 

1. Log in to the Central Management Console (CMC). 

2. Go to Applications » Web Intelligence. 

3. Select the Enable javascript content into Web Intelligence documents check box. 

4. Click Save. 

Set up BPM Data Warehouse 
Pentaho Data Integrator is required for BPM Analysis and BPM People Planner. Where names for these 
two products differ, it is stated. 

To set up Pentaho Data Integrator, you must:  

 Install Pentaho Data Integration tools 

 Set up kettle.properties 

 Prepare the Pentaho repository 

 Install the ETL 

 Create the Data Warehouse 

Install Pentaho Data Integration Tools 
Pentaho is the third-party tool that is used for data integration. You can download Pentaho Data 
Integration (PDI) from the Deltek download server. 

 

To install Pentaho data integration tools, you must: 

 Do all items listed in “Before You Begin” 

 Perform Pentaho Installation (Server + Client tools) 

 Install Patch 5 for Pentaho Data Integration (Client tool) 

Tip: If you have installed SAP BusinessObjects Business Intelligence 4.1 Support Pack 7 or 
BI 4.2 onward, it is recommended to disable the Enable Memory Analysis feature to improve 
performance. 

If you are using an earlier version on the Windows Platform, enable this feature to prevent a 
possible crash of the Web Intelligence Processing Server. 

Note: Ensure that you have enough RAM and monitor the memory usage of your server. If 
your server runs out of RAM, it will start to use swap, which may cause performance issues. 

If you have limited RAM and you find your server is using swap, keep this feature enabled to 
ensure maximum performance. 
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 Activate the PDI license 

Before You Begin 
Before you begin the installation of Pentaho, you must do the following: 

 Uninstall previous versions of Pentaho. 

 Delete the folders .kettle and .Pentaho, typically located on C:\Users\<username>. 

 Ensure that J2SE Runtime Environment is installed and that the PATH environment variable 
references the Java SE folder. For 64-bit operating systems, you need to have JRE 32-bit 
installed. 

Perform Pentaho Installation 
There are various ways to install Pentaho: Evaluation, Archive, Manual, or Client tools only. This guide 
describes a quick way to start using the evaluation installation. The archive installation is described later 
for backend database customizations. 

 

To install Pentaho: 

1. Run pentaho-business-analytics-8.2.0.0-342-x64.exe to open the installation wizard. 

2. Accept the License Agreement, and then click Next. 

 

3. Select Let me decide for myself, and then click Next. 

4. Select Pentaho Server and Data Integration ETL, and then click Next. 

Note: More information about Pentaho installation is available in the Pentaho documentation. 

https://help.pentaho.com/Documentation/8.2/Setup/Installation
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Pentaho Server will host the repository. Data Integration (ETL) is the client tools. 

5. Select No thanks, I’ll create my own to skip generating sample contents. 

 

6. Enter a password for the Postgres user. 

7. Click Next until finished. 

8. Once finished, a Pentaho Server is installed using tomcat and PostgreSQL as a database with 

Data Integration client tools. 

Activate PDI License 

To activate the PDI License 

1. Log in to the Pentaho User Console.  

2. Click the drop down menu on the upper left side of the screen and select Administration. 
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3. Select the Licenses tab. 

4. In the upper right corner, click the + icon. 

5. Select the following files: 

a. Pentaho BI Platform Enterprise Edition.lic 

b. Pentaho PDI Enterprise Edition.lic 

 
Alternatively, run Install_license.bat from <Installation directory>\Pentaho\license-installer in a 
command prompt or shell. Input the directory of the license files in the command, for example: 

 

Install Patch 5 for Pentaho Data Integration (Client tool) 
This section describes the installation process to update Pentaho Data Integration (Client tool) to Patch 5. 
This is necessary to avoid data type conversion errors when running “Load” and improve stability. 

Before you Begin: 

 Ensure Pentaho Data Integration 8.2 is installed (internal version 8.2.0.0-342). 

 Make sure that Pentaho Data Integration is closed. 

Installation 

1. Run PDIClient-SP-8.2.0.5-625.exe to open the installation wizard. 

2. Accept the License Agreement. 

3. Set the Patch location to where Pentaho Data Integration is installed. 
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4. Click Install. 

5. Once the installation is complete, you should see the following message. 

 

 

Using MS SQL Server as Pentaho Server Database 
This section describes how to change the backend database of Pentaho Server from the default 
PostgreSQL installed by the evaluation installation to MS SQL Server. This is not required when using 
MS SQL Server as data source for the ETL. 

 

Prepare the environment 

1. Extract pentaho-server-ee-8.2.0.0-342-dist.zip. 

2. Run installer.bat as Administrator. 

3. Accept the license term agreement, then click Next. 

4. Change the installation path to <Installation_directory>/Pentaho/server. 

5. A warning message that the directory already exists appears. Click Yes.  
Any existing files in the directory will be retained. 

Configuring MS SQL Pentaho Repository Database 

 

1. Adjust MS SQL Server configuration settings: 

a. Use mixed authentication – on MS SQL Server Management Studio object explorer, 
right-click the server > Properties > Security > select SQL Server and Windows 
Authentication mode. 

b. Enable TCP/IP for MS SQL Server – on SQL Server Configuration Manager > SQL 
Server Network Configuration > Protocols for MSSQLSERVER > right-click TCP/IP > 
Enable. 

c. Configure MS SQL Server to listen on an external IP and not localhost - on SQL 
Server Configuration Manager > SQL Server Network Configuration > Protocols for 
MSSQLSERVER >, right-click TCP/IP > Properties > IP Addresses > Update the IP 
Addresses. 

Note: More information is available here. 

Note: More information is available here. 

https://help.pentaho.com/Documentation/8.2/Setup/Installation/Archive/MS_SQL_Server_Repository
https://help.pentaho.com/Documentation/8.2/Setup/Installation/Archive/MS_SQL_Server_Repository#Configure_MS_SQL_Server_Pentaho_Repository_Database
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2. Navigate to <INSTALL_DIR>\server\pentaho-server\data\sqlserver to find the following SQL 
scripts: 

a. Create_jcr_sqlServer.sql 

b. Create_repository_ sqlServer.sql  

c. Create_quartz_ sqlServer.sql 

3. To change the passwords, go to the pentaho/server/pentaho-server/data/sqlserver/ directory and 
use any text editor to change the passwords in the SQL scripts from item #2. 

4. Run SQL Scripts using Microsoft SQL Server Management Studio in the following order: 

1. File > Open > File…  

2. Select all the scripts. 

3. Execute each script. 

Alternatively, you can run the scripts using sqlcmd  (Requires admin privileges) 

 -i <filepath to DDL>/create_quartz_sqlServer.sql 

 -i <filepath to DDL>/create_repository_sqlServer.sql 

 -i <filepath to DDL>/create_jcr_sqlServer.sql 

5. Verify that databases and user roles have been created: 

a. Open MS SQL Server Management Studio. 

b. In the Object Explorer section of the window, make sure that the Quartz, Jackrabbit 
(JCR), Hibernate, and Pentaho Operations Mart databases are present. 

c. Navigate to Security > Logins and make sure that the appropriate users have been 
created.  

d. Exit the MS SQL Server Management Studio tool. 

Set Up Quartz 

1. Open the <INSTALL_DIR>/pentaho/server/pentaho-server/pentaho-
solutions/system/quartz/quartz.properties file in any text editor. 

2. Locate the #_replace_jobstore_properties section and set the 
org.quartz.jobStore.driverDelegateClass as shown here. 

 

3. Locate the # Configure Datasources section and set the org.quartz.dataSource.myDS.jndiURL 
equal to Quartz. 

4. Save the file and close the text editor. 

Set Hibernate Settings 

 

org.quartz.jobStore.driverDelegateClass =  

org.quartz.impl.jdbcjobstore.oracle.MSSQLDelegate 

org.quartz.dataSource.myDS.jndiURL = Quartz 
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1. Open INSTALL_DIR>/pentaho/server/pentaho-server/pentaho-

solutions/system/hibernate/hibernate-settings.xml file in any text editor. 

2. Change the <config-file> : 

From: <config-file>system/hibernate/postgresql.hibernate.cfg.xml</config-file> 

To: <config-file>system/hibernate/sqlserver.hibernate.cfg.xml</config-file> 

3. Open <INSTALL_DIR>/pentaho/server/pentaho-server/pentaho-

solutions/system/hibernate/sqlserver.hibernate.cfg.xml and update the following properties: 

 

 

Set Audit Log file with SQL Server version 

1. Copy the file <INSTALL_DIR>/pentaho/server/pentaho-server/pentaho-
solutions/system/oracle10g/audit_sql.xml. 

2. Paste and replace the existing audit_sql.xml in <INSTALL_DIR>/pentaho/server/pentaho-
server/pentaho-solutions/system/. 

  

<property 

name="connection.driver_class">com.microsoft.sqlserver.jdbc.SQLServerDriver</property> 

<property 

name="connection.url">jdbc:sqlserver://<Server>:<port>;DatabaseName=<SID></property> 

<property name="dialect">org.hibernate.dialect.SQLServerDialect</property> 

<property name="connection.username">hibuser</property> 

<property name="connection.password"><password></property> 

<property name="connection.pool_size">10</property> 

<property name="show_sql">false</property> 

<property name="hibernate.jdbc.use_streams_for_binary">true</property> Note: Connection.username and connection.password is from create_repository_ora.sql. 
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Set Jackrabbit Repository Information 

1. Open <INSTALL_DIR>/pentaho/server/pentaho-server/pentaho-

solutions/system/jackrabbit/repository.xml file in any text editor 

2. Comment out (<!—code -->) the code section for PostgreSQL and uncomment the Oracle 
counterpart of the following and then update the parameters: 

Code Section 
Repository 

<FileSystem class="org.apache.jackrabbit.core.fs.db. MSSqlFileSystem"> 
 <param name="driver" value="com.microsoft.sqlserver.jdbc.SQLServerDriver"/> 

 <param name="url" value="jdbc:sqlserver://<Server>:<Port>;DatabaseName=jackrabbit"/> 

 <param name="user" value="jcr_user"/> 

 <param name="password" value="password"/> 

 <param name="schemaObjectPrefix" value="fs_repos_"/> 

</FileSystem> 

DataStore 

<DataStore class="org.apache.jackrabbit.core.data.db.DbDataStore"> 

 <param name="url" value="jdbc:sqlserver://<Server>:<Port>;DatabaseName=jackrabbit"/> 

 <param name="driver" value="com.microsoft.sqlserver.jdbc.SQLServerDriver"/> 

 <param name="user" value="jcr_user"/> 

 <param name="password" value="password"/> 

 <param name="databaseType" value="mssql"/> 

 <param name="minRecordLength" value="1024"/> 

 <param name="maxConnections" value="3"/> 

 <param name="copyWhenReading" value="true"/> 

 <param name="tablePrefix" value=""/> 

 <param name="schemaObjectPrefix" value="ds_repos_"/> 

</DataStore> 

Workspaces 
<FileSystem class="org.apache.jackrabbit.core.fs.db.MSSqlFileSystem"> 

 <param name="driver" value="com.microsoft.sqlserver.jdbc.SQLServerDriver"/> 

 <param name="url" value="jdbc:sqlserver://<Server>:<Port>;DatabaseName=jackrabbit"/> 

 <param name="user" value="jcr_user"/> 

 <param name="password" value="password"/> 

 <param name="schema" value="mssql"/> 

 <param name="schemaObjectPrefix" value="fs_ws_"/> 

</FileSystem> 
Persistence Manager (Part 1) 

<PersistenceManager 

class="org.apache.jackrabbit.core.persistence.bundle.MSSqlPersistenceManager"> 

 <param name="url" value="jdbc:sqlserver://<Server>:<Port>;DatabaseName=jackrabbit "/> 

 <param name="driver" value="com.microsoft.sqlserver.jdbc.SQLServerDriver "/> 

 <param name="user" value="jcr_user"/> 

 <param name="password" value="password"/> 

 <param name="schema" value="mssql"/> 

 <param name="schemaObjectPrefix" value="${wsp.name}_pm_ws_"/> 

</PersistenceManager> 

Versioning 
<FileSystem class="org.apache.jackrabbit.core.fs.db.MSSqlFileSystem"> 

 <param name="url" value="jdbc:sqlserver://<Server>:<Port>;DatabaseName=jackrabbit"/> 

 <param name="user" value="jcr_user"/> 

 <param name="password" value="password"/> 
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 <param name="schema" value="mssql”/> 

<param name="schemaObjectPrefix" value="fs_ver_"/> 

</FileSystem> 

Persistence Manager (Part 2) 

<PersistenceManager 

class="org.apache.jackrabbit.core.persistence.bundle.MSSqlPersistenceManager"> 

 <param name="url" value="jdbc:sqlserver://<Server>:<Port>;DatabaseName=jackrabbit"/> 

 <param name="driver" value="com.microsoft.sqlserver.jdbc.SQLServerDriver"/> 

 <param name="user" value="jcr_user"/> 

 <param name="password" value="password"/> 

 <param name="schema" value="mssql"/> 

 <param name="schemaObjectPrefix" value="pm_ver_"/> 

</PersistenceManager> 

 

3. Comment out the DatabaseJournal code section: 

4. Apply JDBC Drivers to the Pentaho Server. 

a. Download the mssql-jdbc-6.2.2.jre8 from <TBD>. 

b. Copy the jar file to <INSTALL_DIR>/pentaho/server/pentaho-server/tomcat/lib. 

  

Note: “password” for jcr_user is the one defined in create_jcr_ora.sql. 

<!-- 

<Cluster id="node1"> 

 <Journal class="org.apache.jackrabbit.core.journal.DatabaseJournal"> 

   <param name="revision" value="${rep.home}/revision.log" /> 

   <param name="url" value="jdbc:postgresql://localhost:5432/jackrabbit"/> 

   <param name="driver" value="org.postgresql.Driver"/> 

   <param name="user" value="jcr_user"/> 

   <param name="password" value="password"/> 

   <param name="schema" value="postgresql"/> 

   <param name="schemaObjectPrefix" value="cl_j_"/> 

   <param name="janitorEnabled" value="true"/> 

   <param name="janitorSleep" value="86400"/> 

   <param name="janitorFirstRunHourOfDay" value="3"/> 

 </Journal> 

</Cluster> 

--> 
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Update Tomcat Context XML File with JDBC Connection 

1. Open <INSTALL_DIR>/pentaho/server/pentaho-server/tomcat/webapps/pentaho/META-

INF/context.xml in any text editor. 

2. Comment out the existing <Resources> in the file and add the following lines: 

 

Note: jdbc/pentaho_operations_mart and jdbc/PDI_Operations_Mart resources needs to be 
included even if it the pentaho_mart_oracle.sql was not run. 

<Resource  

validationQuery="select 1"  

url="jdbc:sqlserver:// <Server>:<Port>;DatabaseName=hibernate" 

driverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver"  

password="password" username="hibuser"  

initialSize="0" maxActive="20" maxIdle="10" maxWait="10000" 

factory="org.apache.tomcat.jdbc.pool.DataSourceFactory"  

type="javax.sql.DataSource" auth="Container" name="jdbc/Hibernate"/> 

 

<Resource  

validationQuery="select 1"  

url="jdbc:sqlserver:// <Server>:<Port>;DatabaseName=hibernate" 

driverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver"  

password="password" username="hibuser"  

initialSize="0" maxActive="20" maxIdle="10" maxWait="10000" 

factory="org.apache.tomcat.jdbc.pool.DataSourceFactory  

type="javax.sql.DataSource" auth="Container" name="jdbc/Audit"/> 

 

<Resource  

validationQuery="select 1"  

url="jdbc:sqlserver:// <Server>:<Port>;DatabaseName=quartz" 

driverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver"  

password="password" username="pentaho_user"  

initialSize="0" maxActive="20" maxIdle="10" maxWait="10000" 

factory="org.apache.tomcat.jdbc.pool.DataSourceFactory  

type="javax.sql.DataSource" auth="Container" name="jdbc/Quartz"/> 

 

<Resource  

validationQuery="select 1"  

url="jdbc:sqlserver:// <Server>:<Port>;DatabaseName=pentaho_operations_mart" 

driverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver"  

password="password" username="pentaho_operations_mart"  

initialSize="0" maxActive="20" maxIdle="10" maxWait="10000" 

factory="org.apache.tomcat.jdbc.pool.DataSourceFactory  

type="javax.sql.DataSource" auth="Container" name="jdbc/pentaho_operations_mart"/> 

 

<Resource  

validationQuery="select 1"  

url="jdbc:sqlserver:// <Server>:<Port>;DatabaseName=pentaho_operations_mart" 

driverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver"  

password="password" username="pentaho_operations_mart"  

initialSize="0" maxActive="20" maxIdle="10" maxWait="10000" 

factory="org.apache.tomcat.jdbc.pool.DataSourceFactory  

type="javax.sql.DataSource"  

auth="Container" name="jdbc/PDI_Operations_Mart"/> 
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Clean Pentaho Server Repository Cache 

The evaluation installation created samples that are still referencing the previous PostgreSQL database. 
This need to be removed for Pentaho Repository to recreate the cache with the right database 
references. Follow these simple instructions: 

1. Stop Pentaho Server. 

a. Open a command prompt. 

b. Run stop-pentaho.bat in <INSTALL_DIR>/server/pentaho-server/. 

2. Navigate to <INSTALL_DIR>/server/pentaho-server/pentaho-solutions/system/jackrabbit/. 

3. Rename or delete the repository folder. 

Start Pentaho Server 

1. Open a command prompt. 

2. Run start-pentaho.bat as Administrator in <INSTALL_DIR>/server/pentaho-server/. 

3. Verify that the server is running by opening Pentaho User Console. In any browser open 
http:<hostname>:<port>/pentaho. 

Using Oracle Server as Pentaho Server Database 
This section will describe how to change the backend database of Pentaho Server from the default 
PostgreSQL installed by the evaluation installation to Oracle database. This is not required when using 
Oracle database as a data source for the ETL. 

 

Prepare the environment 

1. Extract pentaho-server-ee-8.2.0.0-342-dist.zip 

2. Run installer.bat as Administrator 

3. Accept the license term agreement, then click Next 

4. Change the installation path to <Installation_directory>/Pentaho/server 

5. A warning message that the directory already exists appears. Click Yes. Any existing files in the 
directory will be retained. 

Configuring Oracle Pentaho Repository Database 

 

Initialize Values 
1. Navigate to <INSTALL_DIR>\server\pentaho-server\data\oracle10g to find the following SQL 

scripts: 

a. Create_jcr_ora.sql 

b. Create_repository_oral.sql 

Note: More information is available here.  

Note: More information is available here. 

https://help.pentaho.com/Documentation/8.2/Setup/Installation/Archive/Windows_Environment
https://help.pentaho.com/Documentation/8.2/Setup/Installation/Archive/Oracle_Repository
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c. Create_quartz_ora.sql 

2. Edit the above files and uncomment the following lines: 

-- conn admin/password@pentaho 

3. Update the files with the proper database credentials 

Example when connecting to a remote host: 

 

4. Update the default passwords in the SQL scripts 

5. Run SQL Scripts using SQL*Plus (or any Oracle SQL development tool) in the following order: 

 start <INSTALL_DIR>/server/pentaho-server/data/oracle10g/create_jcr_ora.sql 

 start <INSTALL_DIR>/server/pentaho-server/data/oracle10g/create_repository_ora.sql 

 start <INSTALL_DIR>/server/pentaho-server/data/oracle10g/create_quartz_ora.sql 

 start <INSTALL_DIR>/server/pentaho-server/data/oracle10g/pentaho_mart_ora.sql (Optional) 

6. Verify that databases and user roles have been created by running the following in SQL*Plus (or 
any Oracle SQL development tool): 

 

Set Up Quartz 
1. Open the <INSTALL_DIR>/pentaho/server/pentaho-server/pentaho-

solutions/system/quartz/quartz.properties file in any text editor. 

2. Locate the #_replace_jobstore_properties section and set the 
org.quartz.jobStore.driverDelegateClass as shown here. 

 

3. Locate the # Configure Datasources section and set the org.quartz.dataSource.myDS.jndiURL 
equal to Quartz, like this. 

 

4. Save the file and close the text editor. 

Set Up Hibernate Settings 

1. Open <INSTALL_DIR>/pentaho/server/pentaho-server/pentaho-
solutions/system/hibernate/hibernate-settings.xml file in any text editor and then change the 
<config-file>. 

conn admin/password@(DESCRIPTION=(ADDRESS = (PROTOCOL = TCP)(HOST = 
XXXXXXX)(PORT = 1521))(CONNECT_DATA=(SERVER = DEDICATED)(SERVICE_NAME = 
XXXXXXX))) 

 

SELECT USERNAME FROM DBA_USERS; 

org.quartz.jobStore.driverDelegateClass = org.quartz.impl.jdbcjobstore.oracle.OracleDelegate 

org.quartz.dataSource.myDS.jndiURL = Quartz 

create user jcr_user identified by "password" ... 
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From: 

 

To: 

 

2. Open <INSTALL_DIR>/pentaho/server/pentaho-server/pentaho-
solutions/system/hibernate/oracle10g.hibernate.cfg.xml and update the following properties: 

 

 

Set audit log file with Oracle version 

1. Copy the file <INSTALL_DIR>/pentaho/server/pentaho-server/pentaho-
solutions/system/oracle10g/audit_sql.xml. 

2. Paste and replace the existing audit_sql.xml in <INSTALL_DIR>/pentaho/server/pentaho-
server/pentaho-solutions/system/. 

Set Jackrabbit Repository Information 

1. Open <INSTALL_DIR>/pentaho/server/pentaho-server/pentaho-
solutions/system/jackrabbit/repository.xml file in any text editor 

2. Comment out (<!—code -->) the code section for PostgreSQL and uncomment the Oracle 
counterpart of the following and then update the parameters: 

Code Section 

Repository 

<FileSystem class="org.apache.jackrabbit.core.fs.db.OracleFileSystem"> 
 <param name="url" value="jdbc:oracle:thin:@<host>:<port>/<SID>"/> 
 <param name="user" value="jcr_user"/> 
 <param name="password" value="password"/> 
 <param name="schemaObjectPrefix" value="fs_repos_"/> 
 <param name="tablespace" value="pentaho_tablespace"/> 
</FileSystem> 

DataStore 

<config-file>system/hibernate/postgresql.hibernate.cfg.xml</config-file> 

  

<config-file>system/hibernate/oracle10g.hibernate.cfg.xml</config-file> 

  

<property name="connection.driver_class">oracle.jdbc.driver.OracleDriver</property> 
<property name="connection.url">jdbc:oracle:thin:@<host>:<port>:<SID></property> 
<property name="dialect">org.hibernate.dialect.Oracle10gDialect</property> 
<property name="connection.username">hibuser</property> 
<property name="connection.password"><password></property> 
<property name="connection.pool_size">10</property> 
<property name="show_sql">false</property> 
<property name="hibernate.jdbc.use_streams_for_binary">true</property> 

Note: Connection.username and connection.password is from create_repository_ora.sql. 
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Code Section 

<DataStore class="org.apache.jackrabbit.core.data.db.DbDataStore"> 
 <param name="url" value=" jdbc:oracle:thin:@<host>:<port>/<SID"/> 
 <param name="driver" value="oracle.jdbc.OracleDriver"/> 
 <param name="user" value="jcr_user"/> 
 <param name="password" value="password"/> 
 <param name="databaseType" value="oracle"/> 
 <param name="minRecordLength" value="1024"/> 
 <param name="maxConnections" value="3"/> 
 <param name="copyWhenReading" value="true"/> 
 <param name="tablePrefix" value=""/> 
 <param name="schemaObjectPrefix" value="ds_repos_"/> 
</DataStore> 

Workspaces 

<FileSystem class="org.apache.jackrabbit.core.fs.db.OracleFileSystem"> 
 <param name="url" value="jdbc:oracle:thin:@<host>:<port>/<SID"/> 
 <param name="user" value="jcr_user"/> 
 <param name="password" value="password"/> 
 <param name="schemaObjectPrefix" value="fs_ws_"/> 
 <param name="tablespace" value="pentaho_tablespace"/> 
</FileSystem> 

Persistence Manager (Part 1) 

<PersistenceManager 
class="org.apache.jackrabbit.core.persistence.bundle.OraclePersistenceManager"> 
 <param name="url" value="jdbc:oracle:thin:@<host>:<port>/<SID"/> 
 <param name="driver" value="oracle.jdbc.OracleDriver"/> 
 <param name="user" value="jcr_user"/> 
 <param name="password" value="password"/> 
 <param name="schema" value="oracle"/> 
 <param name="schemaObjectPrefix" value="${wsp.name}_pm_ws_"/> 
 <param name="tablespace" value="pentaho_tablespace"/> 
</PersistenceManager> 

Versioning 

<FileSystem class="org.apache.jackrabbit.core.fs.db.OracleFileSystem"> 
 <param name="url" value="jdbc:oracle:thin:@<host>:<port>/<SID"/> 
 <param name="user" value="jcr_user"/> 
 <param name="password" value="password"/> 
 <param name="schemaObjectPrefix" value="fs_ver_"/> 
 <param name="tablespace" value="pentaho_tablespace"/> 
</FileSystem> 

Persistence Manager (Part 2) 
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Code Section 

<PersistenceManager 
class="org.apache.jackrabbit.core.persistence.bundle.OraclePersistenceManager"> 
 <param name="url" value="jdbc:oracle:thin:@<host>:<port>/<SID"/> 
 <param name="driver" value="oracle.jdbc.OracleDriver"/> 
 <param name="user" value="jcr_user"/> 
 <param name="password" value="password"/> 
 <param name="schema" value="oracle"/> 
 <param name="schemaObjectPrefix" value="pm_ver_"/> 
 <param name="tablespace" value="pentaho_tablespace"/> 
</PersistenceManager> 

 

 

3. Comment out the DatabaseJournal code section: 

 

Apply JDBC Drivers to the Pentaho Server 
1. Download the ojdbc8.jar oracle driver. 

2. Copy the jar file to <INSTALL_DIR>/pentaho/server/tomcat/lib. 

Update Tomcat Context XML File with JDBC Connection 
1. Open <INSTALL_DIR>/pentaho/server/tomcat/webapps/pentaho/META-INF/context.xml in any 

text editor. 

2. Comment out the existing <Resources> in the file and add the following lines: 

Note: “password” for jcr_user is the one defined in create_jcr_ora.sql. 

<!-- 
<Cluster id="node1"> 
 <Journal class="org.apache.jackrabbit.core.journal.DatabaseJournal"> 
   <param name="revision" value="${rep.home}/revision.log" /> 
   <param name="url" value="jdbc:postgresql://localhost:5432/jackrabbit"/> 
   <param name="driver" value="org.postgresql.Driver"/> 
   <param name="user" value="jcr_user"/> 
   <param name="password" value="password"/> 
   <param name="schema" value="postgresql"/> 
   <param name="schemaObjectPrefix" value="cl_j_"/> 
   <param name="janitorEnabled" value="true"/> 
   <param name="janitorSleep" value="86400"/> 
   <param name="janitorFirstRunHourOfDay" value="3"/> 
 </Journal> 
</Cluster> 
--> 
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Note: Jdbc/pentaho_operations_mart and jdbc/PDI_Operations_Mart resources 
needs to be included even if it the pentaho_mart_oracle.sql was not run. 

<Resource  
validationQuery="select 1 from dual"  
url="jdbc:oracle:thin:@<host>:<port>/<SID"  
driverClassName="oracle.jdbc.OracleDriver"  
password="password" username="hibuser"  
maxWaitMillis="10000" maxIdle="5" maxTotal="20"  
factory="org.apache.commons.dbcp.BasicDataSourceFactory"  
type="javax.sql.DataSource" auth="Container" name="jdbc/Hibernate"/> 

 
<Resource  

validationQuery="select 1 from dual"  
url="jdbc:oracle:thin:@<host>:<port>/<SID" 
driverClassName="oracle.jdbc.OracleDriver"  
password="password" username="hibuser"  
maxWaitMillis="10000" maxIdle="5" maxTotal="20"  
factory="org.apache.commons.dbcp.BasicDataSourceFactory"  
type="javax.sql.DataSource" auth="Container" name="jdbc/Audit"/> 

 
<Resource  

validationQuery="select 1 from dual"  
url="jdbc:oracle:thin:@<host>:<port>/<SID" 
driverClassName="oracle.jdbc.OracleDriver"  
password="password" username="quartz"  
maxWaitMillis="10000" maxIdle="5" maxTotal="20"  
factory="org.apache.commons.dbcp.BasicDataSourceFactory"  
type="javax.sql.DataSource" auth="Container" name="jdbc/Quartz"/> 

 
<Resource  

validationQuery="select 1 from dual"  
url="jdbc:oracle:thin:@<host>:<port>/<SID" 
driverClassName="oracle.jdbc.OracleDriver"  
password="password" username="hibuser"  
maxWaitMillis="10000" maxIdle="5" maxTotal="20"  
factory="org.apache.commons.dbcp.BasicDataSourceFactory"  
type="javax.sql.DataSource" auth="Container" name="jdbc/pentaho_operations_mart"/> 

 
<Resource  

validationQuery="select 1 from dual"  
url="jdbc:oracle:thin:@<host>:<port>/<SID" 
driverClassName="oracle.jdbc.OracleDriver"  
password="pentaho_operations_mart" username="pentaho_operations_mart"  
maxWaitMillis="10000" maxIdle="5" maxTotal="20"  
factory="org.apache.commons.dbcp.BasicDataSourceFactory" type="javax.sql.DataSource"  
auth="Container" name="jdbc/PDI_Operations_Mart"/> 
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Clean Pentaho Server Repository Cache 
The evaluation installation created samples that are still referencing the previous PostgreSQL database. 
This need to be removed for Pentaho Repository to recreate the cache with the right database 
references. Follow these simple instructions: 

1. Stop Pentaho Server. 

a. Open a command prompt. 

b. Run stop-pentaho.bat in <INSTALL_DIR>/server/pentaho-server/. 

2. Navigate to <INSTALL_DIR>/server/pentaho-server/pentaho-solutions/system/jackrabbit/. 

3. Rename or delete the repository folder. 

Start Pentaho Server 
1. Open a command prompt. 

2. Run start-pentaho.bat as Administrator in <INSTALL_DIR>/server/pentaho-server/. 

3. Verify that the server is running by opening Pentaho User Console. In any browser open 
http:<hostname>:<port>/pentaho. 

Set Up Kettle.Properties 
The ETL for Business Performance Management Analysis utilizes the kettle.properties file to provide 
default values to variables used when running Jobs and/or Transformations. This section will describe the 
parameters that need to be added and the values they should contain. 

The kettle.properties file is located at the following directories by default: 

 For Windows: C:\Users\<username>\.kettle\  

 For Unix/Linux: .kettle folder is placed in the $HOME folder. 

If multiple users are to share the properties, we recommend you to make a copy of the file to another 
commonly accessible folder. Create a new system environment variable KETTLE_HOME and assign the 
path of the file to that variable. After this is done and a Pentaho application is run, the folder .kettle is 
created automatically in the path designated by KETTLE_HOME. Make sure to copy the .kettle.properties 
file down into that folder. 

To set up kettle.properties, you must: 

 Set up parameters for BPM. 

 Test the value is set correctly. 

Set Up Parameters for BPM 

To set up parameters for BPM, follow these steps: 

1. Open kettle.properties in any text editor. 

2. Remove all contents of the kettle.properties, if it is automatically generated. The evaluation 
installer includes pre-defined log schema in the kettle.properties file which conflicts with the 
logging configuration of the ETL provided by Deltek. 

3. If the Maconomy database runs Oracle, add the parameter: 

MAC_CONNECTION_TYPE=ORACLE 
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If the Maconomy database runs MS SQL Server, add the parameter: 
 

MAC_CONNECTION_TYPE=SQL 

4. If the Data Warehouse runs Oracle, add the parameter: 
 
DWH_CONNECTION_TYPE=ORACLE 
 
If the Maconomy database runs MS SQL Server, add the parameter: 
 
DWH_CONNECTION_TYPE=SQL 

5. Add the parameter stating whether to run a full load or an incremental load. 
 
FULL_LOAD=YES 

The FULL_LOAD parameter is not used in the pure standard flows of creating a data warehouse or 
performing a full or incremental load. These Pentaho jobs set the parameter themselves. But if other jobs 
are run the parameter may be read. 

 

Test the Value is Set Correctly 
To test that the value has been set correctly, run the "Test FULL_LOAD variable" transformation. The job 
is part of the BPM Analysis ETL and will be available after you have installed that in section 0.  

Prepare the Database 
The Pentaho Data Integration tool requires the creation of the actual data warehouse database. To 
prepare the Pentaho repository, you must: 

 Create database users in either Oracle or SQL Server. 

 Create storage for BPM People Planner. 

Create Database Users 

To create database users in Oracle: 

1. From the command prompt, run the following: 

sqlplus system/manager 

It may be necessary to specifically connect to the database to be used.  

2. In sqlplus, enter the following: 

create user MACONOMY_DWH identified by MACONOMY_DWH; 

grant dba to MACONOMY_DWH; 

3. If  you do not want to use default database settings for the user’s default table space and 
temporary table space, you can change them with statements such as the following in sqlplus: 

alter user MACONOMY_DWH default table space <x1> temporary table space <y1>; 

where <x1>, <x2>, <y1>, <y2> should be replaced by relevant values. 

Note: Pentaho tools read these variables when starting. Whenever a Pentaho tool is open at 
the moment of resetting the variables, you must restart the tool to use new variable settings. 
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4. To confirm that the settings work, enter the following: 

connect MACONOMY_DWH / MACONOMY_DWH; 

6. Exit sqlplus. 

To create database users in MS SQL Server: 

1. Log in to Microsoft SQL Server Management Studio with the user name sa. 

2. Right-click Databases and create the database MACONOMY_DWH. 

3. In the Options tab, set collation to SQL_Latin1_General_CP1_CS_AS. 

Note: This makes the SQL data warehouse case-sensitive to match with Maconomy database for 
an accurate comparison of data for the ETL. 

4. Expand Security, right-click Logins, and select New Login. 

5. Enter the name MACONOMY_DWH for the login. 

6. Set Authentication to SQL Server Authentication. 

7. Enter a password. 

8. On the left-hand side of the window, click User Mappings. 

9. On the User Mappings dialog box, map the database to the corresponding user. 

10. Specify the role db_owner. 

11. To check that the databases work, log out and then log in again with the data warehouse 
database credentials. 

 

Create Storage for BPM People Planner 
Use the steps above to create storage for BPM People Planner. Replace (what) with the user 
PEOPLEPLANNER_DWH. 

For BPM People Planner other parameters in the kettle.properties file are needed: 

 #DWH_CONNECTION_TYPE = ORACLE 

 DWH_CONNECTION_TYPE = SQL 

 #PP_CONNECTION_TYPE = ORACLE 

 PP_CONNECTION_TYPE = SQL 

 #PP_STAND_ALONE = YES 

 PP_STAND_ALONE = NO 

 # How many years old AvailableHours data should be loaded into DWH 

 PP_ACTUAL_YEAR_RANGE_MIN = 2 

 # How many years in future since current date 

Note: The Oracle database for the BPM data warehouse requires a table space called 
macindex_dwh, where indexes for the DWH are created. This table space must be created in 
addition to the normal table space of MACONOMY_DWH.  

For more information, see Build the BPM Data Warehouse. 
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 # should be loaded for AvailableHours into DWH 

 PP_ACTUAL_YEAR_RANGE_MIN = 2 

The “#” symbol means that all strings following it are comments. By changing its position, you can switch 
which RDBMS system to use to access the DWH database and which one to use for PeoplePlanner. 

Parameter PP_STAND_ALONE defines how PeoplePlanner is used, meaning, is it used in integration 
with Maconomy system or as a standalone system.  

 

The last two parameters define how many years before and after the current date should be loaded in the 
DWH.  

 

Install the ETL 
The ETL (Extract-Transform-Load) is the mechanism which reads (extracts) data from Maconomy or 
People Planner, transforms it, and stores it (loads it) in the data warehouse database. 

The steps below take origin in a data warehouse on Oracle. If the data warehouse is on MS SQL Server, 
change the connection type from Oracle to MS SQL Server accordingly.  

Furthermore, the steps assume the setup of a data warehouse for BPM Analysis (Maconomy). If a data 
warehouse is set up for BPM People Planner, import the DataIntegrationRepository.xml from the 
peopleplanner folder in the RPU. 

To install the ETL, you must: 

 Connect to a Pentaho Server 

 Import the BPM ETL. The file name is DataIntegrationRepository.xml. 

 Standard ETL is under etl\reporting 

 PeoplePlanner ETL is under etl\peopleplanner 

Connecting to a Pentaho Server 

To connect to a Pentaho Server, follow these steps: 

1. Go to Start > Pentaho Enterprise Edition > Data Integration 

2. Click the Connect button on the upper-right corner of the window. 

a. For the first connection, it will open the Repository Manager automatically. 

b. For subsequent connections, select Repository Manager in the drop-down list, then click 
Add. 

3. Click Get Started on the Repository Manager window. 

4. Fill in the details: 

Note: Existing Business Performance Management PeoplePlanner Reporting assumes that 
PeoplePlanner is used in integration with Maconomy – so, the reports do not work for a stand-
alone solution (in this case you will be able to use the DWH only). 

Warning: Remember that for every additional year, a significant number of additional data is 
loaded. Therefore, use these parameters with care and only include the number of years 
required to cover the user’s business needs. 
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a. Display Name – name to identify the connection. 

b. URL – URL to open Pentaho User console. Make sure to enter the correct port no. 

c. Description – additional information to help identify the connection 

5. Click Finish. 

6. A test will be automatically performed, if successful click Connect Now. Otherwise, review the 
connection details. 

7. Log in with username admin and password password. 

Import the BPM ETL 
To import the BPM ETL, follow these steps: 

1. Select Tools > Repository > Import Repository... 

2. Browse to the location of the BPM Analysis or BPM People Planner ETL XML file. 
The file is named DataIntegrationRepository.xml. 

3. At the prompt "Do you want to apply a set of rules to the import?" select No. 

4. Select the root as directory (default). Click OK. 

5. Click Yes to create the suggested folders. The transformations and jobs are now imported. 

6. Click Close. 

Create the Data Warehouse 
This section describes how to create and load the data warehouse. To prepare for creating the data 
warehouse, you must set up the connections to the Maconomy/People Planner database and the data 
warehouse database. Then you must run the ETL job that creates the data warehouse itself. All this is 
done in Spoon. 

To create the data warehouse, you must: 

 Set up a connection to Maconomy / People Planner 

 Set up the Table Space 

 Create the date warehouse 

Set Up a Connection to Maconomy / People Planner 

To set up a connection to Maconomy / People Planner, follow these steps: 

1. Select Tools > Repository > Explore... 

2. Switch to the Connections tab. 

3. Select the Maconomy connection and click . 

Fill in the following fields: 

 Host Name – Enter the name of the Maconomy / People Planner server. 

 Database Name – Enter the name of the Oracle SID or MS SQL Server database name. 

 Tablespace for Data – Enter the name of the tablespace if the default is not used. 
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 Tablespace for Indices – Enter the name of the tablespace for indices if the default is not 
used. 

 Port Number – Enter the port of Maconomy, typically 1521. 

 User Name – Enter the name of the Maconomy database user (short name). 

 Password – Enter the password for accessing the database user. 

4. Click Test to test the connection. Click OK. 

5. Select the DWH connection and click . 

6. Fill in the following fields: 

 Host Name – Enter the name of the Data warehouse server. 

 Database Name – Enter the name of the Oracle SID or MS SQL Server database name. 

 Tablespace for Data – Enter the name of the tablespace if the default is not used. 

 Tablespace for Indices – Enter the name of the tablespace for indices if the default is not 
used. 

 Port Number – Enter the port of Maconomy, typically 1521. 

 User Name – Enter MACONOMY_DWH 

 Password – Enter MACONOMY_DWH 

7. Click Test to test the connection. Click OK. 

8. Click Close. 

Set Up the Table Space 
For BPM People Planner, set up the right table space.  

To set up the table space, follow these steps: 

1. In this transformation you should edit either do the Oracle DWH Variables step or the Oracle 
DWH Variables step (depending upon your DWH connection type) and set the right tablespace 
for the constant DWH_INDEX_TABLESPACE: 
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2. Click OK and Save. 

Create the Data Warehouse 

Before You Begin 

Before you begin this section, note the following: 

 Because the Create job starts by dropping the full data warehouse, it should not be used for 
upgrading a data warehouse. 

 Drop indexes on facts could fail the first time you run this job. If the enhanced reporting views are 
not in place, the job fails. This may take a long time to finish, depending on the size of the 
Maconomy database. 

 Only run the Drop or DropTablesAndViews jobs if you really want to remove the full data 
warehouse completely. Performing a full load does not require running DropTablesAndViews first. 

To create the data warehouse, follow these steps: 

1. Select Tools > Repository > Explore. 

2. Double-click the job Create. 

 

3. Run this job. 

Note: For BPM People Planner the jobs are PP_CreateTablesAndViews and 

PP_LoadData. 
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The above Create job drops the full data warehouse (in case one should already exist), then 
creates tables and views and performs a full load. This could take some time depending on the 
size of the Maconomy / People Planner database. 
 
The job initiates by dropping the data warehouse. If this is the first time this is done, errors may 
occur because the job tries to drop something that does not exist. Ignore these errors. 
 

 

 

Note: For BPM People Planner first run PP_CreateTablesAndViews and then 
PP_LoadData. The PP_DropTablesAndViews removes the People Planner data 
warehouse. 

Note: To verify, open the command prompt, type sqlplus 

maconomy_dwh/maconomy_dwh, and then select table_name from user_tables. 

Note: The People Planner reports and universe use data from Maconomy data 
warehouse and therefore cannot be used when Business Performance Management 
BI for PP is installed in standalone. The universe for standalone mode has not been 
implemented at the moment. 
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Install Universes and Documents 
Universes and documents are required for all three products: BPM Reporting, BPM Analysis, and BPM 
People Planner. The universes and documents for each product are contained in individual BIAR files of 
the RPU. 

The following procedure is the same for the BIARs of BPM Reporting, BPM Analysis, and BPM People 
Planner. 

To install universes and documents, you must: 

 Import BIAR files 

 Set Universe Connection 

Importing BIAR File with Promotion Management 
All BPM Analysis universes, reports, and dashboards are enclosed in the BIAR files, which are imported 
using Promotion Management. 

This section shows how Promotion Management can be used to deploy BPM reports on client systems. 
Promotion Management is a tool that is integrated with the Central Management Console to promote (or 
move) contents such as reports, universes, and connections to other systems. The source system can be 
either be another system or a BIAR file. It can be especially useful for structures in which a client uses 
separate DEV, QA, and Production systems. 

 

Features 

Server-to-Server 

Promotion Management can be used to transfer contents from one server to another. It is similar to Import 
Wizard of BO XI 3.1, but it is web-based and integrated with the CMC. 

LCMBIAR-to-Server (and Vice Versa) 

Both LCMBIAR and BIAR files can be imported to the CMS repository via Promotion Management, but 
only an LCMBIAR can be exported from the CMS. You can do this via the command line. 

Overrides 

Overrides enable the automatic update of connection when contents are transferred from another server 
or BIAR. 

Rollback  

You can restore a part of or the whole promoted content on the repository to its previous state. Note that 
this is only applicable if the source is another system and NOT a BIAR. 

Note: There is a similar tool for transferring content called Upgrade Management tool, but it is 
only available on the server, and its main function is for making BIARs created from previous 
versions usable on BO 4.1. It must be modified to keep it from checking versions; otherwise, it 
throws a version check failed (UMT 20012) error. 
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Scheduling 

You can schedule when content will move to another system. 

LCM CLI 

This command-line interface can be used to run Promotion Management features without the need to 
access CMC. This section shows the steps for how to import and export an LCMBIAR using the LCM CLI 
tool. 

Implementation 

To do a BIAR-to-server promotion: 

1. Log in to the Central Management Console at https://<server>:<port>/BOE/CMC. 

2. On the CMC homepage, find the Manage island at the right side and click Promotion 

Management. 

 

3. Click the Import drop-down and select Import file.  

The Import from file window appears. 
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4. Select File System, then click Browse. 

5. Select the BIAR or LCMBIAR, then click Open. 

6. The text beside the “Browse…” button is updated with the location and file name of the BIAR. 

Click OK to create the new job. 

 
7. A new job with the Source set as “From File” is automatically created. Update the Name and 

Destination of the new job and click Create. 

 

8. All objects from the BIAR are pre-selected, including all dependencies. Click Promote to display 

a new window that contains the Summary, Security Settings, and Test Promote. 

 Select Security Settings — Specify whether there are any rights that must be included for 
the objects to be promoted. 

 Select Test Promote — Select this option to check whether there are any errors in the 
promotion before you click Promote again in Step 8 and commit to the changes. 

9. Click Promote to start the transfer, or Schedule to have the promotion run at a later date (or a 

recurring schedule, depending on the need). 

Setting Universe Connection 
After you import the BIAR file, universes and connections are stored in the CMS. To set database 
connection on the universes, you must create a project and a relational connection, retrieve universe files, 
assign a connection, and publish the universes. 

This is all done in Information Design Tool. In Information Design Tool, a session to the CMS is 
required for certain operations. For information about sessions, as well as for more information and 
guides about creating projects, connections, and handling universe files, see documentation and tutorials 
on Information Design Tool. 

Note: A password can be set for LCMBIAR. Importing a password-protected LCMBIAR 
displays another window that allows a user to input the password. 
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To set a universe connection, you must: 

 Create a project 

 Create a relational connection 

 Retrieve the universe files 

 Set universe connections and publish 

Create a Project 

To create a project (skip this if a project is available already): 

1. Select File » New » Project. 

2. Enter a name for the project. 

3. Select a Project Location. 

This is the folder where universe and connection files are stored in the project. By default, a folder 
under the user’s profile is chosen. If other universe developers are to access the files, it is 
recommended that you select another folder (not under the user profile). 

Create a Relational Connection 

To create a relational connection (skip this if a connection is available already): 

1. Select File » New » Relational Connection. 

2. In the Resource Name window, enter a name for the connection. Click Next. 

3. In the Database Middleware Driver Selection window, choose a database type. 

BPM supports Oracle and MS SQL Server connections. 

For BPM Reporting, you must choose the database type of the Maconomy database. 

For BPM Analysis and BPM People Planner, you must choose the database type of the BPM 
Data Warehouse or People Planner Data Warehouse database, respectively. 

4. In the Parameters window, enter the name of the database user, password, reference to TNS, 
service/database, port number, and SID/database. The parameters required depend on whether 
an Oracle or MS SQL Server connection is chosen, as well as whether a Client, ODBC, or JDBC 
connection is selected. Click Next. 

5. Choose default settings for the next Parameters screen. 

6. Set up the ALL_ROWS hint to speed up performance. Enter the following value for the custom 
property Hint: 
 
/*+ ALL_ROWS */ 
 

7. Enable Cursor Sharing, if needed. Enter the following value for the custom property ConnectInit. 

Tip: See SAP for details about Information Design Tool: 

http://scn.sap.com/docs/DOC-8461 
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 On Oracle connections: 
 
ALTER SESSION SET CURSOR_SHARING = FORCE 
 

 On MS SQL Server connections: 
 
FORCE PARAMETERIZATION 

 

8. Click Finish. A new connection file (type cnx) is added to the project. 

A cnx connection is a local connection and can be used for publishing universes locally on disk. 
However, it is recommended that you publish universes on the CMS. This requires a secure 
connection. 

9. To create a secure connection of the new connection file, right-click the cnx file and choose 
Publish Connection to a Repository. 

10. In the window that appears, browse for the CMS location in which the connection is to be stored. 
For example, select the default Connections folder of the CMS. Click Finish. 

11. A question window appears. Click Yes to retrieve a shortcut file to the secure connection. A 
secure connection file (type cns) is added to the project. 

 

Retrieve the Universe Files 

To retrieve the universe files, follow these steps: 

1. Make sure the project is selected in the Local Projects view. 

2. Select File » Retrieve a Published Universe » From a Repository... 

On many installations, performance is improved by applying Cursor Sharing. However, it can 
reduce performance on some systems.  

If the system has performance issues while Cursor Sharing is disabled, enable it to help 
improve performance. If the system has performance issues while Cursor Sharing enabled, 
disabling it may improve performance. 

Note:  

ALL_ROWS Information 

By default, the Maconomy database is set to retrieve a small number of records at a time for 
each query. This is convenient when entering and working in Maconomy workspaces or 
dialogs where you typically only see 10, 50, or 100 records at a time. However, when 
reporting, it is beneficial to retrieve all records at once, because a report document or 
dashboard is not refreshed until all records are retrieved. 

Cursor Sharing Information 

Often the reports that are run have the same query outline. Oracle and SQL Server can use 
this by saving a template of the queries that are executed. In many cases, this means that 
even if restrictions are changed (and the queries thereby differ), the database can skip the 
analysis of how to execute the queries, such as the creation of the explain plan. For many 
reports, the creation of the explain plan takes most of the time, so there is significant value in 
being able to reuse query templates. 
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3. In the window that appears, browse to the location of the universes. 
If the universe is an old BO 3.1 universe, it has no extension; otherwise, it has a unx extension. 
Retrieving a universe of type unv migrates the universe to the new BI 4 unx format. 
If a BO 3.1 universe should be kept in the BO 3.1 unv format, set connection with the Universe 
Designer tool instead. 

4. Select Save for All Users. Click OK. 
The Universe files (blx and dfx) are retrieved to a timestamp named folder under the project 
folder selected. 

 

Set Universe Connections and Publish 

To set universe connections and publish, follow these steps: 

1. Open the dfx file of a universe. 

2. Click the Connections tab. 

3. Click Change Connection... . 

4. Select the connection file (for example, the newly created cns connection shortcut file). Click 
Finish. 

5. Save the dfx file. 

6. Right-click the blx file and choose Publish » To a Repository. 

7. Optionally, mark areas for checking integrity. Click Next. 

8. Browse to the CMS folder in which the universe is to be published. Click Finish. 
The universe has now been published with the selected database connection. 

9. Continue this process for all universes needed. 

  

Note: If needed, the universe files can be moved to another folder (for example, out of the 
timestamp named folder). However, this may break the local dependency that the blx file 
has to the dfx file and the local dependency that the dfx file has to the cnx/cns file. If this 
happens, open the dfx file and choose the connection again and possibly make some other 
minor change to force Information Design Tool to mark the dfx file as changed. Then save 
the file. Then open the blx file and choose Change Data Foundation. Here select the dfx file 
and possibly make some other small change to force Information Design Tool to mark the blx 
file as changed. Then save the file. 
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UPGRADE 

Upgrade Workflow 
This process of upgrading is divided into three main steps, described in the following. 

 

Upgrade ETL 
Upgrading the ETL is required for upgrading BPM Analysis and BPM People Planner. 

To upgrade the ETL you must: 

 Upgrade the ETL and BPM Data Warehouse 

 Upgrade the ETL and People Planner Data Warehouse 

Before You Begin 
Before upgrading, it is recommended that you make a backup of the ETL and a backup of the data 
warehouse database. 

 

Upgrade the ETL and BPM Data Warehouse 
To upgrade the ETL and BPM Data Warehouse, follow these steps: 

1. Install the ETL of the new RPU. 

2. Run the ETL job Upgrade. 

1
• Upgrade ETL

2
• Upgrade Universes and 

Documents

3
• Upgrade Customizations

Note: Since there are many methods to back up a data warehouse database, and methods 
differ for Oracle and MS SQL, consult your Database Administrators for this task. 
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The Upgrade job truncates the fact tables, upgrades the database schema of the data warehouse, and 
performs a full load. Dimension tables remain unchanged and keep the history of dimensions. 

Back Up the ETL 
To back up the ETL, follow these steps: 

1. Run Spoon.bat. 

2. Select Tools » Repository » Connect... 

3. In the Repository Connection window, select the repository that contains the ETL to back up. 

4. Select Tools » Repository » Export Repository… 

5. Choose a location and a file name for the XML file to be created. 

6. Click Save. 

Upgrade the ETL and People Planner Data Warehouse 
To upgrade the ETL and People Planner Data Warehouse, install the ETL of the new RPU. 
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Upgrade Universes and Documents 
Upgrading universes and documents is required for upgrading BPM Reporting, BPM Analysis, and BPM 
People Planner. 

Upgrading is done by installing the respective BIARs from the new RPU. Before installing, make a backup 
of the CMS, for example, a shape of a BIAR export using Promotion Management. 
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Upgrade Customizations 
Customizations are the responsibilities of the consultant who applies them. There is no automatic 
resolving mechanism that safely upgrades BPM without the risk of overwriting customizations or that 
automatically makes customized BPM components adjust to upgraded BPM components. 

However, there are several precautions that you can take when customizing BPM that help to protect the 
customizations from being overwritten when upgrading. 

The following outline the procedures for upgrading customizations, which include: 

 Upgrading custom ETL 

 Upgrading custom universes 

 Upgrading Custom Documents on Standard Universes 

 Upgrading Custom Documents on Custom Universes 

Upgrading Custom ETL 
Customized ETL is typically create as separate ETL pieces—that is, separate jobs and tasks that are 
called from the standard ETL. When a new standard ETL is installed, any modifications to it are 
overwritten, including the places that called the custom ETL. This link to the custom ETL then must be 
reestablished. The custom ETL itself should have facilities for upgrading to new database schemas of 
tables, and so on. 

Upgrading Custom Universes 
Customized universes are typically created in one of two ways: 

 Copied — A copy of a standard universe. In this case, upgrading is not needed except for 
running refresh structure on the custom universe to update it to fit the present Maconomy 
database. 

 Linked — A universe linking to a standard universe. In this case, there should be no need for 
doing modifications to the custom universe. 

There are exceptions, namely if deprecated elements have been removed from the standard universe or 
that universe has undergone substantial changes, as happens on occasion. 

Also, the custom universe may have introduced tables, objects, and so on, which are also introduced in 
the new standard universe. Therefore, it is always a good idea to inspect the link from the custom 
universe to the standard universe and make sure it is intact. 
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Upgrade Custom Documents on Standard Universes 
Custom documents running on standard universes typically work without any changes. 

If the principles for customization have been followed, installing a new standard package does not 
overwrite custom documents. 

However, as standard universes from time to time may undergo some changes or fixes, or because 
deprecated elements may be removed from universes, it is always recommended to test run custom 
documents and inspect for any issues. 

Upgrade Custom Documents on Custom Universes 
If customizations have been performed following the recommended principles, upgrading to a new BPM 
standard package should not ruin any custom documents or custom universes. 

It is always a good idea to inspect custom documents, and especially universes, to ensure that they are 
still functioning correctly after an upgrade; the Maconomy database could have been changed and made 
custom universe elements invalid or require a refresh of the structure. 
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SETUP AND CONFIGURATION 
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Set Up Maconomy 
You must set up Maconomy before you can take full advantage of BPM Reporting’s features. 

Calendar Day  
Universes and reports in BPM Reporting use dates that refer to the Calendar Day table in Maconomy. To 
use this table, you must specify a system parameter that identifies the starting date of the calendar and 
the number of years for which it should run. 

To set up the calendar day: 

1. Open the System Parameters workspace. 

2. Click Use Calendar Day Table. 

3. Specify the number of years and the start date in the following format: MM/DD/YYYY. 

 

This creates an entry in the CalendarDay table for each date starting with 1/1/1980 and 50 years 
beyond. 

Split Week Time Sheet 
You need to set up the split week time sheets to use BPM Reporting. Split week time sheets are 
mandatory when using monthly time reporting. For more information, see the Deltek Maconomy Online 
Help and Deltek Maconomy Concepts Guide. 

To enable the split week time sheet: 

1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 

2. Double click the Split Week Time Sheet system parameter. 

3. On the System Parameter sub-tab, select the Split Week Time Sheet check box. 

4. Click Save. 

5. Restart the Workspace Client.  
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Reporting Structures 
The Finance universe of BPM Reporting and the General Ledger universe of BPM Analysis use reporting 
structures to structure and filter accounts. 

Reporting Structure for Finance Measures 

To set up dimension grouping: 

1. Open the Option List window. 

2. In the Option List No. field, enter Finance. 

3. In the Name field, enter Standard. 

 

4. Open the Reporting Structures window in the workspace Reporting. 

5. Create a reporting structure with the following settings: 

 Type — Account 

 Option List — Finance 

 Selected Value — Standard 

6. Insert group headers, sub-group headers to provide the desired account structure. 

7. Add accounts to the individual groups of the reporting structure. 

Each group states the header labels for the finance report using the reporting structure. For example, 
account number 1110 is displayed in the group with the top-level header RESULT, then RESULT 
BEFORE EXTR. ENTRIES, REVENUE, and so on. 

 

Note: If using Local Charts of Accounts, reporting structures should be setup for these as well. The 

Type for these is Local Account. 
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Reporting Structures for Cashflow 

 

To select the accounts for which postings are considered as contributing to cash flow (cash flow 
statement): 

1. Open the Option Lists window. 

2. Create an option list named Finance. 

3. Enter a value with the name Cashflow Statement. 

If Business Performance Management Reporting has already been set up in Maconomy, the 
option list might already exist; if so, add only the value Cashflow Statement. 

4. Open the Reporting Structure window in the workspace Reporting. 

5. Create a new reporting structure with the following settings: 

 Type — Account 

 Option List — Finance 

 Selected Value — Cashflow Statement 

6. Create grouping headers and add accounts similar as done above. Cashflow usually only include 
a small subset of accounts. Thereby, the reporting structure works as a filter on accounts in 
addition to providing a hierarchical structure. 

7. Create another reporting structure with the option list value Cashflow Forecasting. 

Reporting Structure for Cashflow Statement Indirect Method 

To create a reporting structure for Cashflow Statement Indirect Method: 

1. Go to Setup » System Setup » Parameters and Numbers » Option Lists. 

2. Click + New Option List. 

3. In the Option List No. field, enter Finance. 

4. Click Create. 

5. On the Options sub-tab, click Add Option or press Ctrl + M. 

6. In the Name and Description fields, enter Cashflow Statement. 

7. Click Save Option (Enter), then click Save Option List (Enter). 

8. Go to Setup » Reporting » Reporting Structures. 

9. Click + New Reporting Structure. 

10. In the Create Reporting Structure dialog, enter the following setting: 

 Name — Cashflow Statement 

 Description — Cashflow Statement Reporting Structure 

 Type — Account 

Note: If Maconomy is already set up for BPM Reporting, this reporting structure may already exist. If 
it does, you do not need to perform the following procedure. 
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 Option List — Finance 

 Selected Value — Cashflow Statement 

If Business Performance Management Reporting has already been set up in Maconomy, the 
option list might already exist; if so, add only the value Cashflow Statement and description. 

11. Click Create. 

12. Insert group headers, sub-group headers to provide the desired account structure, similar as 
done above. Cashflow usually only include a small subset of accounts. Thereby, the reporting 
structure works as a filter on accounts in addition to providing a hierarchical structure. 

a. Add two top-level groups for Net Cashflow and Cash Reconciliation.  

b. Under Net Cashflow, add three sub-level groups for Operating, Investing, and Financing 
Activities. 

c. Then, you can configure the next levels based on your preference. 

Reporting Structure for Dashboard Components 
The dashboard components and dashboards in BPM Reporting also require the same kind of reporting 
structure as is needed for the dashboards in BPM Analysis. The following replicates the setup steps. 
However, it is not necessary to define all dimension categories, only Revenue on level 5 and Gross Profit 
on level 4. Deltek recommends that you set up a meaningful structure that includes all of the groups. 

To classify accounts that are used to calculate finance key metrics: 

1. Open the Option Lists window. 

2. Create an option list with the number Finance and a value with the name Key Metrics. 

If BPM Reporting has already been set up in Maconomy, this option list might already exist. If so, 
add only the Key Metrics value. 

3. Open the Reporting Structure window in the workspace Reporting. 

4. Create a reporting structure with the following settings: 

 Type — Account 

 Option List — Finance 

 Selected Value — Key Metrics 

5. The reporting structure needs to have specific grouping headers and a certain structure. This is 
described below: 

6. Place each account in the group where it belongs. 

Assign To the Value For All Accounts in which 

Grouping 1 NET PROFIT Posted amounts should contribute to the calculation of Net 
Profit. 

Grouping 1 ASSET Posted amounts should contribute to the calculation of 
Assets. 

Grouping 1 LIABILITY Posted amounts should contribute to the calculation of 
Liability. 
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Assign To the Value For All Accounts in which 

Grouping 1 EQUITY Posted amounts should contribute to the calculation of 
Equity. 

Grouping 2 EBIT Posted amounts should contribute to the calculation of EBIT. 

Grouping 3 EBITDA Posted amounts should contribute to the calculation of 
EBITDA. 

Grouping 4 GROSS 
PROFIT 

Posted amounts should contribute to the calculation of 
Gross Profit. 

Grouping 5 REVENUE Posted amounts should contribute to the calculation of 
Revenue. 

Grouping 5 COST Posted amounts should contribute to the calculation of Cost. 

Grouping 5 DEPRECIATION Posted amounts should contribute to the calculation of P&L 
depreciation. 

Grouping 5 INTEREST Posted amounts should contribute to the calculation of P&L 
interest. 

Grouping 5 TAX Posted amounts should contribute to the calculation of P&L 
TAX. 

Reporting Structure for NSAFT 
The NSAFT report uses a reporting structure to group finance data.  

To create a reporting structure for NSAFT: 

1. Go to Setup » System Setup » Parameters and Numbers » Option Lists. 

2. Click + New Option List. 

3. In the Option List No. field, enter Finance. 

4. Click Create. 

5. On the Options sub-tab, click Add Option or press Ctrl + M. 

6. In the Name and Description fields, enter NSAFT. 

7. Click Save Option (Enter), then click Save Option List (Enter). 

8. Go to Setup » Reporting » Reporting Structures. 

9. Click + New Reporting Structure. 

10. In the Create Reporting Structure dialog, enter the following setting: 

 Type — Accounts or Local Accounts 

 Option List — Finance 

 Selected Value — NSAFT 
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11. Click Create. 

12. Insert group headers, sub-group headers to provide the desired account structure. 

13. Add accounts to the individual groups of the reporting structure. 

Grouping Headers  

The grouping headers specified in the reporting structure is mapped to the generated XML file following 
the structure below: 

Tags (attributes indented) Mapping 

  <MasterFiles> 

 

    <GeneralLedgerAccounts> 

 

      <Account> 

 

        <AccountID> [Account No.] 

        <AccountDescription> [Account Description] 

        <StandardAccountID> [Grouping Level 1] 

        <GroupingCategory> [Grouping Level 2] 

        <GroupingCode> [Grouping Level 3] 

      <Account> 

 

    <GeneralLedgerAccounts> 

 

  <MasterFiles> 

 

Reporting Structure for Statement of Changes in Equity 
The Statement of Changes in Equity report uses a reporting structure to group data.  

 

To set up a reporting structure for the Statement of Changes in Equity report:  

1. Go to Setup » Reporting » Reporting Structures. 

2. Click + New Reporting Structure. 

3. Add a group for each of the columns to be displayed. 

Example:  

Column 1: “Share Capital” 

Notes: 

 Only Grouping Level 1 is used for this report. No other grouping levels need to be set for this 
report as it does not utilize them.  

 The reporting structure does not need to have Option List and Option Value set as the report 
prompts the user to select a reporting structure instead. 
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Column 2: “Statutory Reserve” 

Column 3: “Other Reserve” 

Column 4: “Retained Earnings” 

Note: The naming groups and naming of them can be adjusted to your business needs. However, 
it is usually standard to have one group named “Retained Earnings” or something similar. This 
group should include the Year-end-Result Account and all the profit and loss accounts. 

Each of the other groups should include the respective Equity accounts for which you want the 
postings to appear for in the respective columns. 

4. Click Create. 

For more information on the column structure and how it is utilized in the report, see the Deltek 
Maconomy BPM Report Description Guide. 

Aging Principles Setup 
Beginning with version 2.1 (internally 16.0) you must set up aging principles in Maconomy to be able to 
run the various aging reports (WIP Aging, AR Aging, AP Aging, and variants). A number of BPM 
Reporting reports also require this setup, even though they are not—as such—aging reports. This 
includes the various transaction sub-reports to the aging reports and, in general, job cost, AR, and AP 
reports that show balances. 

 

What is an Aging Principle? 
An aging principle is a named collection of aging periods. Each aging period marks the start and end of a 
period. Periods can either be backward- or forward-looking. You use backward-looking periods to display 
aged figures that have passed the statement date; you use forward-looking periods to display figures that 
are after the statement date. 

Periods can also be open intervals such that it is possible to report on aged figures that are more than 90 
days old. For each period you can provide a title that appears as the header for the aging column in the 
aging reports. 

Each aging principle states whether the periods are measured in months or in days. In addition, it states 
whether or not aging is based on the entry date. 

 

Changes to the Standard Reports 
From Maconomy version 2.1.5 and 2.2.1, all standard reports that use an aging principle no longer 
prompt users for an aging principle. Maconomy assumes that certain aging principles have been set up. 

Customized Reports 
If you are upgrading to Maconomy 2.2, you should note that customized reports typically use the aging 
objects that were available before Maconomy 2.2. Those aging periods are hard-coded, and the reports 

Note: The functionality is only used and available in BPM Reporting. 

Tip: For information about how to set up aging principles, see the Maconomy Reference Manual or 
single dialog online help. 
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prompt users to indicate whether they should use the entry date. The hard-coded aging objects are 
deprecated as of Maconomy 2.2. They are located in the DEPRECATED universe class and have 
“DEPRECATED” as a suffix to their titles. 

 

Mandatory Aging Principle Setup 
Version 2.1 of BPM includes a collection of dashboard components that you can combine in different 
ways to create performance dashboards on company and customer levels. These dashboards are also 
embedded in the Workspace Client for the solutions. 

Some of the components assume a specific kind of aging principle. The following procedure shows you 
how to create that kind of aging principle. 

To set up that aging principle: 

1. Open the Option List workspace. 

2. In the Option List No. field, enter Aging Principles. 

3. Enter Dashboards in the Name field. 

 

4. Open the Aging Principles workspace. 

5. Create an aging principle; use any appropriate name. 

6. Enter Aging Principles in the Option List field. 

7. Enter Dashboards in the Selected Value field. 

8. In the table, create four periods. Enter an appropriate title and choose appropriate settings. 

Note: These aging objects are no longer maintained and are not included in the universes after 
the release of version 2.2. It is therefore important to migrate customers’ reports to use aging 
principles instead. 
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Beginning with version 2.1.5, standard reports do not prompt you to select an aging principle. Reports 
that require an aging principle assume that you have set one up, and that you can indicate it via the 
option list and selected value, as explained in the preceding steps. 

These aging principles assume the same Aging Principles option list as described in the preceding 
procedure: 

 WIP Aging reports — Designated by having the value WIP Aging in the Selected List field. 

 AR Aging reports — Identified by having the value AR Aging in the Selected Value field. 

 Aging reports — Identified by having the value AP Aging in the Selected Value field.Utilization-
Specific Setup 

To take full advantage of the utilization facilities in Business Performance Management Reporting 
(including the Utilization and Realization reports and the Utilization universe), you must set up activities 
and employees to comply with the assumptions that are made. 

Employee Utilization Pop-Up Literals 
Some utilization figures are calculated by using the employee utilization pop-up that is defined on 
activities. BPM Reporting complies with the PSO setup, and you should set up Pop-Up Literals 
accordingly. 

To set up employee utilization pop-up literals: 

1. Open the Popup Fields window. 

2. From the drop-down list for Popup field, select Employee Utilization Levels. 

3. Insert the lines that are shown in the following figure. 
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4. For each activity, assign the appropriate pop-up value for Employee Utilization, as shown in the 
following figure. 

 

If other employee utilization literals are needed, you must insert them in the Popup Fields window (see 
the figure that follows step 2 in the preceding procedure). You can then customize the objects in the 
Custom Utilization Figures class to use the literals. 

Fixed Hours Setup for Employees 
Fixed hours are calculated from the week calendars, from the employee revisions, or as the minimum of 
fixed hours that are defined on both. Therefore, you must assign a week calendar to each employee and 
set up fixed hours for both week calendars and employees. 
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To set up fixed hours for employees: 

1. Open the Week Calendars window. 

2. For each week calendar to be referenced by employees, ensure that all of the necessary days 
within the weeks show the appropriate fixed working hours. 

 

3. Open the Employees window. 

4. For each employee, assign a week calendar number to the current employee revision. 

 

5. Assign employee-specific fixed working hours. 
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Derived Dimensions for Employees 
In utilization and realization reports, you can drill down on employees’ dimensions. This is different from 
other reports, where you drill down on the dimensions of transactional entries that to which standard 
dimensions are assigned. For drilling down to be meaningful, you must assign values for all ten standard 
dimensions for each employee. 

To set up derived dimensions for employees: 

1. Open the Derived Dimensions window. 

2. For each employee that is displayed in the upper pane, assign values to all ten standard 
dimensions in the lower pane. 

 

 

Note: Previously, you were required to enable split weeks on time sheets. BPM version 2.1 and 

newer can handle split weeks being enabled or not enabled. 
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Set Up BPM Reporting Images 
To set up BPM Reporting Images, you must copy the files from the images folder of the Reporting 
Packing Unit (RPU) and paste them in the destination folder for graphical images in SAP 
BusinessObjects. 

To copy and paste the image: 

1. Go to images folder of the Reporting Packing Unit (RPU) and copy the image files.  

2. Go to the destination folder for graphical images in SAP BusinessObjects, and paste the image 
files in this folder. 

For example: 

C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\images 
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Set Up BPM Reporting Dashboard Components 
This setup is required for BPM Reporting Dashboard Components only. 

BPM Dashboard Components allows you to view different dashboard components in a window tab. 

To properly view the Company Performance, Customer Performance, and Job Performance workspaces 
in the Workspace Client, copy the BPMDashboards.war file from the download server to the local 
machine. 

To copy and prepare the Dashboard Component iFrames, follow these steps: 

1. Copy the BPMDashboards.war file from the download server and place in an appropriate 
location on the local machine. 

2. Navigate to C:\Business Objects\Tomcat7\conf and update tomcat-users.xml 

3. Insert the following lines between the above  </tomcat-users> end tag. This creates the user 

admin that has the role for manager-gui: 

a. <role rolename="manager-gui"/> 

b. <user username="admin" password="admin" roles="manage-gui"/> 

4. Navigate to the http://<servername>:8080/ Tomcat interface. 

5. Click on the manager webapp link and use the credentials that you created for admin. 

6. In the Deploy directory or WAR file located on the server section, deploy the 
BPMDashboards.war and complete the following: 

 Context Path (required) — (Starts with a backslash (/) and is concatenated with the war 
file name, for example, /BPMDashboards). 

 WAR or Directory URL — (Complete URL of the WAR file to be deployed, including the 
name of the war file, for example, C:\temp\BPMDashboards.war). 

7. Click Deploy. 

8. Once the webapp is deployed, check whether the web app is started. If not, start the web app. 
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STATUTORY 

Statutory Overview 
Maconomy’s Statutory offering supports regulatory requirements in various countries, and includes 
reporting, an audit of compliance analysis for specific countries, and where applicable, setup 
requirements to facilitate an interface with a country’s tax authority website.  

Maconomy provides specific statutory-related functionality relevant within select countries, including tax 
settlement, foreign transactions, and related reports. Additionally, Maconomy’s robust and sophisticated 
extensibility provides extensive capabilities to tailor the solution to specific localized needs. 

Benefits of implementing statutory reporting include: targeted statutory-related reporting; easy interface 
between Maconomy system and a country’s tax authority, where applicable. 

To use Maconomy Statutory, you must perform: 

 Setup by Country 

 

Compliance 
Deltek maintains a foundational ISAE 3000 audit conducted by BDO as a baseline representation of 

Maconomy’s ability to satisfy global statutory requirements. This audit includes standard financial reports, 

financial statements, trial balances, and statements of cash flows in a GAAP/IFRS format.  

Regulatory documents for specific countries detail that country’s requirement with an analysis of 
Maconomy’s compliance, as determined by BDO.  

For details on compliance and Regulatory documents by country, Consultants can get the latest 
information in the following locations:  

Teams 

 Teams » Maconomy Knowledge Center » Area-Statutory 

Product Central 

 Statutory Documents 

Reporting Documents 
See the BPM Report Description Guide for details on specific reports, as well as workflow information.  

BPM Statutory Reports Upgrade 
Valid through Maconomy 2.4.5. From Maconomy 2.4.6 APU and higher, ensure that the Maconomy 
standard extension is installed and go to Statutory Reports Setup. 

Note: This only applies to upgrades from IA SPU to another SPU version or from SPU to APU version. 

To upgrade the Statutory Reports from either a major or a CU version, follow the instructions below: 

Note: IA SPU Installation is no longer required to install the statutory and BPM report support in 
Maconomy. Statutory reports are now part of the APU for Maconomy version 2.5. 

file:///C:/Users/jennifercarr/Documents/1_Maconomy/2.5.1/BPM%20Restructuring/DeltekMaconomyBPMInstallandStatutorySetupGuide.docx%23_Setup_by_Country
https://teams.microsoft.com/l/channel/19%3aae946f9ec93a45e58b7038d6a28d296e%40thread.tacv2/Area-Statutory?groupId=e9ad63a6-1d64-4744-a8c7-1f7fd456cf4f&tenantId=37d75c7a-7cb8-4ef7-8a8f-2108fe6cadbe
https://delteko365.sharepoint.com/sites/ProductCentral/Maconomy/Forms/AllItems.aspx?id=%2Fsites%2FProductCentral%2FMaconomy%2FMessaging%20Guides%20%26%20Internal%20Resources%2FStatutory%20Documents&p=true&originalPath=aHR0cHM6Ly9kZWx0ZWtvMzY1LnNoYXJlcG9pbnQuY29tLzpmOi9zL1Byb2R1Y3RDZW50cmFsL0VweGMtRGZ0NW1OS3ZKa0YxaThzNEc4Qm81QURGaGpZSFE2bjQyMlZDYTRvV3c%5FcnRpbWU9WkY0c25iWkgyVWc
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Workflow of Upgrade 

 

Uninstallation of Existing BPM IA SPUs 
To be able to fully uninstall BPM Statutory Reporting extensions, please note the following parameters: 

 “ - -uninstall-extensions” - This Command only uninstalls custom extensions. 

 “ - - override-extension-features” - This Command used in conjunction with the above 
command but has the <feature_id> parameter. 

 “<feature_id> parameter” - This is used to get the feature ID of the IA SPU, we need to: 

1. Extract the SPU itself to .tar then to folder level. 

2. Go to the path and unzip 
“..\CustomInstallation\JavaExtensions\ia.UKTaxSubmission.extensions.zip” 

3. In the folder, open the content.xml 

 

4. Copy the unit ID with the feature.group suffix.  

Note: There will be other unit IDs per project; we need the unit ID of the whole feature. 

1
•Uninstallation of BPM IA SPUs

2 •Update Registry for Maconomy

3 •Reinstallation of Standard Extensions
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5. Once done, follow the instructions below. 

Example of uninstallation of an IA SPU (UK MTD statutory): 

1. Run the command prompt as administrator. 

2. Go to <Maconomy_INST_DIR>\<shortname>\CouplingService (Or where the CouplingService of 
the said maconomy installation is located). 

3. Run this command (feature ID is only an example): 

“CouplingService.exe --uninstall-extensions --override-extension-features 
com.maconomy.ia.UKTaxSubmission.container.extensions.feature.group -console –noexit” 

 

4. Check if the plugins are already removed in the plugins folder. Otherwise, remove the 
uktaxsubmission and reporting.bpm.util in the plugins folder.(see highlighted example below) 

 

5. Restart the Coupling Service. 

 

Note: The IA SPU name would be the same as the unit ID of the released BPM IA SPU. So for 
example the file spu.20_0.ia_BPMStatutoryReporting244CU13.sp104.tgz would have a 
feature ID of 
com.maconomy.ia.BPMStatutoryReporting244CU13.container.extensions.feature.group 

This only pertains to removing the Java Extensions. The manual deletion of Workspace 
definition files and Dialog Layouts is a different story. You would still need to do that to 
completely wipe out remnants of the SPU. 
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6. Make sure that Workspace Definition and Dialog Layout files for BPM Statutory and UK Tax 
Submission are removed. 

7. In the Maconomy Workspace Client, clear the Client Caching under Preferences. 

8. Restart the Workspace Client. 

Update Registry of BPM IA SPUs for Maconomy 
To remove further remnants of old version of BPM Statutory or UK MTD IA SPUs, follow the instructions 
below: 

1. Run the Registry Editor. 

2. Navigate to the folder below: 

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\PPU 
Maconomy\MaconomyInstallation\Server\Applications\<maconomy 
shortname>\OSGiProducts\Setup\<Coupling Service name> 

3. Find the InstalledJavaExtensions key value and edit. 

 

4. Remove all instances of previous versions for BPMStatutoryReporting and/or UKTaxSubmission. 

Installation of New BPM IA SPUs (SPU to SPU) 
This is only applicable until 2.4.4 CU 22 and 2.4.5 CU 25. 

For upgrading to versions 2.4.4 CU 21 and lower, and 2.4.5CU24 and lower, follow the steps below: 

1. Run MConfig as Administrator. 

2. Select the shortname from which you want to install the new BPM IA SPUs. 

Note: Installation of both BPMStatutoryReporting and UKTaxSubmission would require doing the 
succeeding steps twice. 

3. Install the new version of BPMStatutoryReporting or UKTaxSubmission IA SPU. 

4. Verify that the BPM Statutory Reporitng and/or UKTaxSubmission jar files has been installed: 

For BPM Statutory Reporting: 

com.deltek.maconomy.bpm.belgium.ico_<automatically_generated_version_number>.jar 

com.deltek.maconomy.bpm.belgium.lk_<automatically_generated_version_number>.jar 

com.deltek.maconomy.bpm.belgium.tva_<automatically_generated_version_number>.jar 

com.deltek.maconomy.bpm.france.aef_<automatically_generated_version_number>.jar 

com.deltek.maconomy.bpm.norway.nsaft_<automatically_generated_version_number>.jar 

com.deltek.maconomy.bpm.sweden.sie_<automatically_generated_version_number>.jar 

com.deltek.maconomy.bpm.util_<automatically_generated_version_number>.jar 

For UK Tax Submission: 
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com.deltek.maconomy.bpm.uktaxsubmission_<automatically_generated_version_number>.jar 

com.deltek.maconomy.reporting.bpm.util_<automatically_generated_version_number>.jar 

5. Verify that the Dialog Layouts and Workspace Definition files have been installed successfully 
under the CustomizationDir/Extension folder. 

Upgrade from SPU to APU 
For versions 2.4.4 CU 21 and lower, and 2.4.5 CU 24 and lower upgrading to 2.4.6 or higher of standard 
extensions, follow the instructions below. 

1. Run MConfig as Administrator. 

2. Edit the application name 

3. Scroll down and click OSGI Products. 

4. Edit the Coupling Service used by the application. 

5. Scroll down to (Re) install Java Extensions and select MaconomyDir\JavaExtensions. 

6. Click OK up until the top dialog. 

7. Click Next » Next to install the changes 
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Statutory Reports Setup 
To use statutory reports for any country, you must first set them up using the instructions below.  

Beginning with 2.4.3, you must set up the Maconomy system parameters and coupling service to run all 
statutory reports. 

 

Workflow for Statutory Setup 

 

Statutory Setup Steps 

Set Data Export Path and Server Timeout  
1. In the Maconomy installation folder, go to the designated Coupling Service configuration folder in 

relation to the Maconomy shortname. (i.e. C:\Maconomy\<Maconomy Install 
DIR>\CouplingService\configuration).  

2. Select and open the Server.ini file. 

3. Locate server.timeout.and change the value from 600 (default for 10 minutes) to 2400 (40 
minutes). 

1
•Set data export path and server timeout

2 •Update system parameters for BPM

3 •Enable Background Task

4
•Additional SSI Setup

5
•Restart programs

6
•Follow country-specific instructions

Important: Proper setup must be followed or statutory reports will not work as intended. 
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4. Locate filepath.<file-path-id> = <file path> (This will serve as a template to the BPM export path.) 

5. Create a new uncommented line following the template above and with the file path ID as 
bpmexportpath. (i.e. filepath.bpmexportpath.<Shortname of maconomy 
installation>=C:\BPMSTATFOLDER). 

6. Make sure that system.maintenance is set to false. 

7. Save the file. 

8. Restart the coupling service. 

 

Update System Parameters for BPM 
The statutory reports need to connect to a SAP BusinessObjects Server with the installed BPM package 
to be able to run. 

To set up these system parameters: 

1. Open the System Setup workspace. 

2. Go to the Parameters and Numbers » System Parameter to view the System Parameter tab. 

3. Look for two BPM parameters as shown below: 

 

4. Select each parameter and update the URL textbox with the appropriate http://Servername:Port 

Note: You must use a local drive as BPM Statutory reports are created on the Maconomy server 
only. 
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5. Save both parameters. 

6. Restart the Workspace Client. 

7. BPM Statutory reports can now be seen on the Path: Reporting >> Statutory Reporting 

 

Enable Background Task 
The statutory reports run as background tasks to extract huge amounts of data without compromising 
simultaneous entry in the Workspace Client. Background Tasks are enabled by default. Set the task 
duration as described below.  

To set the Task Duration: 

1. Go to Background Tasks » Management » System Defaults. 

2. In Default Max. Task Duration, enter 40 minutes.  

Additional SSI Setup 
In addition to the SSI Setup detailed in the System Admin Guide, additional steps are necessary to allow 
Trusted Authentication in REST API to run the statutory reports. 

To configure Trusted Authentication for statutory reports: 

1. On the BO server, log in to the Central Management Console (CMC) with administrative 
rights. 



Statutory Reports Setup 

BPM Admin Guide 66 

 

2. Go to Servers area of the CMC Client and open the properties for the Web Application 
Server. 

3. In the Command Line Parameters textbox, look for the parameter -

Dbobj.trustedauth.home and note down its corresponding value. (i.e. "-

Dbobj.trustedauth.home=C:/Program Files (x86)/SAP BusinessObjects/SAP 

BusinessObjects Enterprise XI 4.0/java/pjs/container/bin) 

4. Go to the Authentication Management area of the CMC Client, and on the Enterprise 
tab, scroll down to the Trusted Authentication section. 

5. Under Trusted Authentication: 

a. Click Trusted Authentication is enabled. 

b. Click New Shared Secret. 

c. Enter the number of days for the Shared Secret Validation Period and timeout 
for the Trusted Authentication request.  

d. Click Update to save the settings. 

e. Reopen the Enterprise tab. 

f. Click Download Shared Secret. The File Download dialog box displays. 

g. Click Save and copy the TrustedPrincipal.conf file to: 

<INSTALLDIR>\SAP BusinessObjects Enterprise XI 4.0\win32_x86\ 

<INSTALLDIR>\SAP BusinessObjects Enterprise XI 4.0\win64_x64\ 

The Trusted Authentication Home folder as mentioned in Step 3 (i.e. C:/Program Files 

(x86)/SAP BusinessObjects/SAP BusinessObjects Enterprise XI 4.0/java/pjs/container/bin). 

h. Restart the SIA. 

 

After this is completed, you must enable Trusted Authentication on the Coupling Service. To do so: 

1. Update the OSGi settings in MConfig.  

2. Select the Trusted Authentication check box, and then copy the value of the shared 
secret inside TrustedPrincipal.conf to the Password from the preceding list. 

Restart Programs 
After SSI setup, you must restart the following programs: 

1. Tomcat  

2. Server Intelligence Agent (SIA) 

Follow Country-Specific Instructions 
1. Click Ctrl + F to search for the country. 

2. Follow the country-specific instructions as needed.   

Note: There is a chance the generated Shared Secret will be too long and will cause an 
unnecessary line break. If this happens, generate a new Shared Secret. 



Statutory Reports Setup 

BPM Admin Guide 67 

 

Belgium 
See Statutory Reports Setup to begin. 

Revision History / What’s New 
The table below shows a quick reference of updates.  

Update  Version Description 

 

2.5.3 

 

Tax Declaration Report 

Define tax declaration fields for the Tax Declaration report that lists financially posted amounts and their 
tax amounts, for a specific company and fiscal year. Maconomy automatically creates tax report records 
when posting amounts and each record has a field that states which tax declaration box to place the tax 
amount in the tax declaration. 

Setup in Maconomy 

To enable this feature: 

1. Go to System Setup » System Information » Finance. 

2. Select the Extended Tax Reporting parameter check box. 

3. Go to General Ledger » Tax » Tax Report Fields and create the tax declaration fields. 

4. Go to General Ledger » Tax » Tax Report Specification and specify the amounts that should 
go into the fields. 

5. Perform postings as usual.  

 

Setup in Tax Authority 

Not applicable for this report. 

France 
See Statutory Reports Setup to begin. No Additional Setup Required. 

Revision History / What’s New 
The table below shows a quick reference of updates.  

Update  Version Description 

Note: If you need to reference the XML schema for the report, refer to the Deltek BPM Description 
Guide.  



Statutory Reports Setup 

BPM Admin Guide 68 

 

 

2.5.3 
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Germany 
See Statutory Reports Setup to begin. No Additional Setup Required. 

Revision History / What’s New 
The table below shows a quick reference of updates.  

Update  Version Description 

Elster Report 2.5.4  Added Elster report setup 

Elster 
Setup in Maconomy for the Elster USTVA report includes: 

 System Parameter Setup 

 Workspace Client BPM System Setup 

 Tax Settlement Setup 

 Popup Field Setup 

 Option List Setup 

 Tax Code Setup 

 Company Setup 

 Layout Changes on Report Criteria Dialog 

 Fiscal Year Setup 

 Country Setup 

Setup in Maconomy 

System Parameter Setup 

Tax Period or Tax Entry Date Setup 

USTVA offers the flexibility to report on either tax entry dates or periods. 

To enable this parameter: 

1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Use Entry/Period Dates for Statutory Reports parameter. 

3. On the System Parameter sub-tab, select the Use Entry/Period Dates for Statutory Reports 
check box. 

Parameter Description 

Use Entry/Period Dates for Statutory 
Reports 

Select this parameter to use entry dates for 
companies. 
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Deselect this parameter to use tax settlement 
dates for companies. 

Note: The Use Entry/Period Dates for 
Statutory Reports checkbox in the Company 
Specific Values sub-tab should not be used 
and does not have any impact on the report. 

Workspace Client BPM System Setup 

In order for the Statutory workspace to appear in the Workspace Client, you must perform the following 
steps:  

1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 

2. Search for BPM. 

3. Select BPM Server REST API URL 

4. Supply the necessary URL in the field using the format http://<SERVERNAME>:####  

(For example, http://<SERVERNAME>:6405). 

5. Go back to the search results and select BPM Server URL. 

6. Enter the server URL value in the BPM Server URL field using the format visible in the Remarks 
field below. 

Note: The standard value is: http://<SERVERNAME>.ads.deltek.com:8080. 

Tax Settlement Setup 

Tax settlement entries should be set up, created and approved to be able to fetch data for the report. 

To set up the tax settlement entries: 

1. Go to Single Dialogs » General Ledger » Tax » Tax Settlement. 

2. Click Create Settlement.  

Popup Field Setup 

Tax Popup 1 Setup 

Note: Be aware that the following setup will cause a conflict if Elster is used along with UK MTD statutory. 

Tax Popup 1 is used to define whether an entry should be considered Goods or Services. 

To select Goods or Services for this popup: 

1. Go to Single Dialogs » Set-Up » Set-up » Popup Fields 

2. Search for and double-click Tax Popup 1. 

3. On the Values sub-tab, select either the Goods or Services checkbox in the Boolean 1 column. 

Popup Field Description 

Tax Popup 1 Select Boolean 1 checkbox if using for 
Services. 

Leave Boolean 1 unselected if using for 
Goods. 
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Option List Setup 

Option list setup is used to handle situations where kz lines are duplicated due to tax code similarities and 
to avoid using the same values. 

To view and update the option list:  

1. Go to Single Dialogs » Set-Up » Set-up » Option Lists 

2. Locate ELSTER in the Option List No. column and click it. 

3. In the Options sub-tab,  the Option Name must match the Tax Code name. 

Important: The Remarks 1 value must correspond to the intended kz line number for the associated 
Option Name.  

4. Click Save. 

Example:  

Option Name Remarks 1 

0% Services 21 

0% Goods 41 

19% Services 81 

7% 86 

19% Goods 89 

0% Goods EU 91 

7% Goods 93 

19% Non EU Goods or Services 66 

19% EU Services 46 

0% Goods or Services 45 

Note: Option Name is equal to the Tax Code created in Tax Code or GL Tax Code workspace for a 
specific kz line number and Remarks 1 is for the actual kz line number in which the Option name is 
related. 

Tax Code Setup 

Tax Code and Tax Table Setup 

To further categorize the tax codes, additional setup is needed in the Tax Code and G/L Tax Code tables. 

To set up tax codes:  

1. Go to Single Dialogs » General Ledger » Tax » Tax Codes or  G/L Tax Codes. 

2. Select an existing tax code from the List of Tax Codes or List of G/L Tax Codes tables, or add a 
new tax code. 
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Note: Make sure that the name of the tax code or G/L tax code selected matches the Option 
name that is added in the Option List Setup section.  

Remember to set the Tax Popup 1 of the tax code in the Popup 1 field as outlined in the Popup 
Field Setup section. 

3. Click Save. 

Tax Reporting Unit Setup 

To handle transactions from different companies, Tax Reporting Unit setup is used as part of the 
Company setup. With this, USTVA is capable of consolidating the transactions of every company under a 
specific Tax Reporting Unit. 

To add a Tax Reporting Unit:  

1. Go to Single Dialogs » General Ledger » Tax Reporting Units. 

2. Add a Tax Reporting Unit. 

3. Complete all necessary fields.  

4. Click Save. 

Note: It is ideal for the report to have the same Company Tax ID for all companies under the same Tax 
Reporting Unit. Companies with the same Tax ID number normally belong to the same VAT group for 
reporting purposes. This means that all companies that share the same Tax ID number file a single, 
consolidated VAT report and entries appear in Tax Settlement for all companies. The report may not 
contain correct data if companies under a single Tax Reporting Unit have different Tax IDs. 

If you have noted the potential for error and wish to proceed, the Company Tax No. value that appears in 
the Selection Criteria island will be the value that appears in the file. 

Company Setup 

In addition to standard setup of Company Information, the following fields must be set up correctly in 
order to be visible in the output file.  

To add these values, go to Single Dialogs » General Ledger » Set-up » Company Information. 

Intercompany Settlement Island 

Field Name 

Customer 

Vendor 

Tax Reporting Unit Island 

Field Name 

Tax Reporting Unit Table 

Settlement 

Tax Island 

Field Name 
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G/L Tax Table 

Tax Table 

Fiscal Year Setup 

The fiscal year is set up in the Company Information workspace. 

To set the fiscal year:  

1. Go to Single Dialogs » General Ledger » Set-up » Company Information. 

2. In the Company Information sub-tab, under General Ledger, select: 

a. Fiscal Year Template 

b. Fiscal Year (starting date) 

Fiscal year can be configured in the Fiscal Year Template and Fiscal Year workspace if a company is 
using an odd fiscal year. 

Fiscal Year Start Date must be the start date of the Fiscal Year Template in Company Information. 

Note: All companies under the same Tax Reporting Unit must follow the same fiscal year. 

Country Setup 

To distinguish countries that are members of the European Union (EU) from the rest of the world, you 
must note them in Maconomy. 

To mark a country as part of the EU: 

1. Go to Single Dialogs » Set-up » Setup » Countries. 

2. In the List of Countries tab, click Germany. 

3. In the Countries sub-tab, select Member of EU.  

Setup in Germany Tax Authority  

No additional setup is required. 

Mappings 

USTVA 

This report utilizes the Tax Settlement universe. The following objects are identified as part of the 
queries.xml.  

Report Field Name Maconomy Mapping & Description 

<Elster>  

   <TransferHeader> Note: Transfer header is only used for when the integration to 
Elster is done. The same goes for all elements under this group  

Optional 

      <DatenArt> Description: This field shows the Data Type (Optional) 
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Report Field Name Maconomy Mapping & Description 

Hardcode “USTVA” 

       <Vorgang> Description: This field shows the Process (Optional) 

Hardcode “send-Auth” 

      <Testmerker> Description: Test notator, whether the file is a test or not 
(Optional) 

Code:If Testmerker checkbox = true  

“Ja” Else map NULL 

      <VersionClient> Description: This is the maconomy version 

Code: “21.0.104.0” 

Optional 

   </TransferHeader>  

   <DatenTeil> Description: This field block shows the data part of USTVA 
(Optional) 

      <Nutzdatenblock> Optional 

         <NutzdatenHeader version=“11” > Attribute Code:  

hardcode version = “11” 

Optional 

            <Empfaenger id="F"> Description: This field shows the Receiver information with ID. 
This has a static value of “F”. (Optional) 

Code: id = Hardcode “F”. 

         </NutzdatenHeader>  

      <Nutzdaten> Optional 

         <Anmeldungssteuern xmlns=”” 
version="" > 

Description: This field shows specific information for USTVA. 
Version attribute is derived from current year and a hardcode “01” 
(Optional) 

Attribute Code: 

 xmlns="http://finkonsens.de/elster/elsteranmeldung/ustva/v2021" 

Attribute Code: version = Current year 

Both Mandatory 

Data Type: String 

Note: We did not change anything from the schema 
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Report Field Name Maconomy Mapping & Description 

               <Erstellungsdatum> Description: This field shows the start date of the report 
(Optional) 

Values either: Start date of the month or the quarter in the 
Selection criteria (YYYYMMDD) if period or Start date in the 
Selection criteria (YYYYMMDD) if entry date 

Data Type: String 

               <DatenLieferant> Description: This field shows the Company Information for single 
company transactions or Tax Reporting Unit information for 
multiple company transactions (Optional) 

Condition: IF Tax Reporting Unit is Entered  in Selection Criteria 

       (IF Company > 1  

            Tax Reporting Unit Information (see field values below) 

        ELSE  

           Company Information (see field values below) 

      ) 

                  <Name> Description: This fields shows the Tax Reporting Unit Name for 
multiple companies or Company Name for single company. 
(Optional) 

Values either: Tax Reporting Unit\TaxReportingUnitName or 

Company\Company Name 

Length: 

Minimum = 1 

Maximum = 45 

Data Type: String 

                  <Strasse> Description: This fields shows the Tax Reporting Unit Tax Office 
1 for multiple companies or Company Address 1 for single 
company.  (Optional) 

Values either: Tax Reporting Unit\ Tax Office 1 or 
Company\Contact Informaiton\Name2 

Length: 

Minimum = 1 

Maximum = 30 

Data Type: String 

                  <PLZ> Description: This fields shows the Tax Reporting Unit Tax Office 
2 for multiple companies or Company ZipCode for single company 
(Optional) 
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Report Field Name Maconomy Mapping & Description 

Values either: Tax Reporting Unit\ Tax Office 2 or Company\ 
Contact Informaiton\ZipCode 

Length: 

Minimum = 1 

Maximum = 12 

Data Type: String 

                  <Ort> Description: This fields shows the Tax Reporting Unit Tax Office 
3 for multiple companies or Company Postal District for single 
company.  (Optional) 

Values either: Tax Reporting Unit\ Tax Office 3 or Company\ 
Contact Informaiton\Postal District 

Length: 

Minimum = 1 

Maximum = 30 

Data Type: String 

                  <Telefon> Description: This fields shows the Tax Reporting Unit Tax Office 
4 for multiple companies or Company Telephone for single 
company. (Optional) 

Values either: Tax Reporting Unit\ Tax Office 4 or Company\ 
Contact Information\Telephone 

Length: 

Minimum = 1 

Maximum = 20 

Data Type: String 

                  <Email> Description: This fields shows the email specified from the 
Selection Criteria. (Optional) 

From Selection Criteria 

Length: 

Minimum = 1 

Maximum = 70 

Data Type: String 

               </DatenLieferant>  

               <Steuerfall> Description: This field block shows the Tax related information 

(Optional) 
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Report Field Name Maconomy Mapping & Description 

                  
<Umsatzsteuervoranmeldung> 

Description: This field block shows information for USTVA 
(Optional) 

                     <Jahr> Description: This field shows the Start Year used in the Selection 
criteria (Optional) 

Value: Start year based on Selection criteria  (YYYY)  

Data Type: String 

                     <Zeitraum> Description: This field shows the two-digit integer code for 
Monthly Period  or Quarterly Period  (Optional) 

Value: 01-12 for monthly period or 41-44 for quarterly period 

Optional 

Data Type: String 

              <SteuerNummer> Description: This fields shows the Company Tax No. (Optional) 

Value: Company/Tax No. 

Data Type: String 

                    <Kz09> Description: 5-digit manufacturer ID assigned to Deltek Germany  

Value: hardcode ”21651” 

Mandatory  

Length: 

Minimum = 5 

Maximum = 95 

Data Type: String 

                    <Kz10> Description: Corrected registration 

Value: Selection Criteria 

Code: IF checkbox Corrected Registration is marked THEN map 
“1” otherwise no xml tag for the kzline 

Data Type: String 

                     <Kz21> Description: Non-taxable services rendered to businesses in 
other EU-Member States (18b sent. 1 no. 2 German VAT Act). Kz 
21 relates to non-taxable supplies of services to entrepreneurs 
established in the European Union solely. Therefore, domestic 
German non-taxable transactions are not to be reported in Kz 21. 
As the transactions are non-taxable, there is no reporting 
obligation in the preliminary German VAT return and thus, no non-
taxable domestic German transactions are covered in the 
preliminary German VAT return. (Optional) 
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Report Field Name Maconomy Mapping & Description 

 Code:IF VATPopup1 = Services AND VATRate = 0% AND BillTo 
Customer Country != Germany AND BillTo Customer EU Member 
= Yes THEN 

Settlement\ Basis Amounts\ Tax Basis\ Tax Basis – Company 

Data Type: BigInteger 

Max Length: 13 

                     <Kz22> Description: Vouchers will be submitted separately (from 2006). 
Documents (invoices, contracts, etc.) are attached or are being 
provided separately (if yes, please enter "1") (Mandatory) 

Value: Selection Criteria 

Condition: IF checkbox kz22 is marked THEN map “1” otherwise 
no xml tag for the kzline 

Data Type: String 

                       <Kz23> Description: In addition to the information in the tax return, other 
or different information or facts must be taken into account (if yes, 
please enter a "1"). This fields shows the Needs additional 
Information field in the Selection criteria. 

Value: Selection Criteria 

Condition: IF checkbox Needs Additional Information is marked 
THEN map “1” otherwise no xml tag for the kzline 

Data Type: String 

                       <Kz23_Begruendung> Description: This fields shows the Additional Information on Tax 
Registration field in the Selection criteria. (Optional) 

Value: Manually entered in Selection criteria 

Length: 

Minimum = 1 

Maximum = 180 

Note: When Needs additional Information checkbox in the 
selection criteria is not ticked, this field will not populate 

Data Type: String 

                     <Kz26> Description: The SEPA Direct Debit Mandate shall be revoked by 
way of exception (e.g. due to offsetting requests) for this reporting 
period (Mandatory) 

Value:Selection Criteria 

Condition: IF checkbox SEPA-Direct Debit Mandate Payment is 
marked THEN map “1” otherwise no xml tag for the kzline 

Data Type: String 
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Report Field Name Maconomy Mapping & Description 

                     <Kz29> Description: A refund amount is transferred to the account 
provided to the tax authorities, insofar as the amount is not offset 
against outstanding tax liabilities. Amount to be refunded is to be 
offset / amount to be refunded is assigned (if yes, please enter "1") 
(Mandatory). Settlement of the refund amount desired / Refund 
amount is assigned 

Value:Selection Criteria 

Condition: IF checkbox Settlement of the refund amount desired / 
Refund amount is assigned is marked THEN map “1” otherwise no 
xml tag for the kzline 

Data Type: String 

                     <Kz39> Description: Deduction of the assessed prepayment for the 
application of a permanent filing and payment extension. (usually 
only to be considered in the last periodic VAT return of the tax 
period) (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigDecimal 

                     <Kz41> Description: Intra-Community supplies of goods (section 4 no. 1 
letter b German VAT Act) to customer with VAT-ID No. (Optional) 

Condition: IF BillToCustomerEUMember = Yes AND VATPopup1 
= Goods AND VATRate = 0.0% AND Bill to Customer Tax No > 0 
AND Bill To Customer <>Germany THEN 

Settlement\ Basis Amounts\ Tax Basis\ Tax Basis – Company 

Note: When Bill To Customer Tax No is empty, kz41 will not 
populate 

Data Type: BigInteger 

Max Length: 13 

                     <Kz42> Description: Supplementary information on sales. Supplies of the 
first customer in an intra-Community triangular transaction (section 
25b German VAT Act) (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigInteger 

Max Length: 13 

                     <Kz43> Description: Further tax-exempt sales with input tax deduction 
(eg export deliveries, sales according to § 4 Nos. 2 to 7 UStG) The 
domestic German transactions which are zero-rated/tax exempt 
are either declared in Kz 43 or 48 depending on the paragraph for 
the zero-rating/tax exemption (Optional) 

Value:Manually entered via Selection criteria 
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Report Field Name Maconomy Mapping & Description 

Data Type: BigInteger 

Max Length: 13 

                     <Kz44> Description: Intra-Community deliveries of new vehicles to 
customers without VAT ID. (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigInteger 

Max Length: 13 

                     <Kz45> Description: Other non-taxable sales (place of supply not in 
Germany) (Optional) 

Condition: IF BillToCustomer Country <> Germany AND 
VATPopup1 = Goods/Services/Blank and VATRate = 0%  AND 
TaxCountry <> Germany AND BillToCustomer EU Member <> 
Yes THEN 

Settlement\ Basis Amounts\ Tax Basis\ Tax Basis – Company 

Data Type: BigInteger 

Max Length: 13 

                     <Kz46> Description: Taxable services rendered by businesses in other 
EU-Member States (section 13b (1) German VAT Act) (Optional) 

Condition: IF TaxCountry <> Germany AND VATPopup1 = 
Services AND EUAcquisition = Yes AND Vendor EU Member = 
Yes THEN  

Settlement\ Basis Amounts\ Tax Basis\ Tax Basis – Company 

Data Type: BigInteger 

Max Length: 13 

                     <Kz47> Description:  Tax Deductible amount of Kz46 (Optional). 19% 
VAT rate 

Condition: IF TaxCountry <> Germany AND VATPopup1 = 
Services AND EUAcquisition = Yes AND Vendor EU Member = 
Yes THEN  

Settlement\Tax Amounts\Tax Deductible\Tax Deductible – 
Company 

Data Type: BigDecimal 

                     <Kz48> Description: Tax-free sales without input tax deduction according 
to § 4 Nos. 8 to 28 UStG. The domestic German transactions 
which are zero-rated/tax exempt are either declared in Kz 43 or 48 
depending on the paragraph for the zero-rating/tax exemption. 
(Optional) 

Value: Manually entered via Selection criteria 
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Report Field Name Maconomy Mapping & Description 

Data Type: BigInteger 

Max Length: 13 

                     <Kz49> Description: Intra-Community deliveries of new vehicles outside a 
company (§ 2a UStG) (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigInteger 

Max Length: 13 

                     <Kz59> Description: Deduction of input tax for intra-Community deliveries 
of new vehicles outside a company (§ 2a UStG) as well as of small 
businesses within the meaning of § 19 Abs. 1 UStG (§ 15 Abs. 4a 
UStG) (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigDecimal 

                     <Kz60> Description: Other sales for which the recipient of goods and 
services owes VAT incurred pursuant to the German Reverse 
Charge provisions (section 13b (5) German VAT Act) (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigInteger 

Max Length: 13 

                     <Kz61> Description: Input VAT arising from intra-Community acquisition 
of goods .This line should include the VAT on intra-community 
acquisitions of goods (calculated from Boxes 89, 93 and 96, 98, i. 
e. lines 33-35) that can be reclaimed by the filing 
company/taxpayer as input VAT. VAT ONLY (Optional) 

Condition: VAT of Kz89 + VAT of  Kz93 + Kz98 + Kz96 

Where:  

 Kz89 and kz93 have calculated VAT not display in the xml 
file 

 Kz98 and kz96 are manually entered in the selection 
criteria 

Data Type: BigDecimal 

                     <Kz62> Description: Import VAT paid (section 15 (1) sent. 1 no. 2 
German VAT Act) (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigDecimal 

                     <Kz63> Description: Input VAT amounts calculated according to general 
average rates (sections 23 and 23a German VAT Act) (Optional) 



Statutory Reports Setup 

BPM Admin Guide 82 

 

Report Field Name Maconomy Mapping & Description 

Value: Manually entered via Selection criteria 

Data Type: BigDecimal 

                     <Kz64> Description: Adjustment of input VAT deduction (section 15a 
German VAT Act) (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigDecimal 

                     <Kz65> Description: Tax due to change of taxation type and form as well 
as after tax on taxed down payments due to tax rate increase 
(Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigDecimal 

                     <Kz66> Description: Input VAT as shown on purchase invoices issued by 
other businesses (section 15 (1) sent. 1 no. 1 German VAT Act), 
from supplies in the meaning of section 13a (1) no. 6 German VAT 
Act (section 15 (1) sent. 1 no. 5 German VAT Act) and arising from 
intra-Community triangular transactions (section 25b (5) German 
VAT Act) This box should include input VAT that can be reclaimed 
from invoices received from other entrepreneurs as well as from 
the second supply of goods in an intra-Community triangular trade 
(for which the transport ended in Germany) (Optional) 

      

Condition: IF EUAcquisition <> Yes AND VATPopup1 = 
Goods/Services/Blank AND TaxSettlementType =Tax Receivable 
THEN 

Settlement\ Tax Amounts\ Tax Amount – Company 

Data Type: BigDecimal 

                     <Kz67> Description: Input VAT incurred due to Reverse Charge 
provisions (section 15 (1) sent. 1 no. 4 German VAT Act)  
(Optional) 

Same as Kz47 

Data Type: BigDecimal 

                     <Kz69> Description: VAT amounts shown incorrectly or unjustifiably in 
invoices (section 14c German VAT Act) 8 customer as trade 
consignor or the warehouses' owner respectively pursuant to 
section 13a (1) no. 6 German VAT Act (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigDecimal 
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Report Field Name Maconomy Mapping & Description 

                     <Kz76> Description: Turnover for which a tax is payable under § 24 UStG 
(sawmill products, beverages and alcohol, eg wine) (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigInteger 

Max Length: 13 

                     <Kz77> Description: Deliveries of agricultural and forestry enterprises to 
US $ 24 VAT to customers with VAT ID up to 2009: Sales of 
agricultural and forestry enterprises according to § 24 UStG 
deliveries to the rest of the Community to customers with VAT ID. 
(Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigInteger 

Max Length: 13 

                     <Kz80> Description: VAT amount of kz76 (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigDecimal 

                     <Kz81> Description: Taxable sales (supplies and other services incl. 
benefits in kind) subject to 19 % VAT. In Box 81, the net amount of 
sales generated by the filing company/taxpayer that are subject to 
German VAT at the regular rate of 19% must be entered. VAT on 
this amount is calculated automatically by the form and entered 
into the adjacent field (column "Steuer"). This VAT amount is 
princiaplly owed by the filing company/taxpayer, i. e. it is a 
payable. (Optional) 

Condition: IF VatRate = 19% AND TaxCountry = Germany AND 
Tax Settlement Type = Tax Payable AND VATPopup1 = 
Blank/Goods/Services THEN 

Settlement\ Basis Amounts\ Tax Basis\ Tax Basis – Company 

Data Type: BigInteger 

Max Length: 13 

                     <Kz83> Description: Total VAT payable (Mandatory) 

Condition: (((kz47+VAT OF kz81+VAT OF kz86+VAT OF 
kz89+VAT OF kz93+kz80+kz98+kz96)  
minus 
kz66+kz61+kz62+kz67+kz63+kz64+kz59) 
plus kz65+kz69) minus kz39 

Where: 

 Kz81, kz86, kz89, kz93 have calculated VAT that are not 
displayed in the xml file 
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Report Field Name Maconomy Mapping & Description 

 Kz36, kz80, kz98, kz96, kz61,kz62 kz63. Kz64, kz59, 
kz65. Kz69 and kz39 are manually entered on selection 
criteria 

Note: This field can be either be calculated in the xml output or 
calculated by the Elster site. However, the total amount provided 
in the xml output may differ by a little than when the amounts are 
manually entered in the elster site because there kz fields that are 
being rounded off when shown in the xml output. (Considering that 
you will use the same entry from the xml output.) 

Data Type: BigDecimal 

                     <Kz86> Description: Taxable sales (supplies and other services incl. 
benefits in kind) subject to 7 % VAT. This box relates to sales 
generated by the filing company/taxpayer that are subject to 
German VAT at the reduced rate of 7%. The net amount of these 
sales is entered in Box 86. VAT on this amount is calculated 
automatically by the form and entered into the adjacent field 
(column "Steuer"). This VAT amount is princiaplly owed by the 
filing company/taxpayer, i. e. it is a payable. (Optional) 

Condition: IF VatRate = 7% AND Tax Country = Germany AND 
TaxSettlementType = Tax Payable AND VATPopup1 
=Blank/Goods/Services THEN 

Settlement\ Basis Amounts\ Tax Basis\ Tax Basis – Company 

Data Type: BigInteger 

Max Length: 13 

                     <Kz89> Description: Taxable intra-Community acquisition of goods 
subject to 19 % VAT. This box relates to intra-Community 
acquisitions of goods carried out by the filing company/taxpayer 
that are subject to German VAT at the regular rate of 19%. The 
net amount of these purchases is entered into box 89. VAT on this 
amount is calculated automatically by the form and entered into 
the adjacent field (column "Steuer"). This VAT amount is 
princiaplly owed by the filing company/taxpayer, i. e. it is a 
payable. (Optional) 

Condition: IF EUVATRate = 19% AND Vendor EU Member= Yes 
AND Tax Settlement Type = Tax Receivable AND VATPopup1 = 
Goods AND EUAcquisition = Yes   

Settlement\ Basis Amounts\ Tax Basis\ Tax Basis – Company 

Data Type: BigInteger 

Max Length: 13 

                     <Kz91> Description: Intra-Community acquisition of goods Zero-rated 
intra-Community acquisition of goods acquisition of goods 
pursuant to sections 4b and 25c German VAT Act. This box 
relates to intra-Community acquisitions of goods carried out by the 
filing company/taxpayer that are zero-rated, i. e. no German VAT 
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is due on them. The net amount of these purchases is entered into 
box 91. (Optional) 

Condition: IF AND Tax Settlement Type = Tax Receivable and 
VATRate = 0% AND VATPopup1 = Goods AND 

EUAcquisition = Yes AND Vendor EU Member = Yes THEN 

Settlement\ Basis Amounts\ Tax Basis\ Tax Basis – Company 

Data Type: BigInteger 

Max Length: 13 

                     <Kz93> Description: Taxable intra-Community acquisition of goods 
subject to 7% VAT. This box relates to intra-Community 
acquisitions of goods carried out by the filing company/taxpayer 
that are subject to German VAT at the reduced rate of 7%. The net 
amount of these purchases is entered into box 93. VAT on this 
amount is calculated automatically by the form and entered into 
the adjacent field (column "Steuer"). This VAT amount is 
principally owed by the filing company/taxpayer, i. e. it is a 
payable. (Optional) 

Condition: IF EUVATRate=7% AND Tax Settlement Type = Tax 
Receivable AND VATPopup1 = Goods AND EUAcquisition = Yes 
AND Vendor EU Member = Yes THEN  

Settlement\ Basis Amounts\ Tax Basis\ Tax Basis – Company 

Data Type: BigInteger 

Max Length: 13 

                     <Kz94> Description: Intra-Community acquisitions of new vehicles from 
suppliers without VAT ID. to the general tax rate (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigInteger 

Max Length: 13 

                     <Kz95> Description: Intra-Community acquisitions at different tax rates 
(Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigInteger 

Max Length: 13 

                     <Kz96> Description: VAT amount of kz94 (Optional) 

Value: Manually entered via Selection criteria 

Data Type: BigDecimal 

                     <Kz98> Description: VAT amount of kz95 (Optional) 
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Report Field Name Maconomy Mapping & Description 

Value: Manually entered via Selection criteria 

Data Type: BigDecimal 

                  
</Umsatzsteuervoranmeldung> 

 

               </Steuerfall>  

            </Anmeldungssteuern>  

         </Nutzdaten>  

      </Nutzdatenblock>  

   </DatenTeil>  

</Elster>  

Special Filing Extension Mappings 

Report Field Name Maconomy Mapping & Description 

<Elster>  

   <TransferHeader> Note: Transfer header is only used for when the integration to Elster is 
done. The same goes for all elements under this group  

Optional 

      <DatenArt> Description: This field shows the Data Type (Optional) 

Hardcode “USTVA” 

       <Vorgang> Description: This field shows the Process (Optional) 

Hardcode “send-Auth” 

      <Testmerker> Description: Test notator, whether the file is a test or not (Optional) 

Condition:If Testmerker checkbox = true  

“Ja” Else map NULL 

      <VersionClient> Description: This is the maconomy version 

Condition: “21.0.04.0” 

Optional 

   </TransferHeader>  

   <DatenTeil> Description: This field block shows the data part of USTVA (Optional) 
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      <Nutzdatenblock> Optional 

         <NutzdatenHeader version=“11” 
> 

Attribute Code:  

hardcode version = “11” 

Optional 

            <Empfaenger id="F"> Description: This field shows the Receiver information with ID. This 
has a static value of “F”. (Optional) 

Condition: id = Hardcode “F” 

         </NutzdatenHeader>  

      <Nutzdaten> Optional 

         <Anmeldungssteuern xmlns =”” 
version="" > 

Description: This field shows specific information for USTVA. Version 
attribute is derived from current year and a hardcode “01” (Optional) 

Attribute Code: 

 xmlns=http://finkonsens.de/elster/elsteranmeldung/ustva/v2021 

Data Type: String 

Attribute Code: version = Current year 

Data Type: String 

Both Mandatory 

Note: We did not change anything from the schema 

               <Erstellungsdatum> Description: This field shows the start date of the report (Optional) 

Values either: Start date of the period in the Selection criteria 
(YYYYMMDD) if period or Start date in the Selection criteria 
(YYYYMMDD) if entry date 

Data Type: String 

               <DatenLieferant> Description: This field shows the Company Information for single 
company transactions or Tax Reporting Unit information for multiple 
company transactions (Optional) 

Condition: IF Tax Reporting Unit is Entered  in Selection Criteria 

       (IF Company > 1  

            Tax Reporting Unit Information (see field values below) 

        ELSE  

           Company Information (see field values below) 

      ) 

http://finkonsens.de/elster/elsteranmeldung/ustva/v2021
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                  <Name> Description: This fields shows the Tax Reporting Unit Name for 
multiple companies or Company Name for single company. (Optional) 

Values either: Tax Reporting Unit\TaxReportingUnitName or 

Company\Company Name 

Length: 

Minimum = 1 

Maximum = 45 

Data Type: String 

                  <Strasse> Description: This fields shows the Tax Reporting Unit Tax Office 1 for 
multiple companies or Company Address 1 for single company.  
(Optional) 

Values either: Tax Reporting Unit\ Tax Office 1 or Company\Contact 
Informaiton\Name2 

Length: 

Minimum = 1 

Maximum = 30 

Data Type: String 

                  <PLZ> Description: This fields shows the Tax Reporting Unit Tax Office 2 for 
multiple companies or Company ZipCode for single company (Optional) 

Values either: Tax Reporting Unit\ Tax Office 2 or Company\ Contact 
Informaiton\ZipCode 

Length: 

Minimum = 1 

Maximum = 12 

Data Type: String 

                  <Ort> Description: This fields shows the Tax Reporting Unit Tax Office 3 for 
multiple companies or Company Postal District for single company.  
(Optional) 

Values either: Tax Reporting Unit\ Tax Office 3 or Company\ Contact 
Informaiton\Postal District 

Length: 

Minimum = 1 

Maximum = 30 

Data Type: String 
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                  <Telefon> Description: This fields shows the Tax Reporting Unit Tax Office 4 for 
multiple companies or Company Telephone for single company. 
(Optional) 

Values either: Tax Reporting Unit\ Tax Office 4 or Company\ Contact 
Information\Telephone 

Length: 

Minimum = 1 

Maximum = 20 

Data Type: String 

                  <Email> Description: This fields shows the email specified from the Selection 
Criteria. (Optional) 

From Selection Criteria 

Length: 

Minimum = 1 

Maximum = 70 

Data Type: String 

               </DatenLieferant>  

               <Steuerfall> Description: This field block shows the Tax related information 

(Optional) 

                  <Dauerfristverlaengerung> Description: This field block shows information for Permanent 
Extension Filing (Optional) 

                     <Jahr> Description: This field shows the Start Year used in the Selection 
criteria (Optional) 

Value: Start year based on Selection criteria  (YYYY)  

Data Type: String 

                     <SteuerNummer> Description: This fields shows the Company Tax No. (Optional) 

Value: Company/Tax No. 

Data Type: String 

                       <Kz09> 
Description: 5-digit manufacturer ID assigned to Deltek Germany 

Value: “21651” 

Length: 

Minimum = 5 

Maximum = 95 

Data Type: String 



Statutory Reports Setup 

BPM Admin Guide 90 

 

Report Field Name Maconomy Mapping & Description 

                       <Kz23> Description: In addition to the information in the tax return, other or 
different information or facts must be taken into account (if yes, please 
enter a "1"). This fields shows the Needs additional Information field in 
the Selection criteria. 

Value: Selection Criteria 

Condition: IF checkbox is marked THEN map “1” 

Data Type: String 

                       <Kz23_Begruendung> Description: This fields shows the Additional Information on Tax 
Registration field in the Selection criteria. (Optional) 

Value: Manually entered in Selection criteria 
 
Data Type: String 
 
Note: When Needs additional Information checkbox in the selection 
criteria is not ticked, this field will not populate 

Special Advance Payment Mappings 

Report Field Name Maconomy Mapping & Description 

<Elster>  

   <TransferHeader> Note: Transfer header is only used for when the integration to Elster is 
done. The same goes for all elements under this group  

Optional 

      <DatenArt> Description: This field shows the Data Type (Optional) 

Hardcode “USTVA” 

       <Vorgang> Description: This field shows the Process (Optional) 

Hardcode “send-Auth” 

      <Testmerker> Description: Test notator, whether the file is a test or not (Optional) 

Condition:If Testmerker checkbox = true  

“Ja” Else map NULL 

      <VersionClient> Description: This is the maconomy version 

Condition: “21.0.04.0” 

Optional 

   </TransferHeader>  

   <DatenTeil> Description: This field block shows the data part of USTVA (Optional) 
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      <Nutzdatenblock> Optional 

         <NutzdatenHeader version=“11” 
> 

Attribute Code:  

hardcode version = “11” 

Optional 

            <Empfaenger id="F"> Description: This field shows the Receiver information with ID. This 
has a static value of “F”. (Optional) 

Condition: id = Hardcode “F” 

         </NutzdatenHeader>  

      <Nutzdaten> Optional 

         <Anmeldungssteuern xmlns =”” 
version="" > 

Description: This field shows specific information for USTVA. Version 
attribute is derived from current year and a hardcode “01” (Optional) 

Attribute Code: 

 xmlns="http://finkonsens.de/elster/elsteranmeldung/ustva/v2021" 

Attribute Code: version = Current year 

Both Mandatory 

Data Type: String 

Note: We did not change anything from the schema 

               <Erstellungsdatum> Description: This field shows the start date of the report (Optional) 

Values either: Start date of the period in the Selection criteria 
(YYYYMMDD) if period or Start date in the Selection criteria 
(YYYYMMDD) if entry date 

Data Type: String 

               <DatenLieferant> Description: This field shows the Company Information for single 
company transactions or Tax Reporting Unit information for multiple 
company transactions (Optional) 

Condition: IF Tax Reporting Unit is Entered  in Selection Criteria 

       (IF Company > 1  

            Tax Reporting Unit Information (see field values below) 

        ELSE  

           Company Information (see field values below) 

      ) 

                  <Name> Description: This fields shows the Tax Reporting Unit Name for 
multiple companies or Company Name for single company. (Optional) 
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Values either: Tax Reporting Unit\TaxReportingUnitName or 

Company\Company Name 

Length: 

Minimum = 1 

Maximum = 45 

Data Type: String 

                  <Strasse> Description: This fields shows the Tax Reporting Unit Tax Office 1 for 
multiple companies or Company Address 1 for single company.  
(Optional) 

Values either: Tax Reporting Unit\ Tax Office 1 or Company\Contact 
Informaiton\Name2 

Length: 

Minimum = 1 

Maximum = 30 

Data Type: String 

                  <PLZ> Description: This fields shows the Tax Reporting Unit Tax Office 2 for 
multiple companies or Company ZipCode for single company (Optional) 

Values either: Tax Reporting Unit\ Tax Office 2 or Company\ Contact 
Informaiton\ZipCode 

Length: 

Minimum = 1 

Maximum = 12 

Data Type: String 

                  <Ort> Description: This fields shows the Tax Reporting Unit Tax Office 3 for 
multiple companies or Company Postal District for single company.  
(Optional) 

Values either: Tax Reporting Unit\ Tax Office 3 or Company\ Contact 
Informaiton\Postal District 

Length: 

Minimum = 1 

Maximum = 30 

Data Type: String 

                  <Telefon> Description: This fields shows the Tax Reporting Unit Tax Office 4 for 
multiple companies or Company Telephone for single company. 
(Optional) 
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Values either: Tax Reporting Unit\ Tax Office 4 or Company\ Contact 
Information\Telephone 

Length: 

Minimum = 1 

Maximum = 20 

Data Type: String 

                  <Email> Description: This fields shows the email specified from the Selection 
Criteria. (Optional) 

From Selection Criteria 

Length: 

Minimum = 1 

Maximum = 70 

Data Type: String 

               </DatenLieferant>  

               <Steuerfall> Description: This field block shows the Tax related information 

(Optional) 

                   < 

Umsatzsteuersondervorauszahlung> 

Description: This field block shows information for Permanent 
Extension Filing (Optional) 

                     <Jahr> Description: This field shows the Start Year used in the Selection 
criteria (Optional) 

Value: Start year based on Selection criteria  (YYYY)  

Data Type: String 

                     <SteuerNummer> Description: This fields shows the Company Tax No. (Optional) 

Value: Company/Tax No. 

Data Type: String 

                       <Kz09> 
Description: 5-digit manufacturer ID assigned to Deltek Germany 

Value: hardcode ”21651” 

Length: 

Minimum = 5 

Maximum = 95 

Mandatory 
Data Type: String 

                          <Kz10> Description: This fields shows the Corrected Registration field in the 
Selection criteria. (Optional) 
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Value: Manually entered in Selection criteria 
 
Data Type: String 

                       <Kz26> 
Description: This fields shows the SEPA-Direct Debit Mandate 
Payment field in the Selection criteria. (Optional) 

Value: Manually entered in Selection criteria 
 
Data Type: String 

                       <Kz29> 
Description: This fields shows the Settlement of the refund amount 
desired / Refund amount is assigned field in the Selection criteria. 
(Optional) 

Value: Selection Criteria 

Note: When this is ticked, then Special advance payment (kz38) will 
populate. 
 
Code: IF checkbox is marked THEN map “1” 
Data Type: String 

                       <Kz38> 
Description: This fields shows the Special Advance Payment field in 
the Selection criteria. (Optional) 

Value: Manually entered in Selection criteria 
 
Note: When Settlement of the refund amount desired / Refund amount 
is assigned checkbox in the selection criteria is not ticked, this field will 
not populate 
 
Data Type: BigInteger 
Total digits: 13 
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India 
See Statutory Reports Setup to begin. No Additional Setup Required. 

Revision History / What’s New 
The table below shows a quick reference of updates.  

Update  Version Description 

 

2.5.3 
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Norway 
See Statutory Reports Setup to begin. 

Revision History / What’s New 
The table below shows a quick reference of updates.  

Update  Version Description 

Norwegian SAFT 
Report 

2.5.3  Merging two company numbers into one report 
limitation 

Norwegian SAFT Report 
The use of Maconomy’s Tax Settlement functionality must be in place for the Tax Information details to 
populate in the report, as required by Norwegian SKAT.  

 The mapping fields below need to be filled in the appropriate dialogs, as provided. For example, 
the <Company> attribute means that the Company Information card has certain fields that must 
be completed, such as Company Registration No. 

 Header information is populated via selection criterion or other means. You do not need to do 
anything for this area. 

 Most of the fields should already be filled in the system. To confirm this, double-check each line 
to ensure that the fields are populated and the correct data is extracted in the report.  

Reference Materials 

 

http://www.skatteetaten.no/no/Bedrift-og-organisasjon/frister-attester-og-regnskap/Bokforing-og-
regnskap/standardformat-regnskap-saf-t/dokumentasjon/  

 Norwegian SAF-T Financial data – Documentation (this section)  

 Norwegian SAF-T Financial data – Technical description (XML elements)  

 Diagrams (picture files) of the XSD Schema  

 Norwegian SAF-T Standard VAT codes  

The export is based on the XML Schema – (www.github.com/skatteetaten/saf-t) 

Note: This version of the SAF-T data export is limited to the general ledger level, including customer and 
supplier transactions. Necessary master data is also included. 

Note: SKAT updates these documents periodically. Make sure you have downloaded the most recent 
versions. 

http://www.skatteetaten.no/no/Bedrift-og-organisasjon/frister-attester-og-regnskap/Bokforing-og-regnskap/standardformat-regnskap-saf-t/dokumentasjon/
http://www.skatteetaten.no/no/Bedrift-og-organisasjon/frister-attester-og-regnskap/Bokforing-og-regnskap/standardformat-regnskap-saf-t/dokumentasjon/
http://www.github.com/skatteetaten/saf-t
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Tags and Mappings 

Tags (attributes indented) Dialogs Field/Value Technical Details 

<?xml version="1.0" encoding="UTF-8" standalone="yes"?> 

 

<AuditFile xmlns="urn:StandardAuditFile-Taxation-Financial:NO"> 

 

  <Header> 

   

        <AuditFileVersion> Hardcoded 1.10 

 

        <AuditFileCountry> Company 
Information 

Country Derived Country ISO: System Setup > 
Regional Settings > Countries 

        <AuditFileDateCreated> 

 

Current System Date 

 

        
<SoftwareCompanyName> 

Hardcoded Deltek, Inc. 

 

        <SoftwareID> Hardcoded Deltek Maconomy 

 

        <SoftwareVersion> Internal Value Application Version 
and Application 
Patch Level 

Help > About Deltek Maconomy > 
Installation Details: Application Version 
and Application Patch Level 

        <Company> 

   

Important Note: Running NSAFT as an Administrator without a Designated Employee 

The following is an issue with NSAFT in Maconomy versions prior to 2.5.4. 

Use the workaround described below. 

Scenario: 

When a user marked as an Administrator runs NSAFT and the “Administrator” user does not have a 
designated employee, NSAFT execution will fail. 

 

Workaround:  

Assign an employee to the “Administrator” user or run NSAFT with a non-admin user who has an 
employee assigned to them. 
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            <RegistrationNumber> 

Company 
Information 

Company Reg. No. 

 

            <Name> Name 

 

            <Address> 

  

                <StreetName> Address 1 

 

                <Number> Address 2 

 

                
<AdditionalAddressDetail> 

Address 3 

 

                <City> City 

 

                <PostalCode> Postal Code 

 

                <Country> Country Derived Country ISO: System Setup > 
Regional Settings > Countries 

            </Address> 

   

            <Contact> 

   

                <ContactPerson> 

   

                    <FirstName> Hardcoded NotUsed 

 

                    <LastName> 

Company 
Information 

Employee Name 1 
up to Employee 
Name 5 

 

                </ContactPerson> 

  

                <Telephone> Phone 

 

                <Fax> Fax 

 

                <Email> Text 10 Generic field used temporarily 

            </Contact> 

   

            <TaxRegistration> 

   

                
<TaxRegistrationNumber> 

Company 
Information 

Company 
Information Vat No. 
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                <TaxAuthority> Hardcoded Skatteetaten 

 

                
<TaxVerificationDate> 

Company 
Information 

Date 1 Generic field used temporarily 

            </TaxRegistration> 

   

            <BankAccount> 

   

                <IBANNumber> 

Company 
Information 

Giro Condition: 
If Giro is available display 
<IBANNumber> 
If Giro is not available display 
<BankAccountNumber> 

                
<BankAccountNumber> 

Bank 

                <CurrencyCode> Base Currency 

 

            </BankAccount> 

   

        </Company> 

   

        <DefaultCurrencyCode> Company 
Information 

Base Currency 

 

        <SelectionCriteria> 

   

            <CompanyEntity> 

Norway 
Statutory 
Reports 

Company No. 

 

            <SelectionStartDate> Year-Period From Set to 1st day of the Period selected 

            <SelectionEndDate> Year-Period To Set to last day of the Period selected 

        </SelectionCriteria> 

   

        <HeaderComment> Norway 
Statutory 
Reports 

Header Comment 

 

        <TaxAccountingBasis> Hardcoded A 

 

        <TaxEntity> Company 
Information 

Text 9 Generic field used temporarily 

        <UserID> Employees Name 1 Derived from the current logged in user 

  </Header> 
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  <MasterFiles> 

   

    <GeneralLedgerAccounts> 

  

Setup Required:  
Reporting Structure 
   Option List = Finance 
   Selected Value = NSAFT 
 
*they need to inlclude accounts to be 
mapped under the reporting structure. 

      <Account> 

  

        <AccountID> Account 
Information 
Card or  
Local Account 
Information 
Card 

Account Number 

        <AccountDescription> Account Name 

        <StandardAccountID> 

Reporting 
Structures 

Grouping level 1 

        <GroupingCategory> Grouping level 2 

        <GroupingCode> Grouping level 3 

        <AccountType> Hardcoded GL 

        <AccountCreationDate> Account 
Information 
Card or  
Local Account 
Information 
Card 

Created Date 

        <OpeningDebitBalance>  
                       OR 
        <OpeningCreditBalance> 

Account 
Ledger or 
Local Account 
Ledger 

Opening (Currency) Condition: 
   If Balance is greater than 0 display as 
<OpeningDebitBalance> 
   If Balance is less than 0 display as 
<OpeningCreditBalance> 

        <ClosingDebitBalance>  
                       OR 
        <ClosingCreditBalance> 

Closing (Currency) Condition: 
   If Balance is greater than 0 display as 
<ClosingDebitBalance> 
   If Balance is less than 0 display as 
<ClosingCreditBalance> 

      </Account> 

   

    </GeneralLedgerAccounts> 

   

    <Customers> 

   

      <Customer> 
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        <RegistrationNumber> 

Company 
Specific 
Customer 
Information 
Card 

Comp. Reg. No. 

 

        <Name> Name 

 

        <Address> 

  

          <StreetName> Address 1 

 

          <Number> Address 2 

 

          
<AdditionalAddressDetail> 

Address 3 

 

          <City> City 

 

          <PostalCode> Postal Code 

 

          <Country> Country Derived Country ISO: System Setup > 
Regional Settings > Countries 

        </Address> 

  

        <Contact> 

   

          <ContactPerson> 

   

              <FirstName> Hardcoded NotUsed 

 

              <LastName> Company 
Specific 
Customer 
Information 
Card 

Contact Person 

 

          </ContactPerson> 

   

          <Telephone> Company 
Specific 
Customer 
Information 
Card 

Phone 

 

          <Fax> Fax 

 

          <Email> Personal E-mail 

 

        </Contact> 

   

        <TaxRegistration> 
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Tags (attributes indented) Dialogs Field/Value Technical Details 

          
<TaxRegistrationNumber> 

Company 
Specific 
Customer 
Information 
Card 

Tax No. 

 

          <TaxAuthority> Hardcoded Skatteetaten 

 

        </TaxRegistration> 

   

        <BankAccount> 

   

          <IBANNumber> 

Company 
Specific 
Customer 
Information 
Card 

Giro Condition: 
If Giro is available display 
<IBANNumber> 
If Giro is not available display 
<BankAccountNumber> 

          <BankAccountNumber> Bank Acct. No. 

          <BIC> SWIFT 

 

          <CurrencyCode> Base Currency 

 

          
<GeneralLedgerAccountID> 

Control Account Control Account No. derived from: 
Popup Fields > A/R Control Accounts > 
Control Account 

        </BankAccount> 

  

        <CustomerID> Customer No. 

 

        <AccountID> Control Account Control Account No. derived from: 
Popup Fields > A/R Control Accounts > 
Control Account 

        <OpeningDebitBalance>  
                       OR 
        <OpeningCreditBalance> 

Periodic 
Customer 
Statement 

Balance, Base 
(Opening) 

Condition: 
   If Balance is greater than 0 display as 
<OpeningDebitBalance> 
   If Balance is less than 0 display as 
<OpeningCreditBalance> 

        <ClosingDebitBalance>  
                       OR 
        <ClosingCreditBalance> 

Balance, Base 
(Closing) 

Condition: 
   If Balance is greater than 0 display as 
<ClosingDebitBalance> 
   If Balance is less than 0 display as 
<ClosingCreditBalance> 

        <PartyInfo> 
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                <PaymentTerms> 

   

                        <Days> 

Company 
Specific 
Payment 
Information 

Payment Terms Days derived from: 
Popup Fields > Payment Terms > (No. of 
Months x 30) + No. of Days 

                        
<CashDiscountDays> 

Cash Discount Code Days derived from: 
Popup Fields > Cash Discount Code > 
No. of Days 

                        
<CashDiscountRate> 

Cash Discount Code Rate derived from: 
Popup Fields > Cash Discount Code > 
Discount % 

                </PaymentTerms> 

   

          <CurrencyCode> Company 
Specific 
Customer 
Information 
Card 

Base Currency 

 

        </PartyInfo> 

   

      </Customer> 

   

    </Customers> 

   

    <Suppliers> 

   

      <Supplier> 

   

        <RegistrationNumber> 

Company 
Specific 
Vendor 
Information 
Card 

Comp. Reg. No. 

 

        <Name> Name 

 

        <Address> 

  

          <StreetName> Address 1 

 

          <Number> Address 2 

 

          
<AdditionalAddressDetail> 

Address 3 

 

          <City> City 
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          <PostalCode> Postal Code 

 

          <Country> Country Derived Country ISO: System Setup > 
Regional Settings > Countries 

        </Address> 

   

        <Contact> 

   

          <ContactPerson> 

   

              <FirstName> Hardcoded NotUsed 

 

              <LastName> Company 
Specific 
Vendor 
Information 
Card 

Contact Person 

 

          </ContactPerson> 

   

          <Telephone> Company 
Specific 
Vendor 
Information 
Card 

Phone 

 

          <Fax> Fax 

 

          <Email> Personal E-mail 

 

        </Contact> 

   

        <TaxRegistration> 

   

          
<TaxRegistrationNumber> 

Company 
Specific 
Vendor 
Information 
Card 

Tax No. 

 

          <TaxAuthority> Hardcoded Skatteetaten 

 

        </TaxRegistration> 

   

        <BankAccount> 

   

          <IBANNumber> Company 
Specific 
Vendor 

Giro Condition: 
If Giro is available display 
<IBANNumber>           <BankAccountNumber> Bank Acct. No. 
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Information 
Card 

If Giro is not available display 
<BankAccountNumber> 

          <BIC> SWIFT 

 

          <CurrencyCode> Base Currency 

 

          
<GeneralLedgerAccountID> 

Control Account Control Account No. derived from: 
Popup Fields > A/P Control Accounts > 
Control Account 

        </BankAccount> 

  

        <CustomerID> Customer No. 

 

        <AccountID> Control Account Control Account No. derived from: 
Popup Fields > A/P Control Accounts > 
Control Account 

        <OpeningDebitBalance>  
                       OR 
        <OpeningCreditBalance> 

Periodic 
Vendor 
Statement 

Balance, Base 
(Opening) 

Condition: 
   If Balance is greater than 0 display as 
<OpeningDebitBalance> 
   If Balance is less than 0 display as 
<OpeningCreditBalance> 

        <ClosingDebitBalance>  
                       OR 
        <ClosingCreditBalance> 

Balance, Base 
(Closing) 

Condition: 
   If Balance is greater than 0 display as 
<ClosingDebitBalance> 
   If Balance is less than 0 display as 
<ClosingCreditBalance> 

        <PartyInfo> 

   

                <PaymentTerms> 

   

                        <Days> 

Company 
Specific 
Payment 
Control 

Payment Terms Days derived from: 
Popup Fields > Payment Terms > (No. of 
Months x 30) + No. of Days 

                        
<CashDiscountDays> 

Cash Discount Code Days derived from: 
Popup Fields > Cash Discount Code > 
No. of Days 

                        
<CashDiscountRate> 

Cash Discount Code Rate derived from: 
Popup Fields > Cash Discount Code > 
Discount % 

                </PaymentTerms> 
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          <CurrencyCode> Company 
Specific 
Vendor 
Information 
Card 

Base Currency 

 

        </PartyInfo> 

   

      </Supplier> 

   

    </Suppliers> 

   

    <TaxTable> 

   

      <TaxTableEntry> 

   

        <TaxType> Hardcoded MVA 

 

        <Description> Hardcoded Merverdiavgift 

 

        <TaxCodeDetails> 

   

          <TaxCode> 

Tax Tables 
and G/L Tax 
Tables 

Tax Code NSAFT has the capability to override the 
tax code using the remarks 2 field from 
the same option list for mapping 
standard tax code. This feature overrides 

<TaxCode> under <TaxTable> and 

<TaxInformation>. Character limit of 

9 is still enforced for the values from the 
remarks 2 field.  

If the Tax Code is neither in the option 
list nor mapped with a remarks 2 field, it 
will show the original tax code from the 
Tax Code dialog in Maconomy. 

          <EffectiveDate> Period From 

 

          <ExpirationDate> Period To 

 

          <Description> 

Tax Codes 
and G/L Tax 
Codes 

Tax Type, Taxable 

 

          <TaxPercentage> Tax Rate 

 

          <Country> Country ISO Code 

 

          <StandardTaxCode> Option Lists Remarks 1 Setup Required: Option List with Option 
List No.= NSAFT 
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          <BaseRate> Tax Codes 
and G/L Tax 
Codes 

Ratio <BaseRate> is always 100 for tax codes 
from 'Tax Codes' dialog  

        </TaxCodeDetails> 

   

      </TaxTableEntry> 

   

    </TaxTable> 

   

  </MasterFiles> 

   

  <GeneralLedgerEntries> 

   

    <NumberOfEntries> 

 

Total count of 
<Transaction> 
elements 

 

    <TotalDebit> 

 

Sum of all 
<DebitAmount> in 
the exported file 

 

    <TotalCredit> 

 

Sum of all 
<CreditAmount> in 
the exported file 

 

    <Journal> 

   

      <JournalID> Show 
Journals 

Journal No. 

 

      <Description> Show 
Journals 

Journal Type 

 

      <Type> 

 

Values ‘A’, ‘AP’, ‘AR’, 
or ‘GL” based on the 
Journal Type 

Reference Journal Type list mapping 

      <Transaction> 

   

        <TransactionID> 

Show G/L 
Entries 

Trans. No. 

 

        <Period> Fiscal Period  

 

        <PeriodYear> Fiscal Year 

 

        <TransactionDate> Entry Date 
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Tags (attributes indented) Dialogs Field/Value Technical Details 

        <SourceID> Show 
Journals 

Created By 

 

        <TransactionType> Show G/L 
Entries 

Aut. Entry Condition: 
If Aut. Entry is Yes, <TransactionType> 
is set to “Automated”.  
If Aut. Entry is No, <TransactionType> is 
set to “Normal”. 

        <Description> Show G/L 
Entries 

Transaction Type 

 

        <SystemEntryDate> Show 
Journals 

Created On 

 

        <GLPostingDate> Show G/L 
Entries 

Date Posted 

 

        <SystemID> Show G/L 
Entries 

Combined Sequence 
No. 

 

        <Line> 

   

          <RecordID> 

 

Auto-generated 
number 

sequence number is generated per 
<Line> per <Transaction> 

          <AccountID> Show G/L 
Entries 

Account No. 

 

          <SourceDocumentID> Show G/L 
Entries 

Journal No. 

 

          <CustomerID> Show 
Customer 
Reconcilliation 

Customer No. 
Condition: 
If the <Line> is an A/R sub ledger entry, 
show <CustomerID> 
If the <Line> is an A/P sub ledger entry, 
show <SupplierID>           <SupplierID> Show Vendor 

Reconciliation 
Vendor No. 

          <Description> Show G/L 
Entries 

Entry Description 

 

          <DebitAmount> 
                   OR 
          <CreditAmount> 

  

Condition: 
If <Amount> is greater than 0, display as 
<DebitAmount> 
If <Amount> is less than 0, display as 
<CreditAmount> 
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Tags (attributes indented) Dialogs Field/Value Technical Details 

            <Amount> Show G/L 
Entries 

Debit, Base - Credit, 
Base 

Displayed in absolute value 

            <CurrencyCode> Show G/L 
Entries 

Original Currency 

 

            <CurrencyAmount> Show G/L 
Entries 

Original Amount 

 

            <ExchangeRate> 

 

<Amount> divided by 
<CurrencyAmount> 

 

          <TaxInformation> 

   

            <TaxType> Hardcoded MVA 

 

            <TaxCode> Show Tax 
Settlement 
Entries 

Tax Code NSAFT has the capability to override the 
tax code using the remarks 2 field from 
the same option list for mapping 
standard tax code. This feature overrides 

<TaxCode> under <TaxTable> and 

<TaxInformation>. Character limit of 

9 is still enforced for the values from the 
remarks 2 field.  

If the Tax Code is neither in the option 
list nor mapped with a remarks 2 field, it 
will show the original tax code from the 
Tax Code dialog in Maconomy. 

            <TaxPercentage> Show Tax 
Settlement 
Entries 

Tax Rate 

 

            <TaxBase> Show G/L 
Entries 

Debit, Base - Credit, 
Base 

 

            <TaxAmount> 

   

              <Amount> Show G/L 
Entries 

Debit Tax - Credit 
Tax 

 

              <CurrencyCode> Show Tax 
Settlement 
Entries 

Original Currency 
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Tags (attributes indented) Dialogs Field/Value Technical Details 

              <CurrencyAmount> Show Tax 
Settlement 
Entries 

Calculated from 
Debit, Currency - 
Credit, Currency and 
Ratio 

 

            </TaxAmount> 

   

          </TaxInformation> 

   

          <ReferenceNumber> Show G/L 
Entries 
         OR 
Show Vendor 
Invoice 
Journals 

Transaction No.  
          OR  
Vendor Invoice No. 

Condition: 
If Journal Type is Invoice, 
<ReferenceNumber> shows the 
Transaction No. 
If Journal Type is Vendor Invoice, 
<ReferenceNumber> shows the Vendor 
Invoice No. 

        </Line> 

   

      </Transaction> 

   

    </Journal> 

   

 

 

 

Enable Logging 

To enable logging, add the following entries to logback.xml of the coupling service configuration:  

Note: This is the setup of IBAN and Bank Account Numbers: 

 <IBANNumber> displays if it has a value, regardless if there is bank account. 

 <Bank Account No.> displays if IBANNumber is blank and Bank Account has a value. 

 If both tags are blank, <IBANNumber>NA</IBANNumber> displays. 

Note:  

If tax code is an EU acquisition, <TaxPercentage>0.00</TaxPercentage> = EU Acquisition Tax Rate 
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Setup in Maconomy 

To enable this report: 

1. Go to System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the BPM Server REST API parameter. 

3. On the System Parameter sub-tab, enter the IP and not DOMAIN address. 

4. On the System Parameters tab, select the BPM Server URL parameter. 

5. On the System Parameter sub-tab, enter the BPM server URL. 

Journal Type Mapping 

Maconomy Journal Types NSAFT Type 

Asset A 

Asset Acquisition A 

Asset Depreciation A 

Asset Internal Sale A 

Asset Relocation A 

Asset Sale A 

Asset Transfer A 

Bank Reconciliation A 

Commission A 

Expense Sheet A 

Fixed Price Inclusion A 

Follow-up Selection A 

Invoice Reallocation A 

  <logger name="com.deltek.maconomy.bpm.norway.nsaft" 

additivity="false"> 

    <level value="DEBUG" /> 

    <appender-ref ref="FILE"/> 

  </logger> 

 

  <logger name="com.deltek.maconomy.bpm.util" additivity="false"> 

 <level value ="DEBUG"/> 

 <appender-ref ref="FILE"/> 

  </logger> 
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Maconomy Journal Types NSAFT Type 

Item A 

Job A 

Job Accrual A 

Job Invoice Allocation A 

Job Item A 

Job Pre-Invoice Reconciliation A 

Job Reallocation A 

Job Revenue Recognition A 

Job Transfer A 

Mileage Sheet A 

Royalty A 

Time Sheet A 

Intercompany Settlement Vendor Invoice AP 

Payment AP 

Vendor AP 

Vendor Invoice AP 

Automatic Customer Payment AR 

Collection AR 

Customer Payment AR 

Customer Reconciliation AR 

Debtor Provisions AR 

Interest Charge Notice AR 

Invoice AR 

Reminder AR 

G/L Reallocation GL 
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Maconomy Journal Types NSAFT Type 

General GL 

Gross Pay GL 

Intercompany Grouping GL 

Intercompany Interest Note GL 

Tax Settlement GL 

Unrealized Exchange Rate Variance GL 

Import Bank Account Numbers for Customers  

Bank Account No. is an optional field from Maconomy that you can leave empty for the Norwegian SAFT 
report. This field is not visible in the standard layout in the Customers workspace. To use the Bank 
Account No field, you must create an import file to fill the field with bank account numbers. 

Note: The import file is only applicable in the Customers workspace.  

To add bank account numbers: 

1. Create a tab-separated data file with customer information, as shown. 

 

2. In Maconomy, go to Single Dialog » Import » Customer » Import Customers. 

3. On the Import Customers tab, select the Internal Names, Progress Bar, and Logging check 
boxes. 

4. Click Import.  

5. Select the import file. 

6. In the Customers workspace, right-click in the customer table and select Customize Columns.  

7. Select the Bank Acct. No. column. The values you imported into the Bank Acct. No. column are 
displayed. 

Import SWIFT Code for Customers and Vendors 

SWIFT Code is not a visible field in the standard layout in the Customers and Vendors workspaces. You 
must use an import file to fill this field with bank account numbers. 

To add bank account numbers: 

1. Create a tab-separated data file with SWIFT code information, as shown. 
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2. Open the Customers or Vendors workspace: 

a. Go to Single Dialog » Import » Customer » Import Customers to import the SWIFT 
code values into the Customers workspace. 

b. Go to go to Single Dialog » Import » Vendor » Import Vendors to import SWIFT code 
into the Vendors workspace. 

3. Select the Internal Names, Progress Bar, and Logging check boxes. 

4. Click Import.  

5. Select your import file. 

6. Customize the layout to display the SWIFT column and values in the Customers and Vendors 
workspaces. 

TaxCode Uniqueness Requirement 

Background 

Deltek Maconomy customers in NO typically have their VAT setup going across multiple countries for the 
Norge 0% Export rates.  

See the following example: 

Limitation: Merging Two Company Numbers into One Report 

Note the following limitation around merging two company numbers into a single report: 

Scenario: 

 Companies under the selected Tax Settlement Unit is a mix of Global and Local Accounts. 
(For example, Company 1 uses global accounts while Company 21 is using Local Accounts) 

Issue: 

 GL Entries will not match Master Data 

Reason: 

GL Entries are filtered by either Global or Local Charts of Account Type. However, there is no filter like 
this for Vendors and Customers. This will result in having more vendors and customers displayed on the 
<MasterFiles> compared to the entries shown under <GeneralLedgerEntries>. 
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As a result of this setup, you see the following extract in the SAF-T XML Output: 

<TaxCodeDetails> 

                    <TaxCode>Norge Exp</TaxCode> 

                    <Description>NO - 12. Norge export försäljning</Description> 

                    <TaxPercentage>0.00</TaxPercentage> 

                    <Country>SE</Country> 

                    <StandardTaxCode></StandardTaxCode> 

                    <BaseRate>100.00</BaseRate> 

                </TaxCodeDetails> 

                <TaxCodeDetails> 

                    <TaxCode>Norge Exp</TaxCode> 

                    <Description>NO - 12. Norge export försäljning</Description> 

                    <TaxPercentage>0.00</TaxPercentage> 

                    <Country>GB</Country> 

                    <StandardTaxCode></StandardTaxCode> 
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                    <BaseRate>100.00</BaseRate> 

                </TaxCodeDetails> 

                <TaxCodeDetails> 

                    <TaxCode>Norge Exp</TaxCode> 

                    <Description>NO - 12. Norge export försäljning</Description> 

                    <TaxPercentage>0.00</TaxPercentage> 

                    <Country>DK</Country> 

                    <StandardTaxCode></StandardTaxCode> 

                    <BaseRate>100.00</BaseRate> 

                </TaxCodeDetails> 

                <TaxCodeDetails> 

                    <TaxCode>Norge Exp</TaxCode> 

                    <Description>NO - 12. Norge export försäljning</Description> 

                    <TaxPercentage>0.00</TaxPercentage> 

                    <Country>FR</Country> 

                    <StandardTaxCode></StandardTaxCode> 

                    <BaseRate>100.00</BaseRate> 

                </TaxCodeDetails> 

                <TaxCodeDetails> 

                    <TaxCode>Norge Exp</TaxCode> 

                    <Description>NO - 12. Norge export försäljning</Description> 

                    <TaxPercentage>0.00</TaxPercentage> 

                    <Country>BE</Country> 

                    <StandardTaxCode></StandardTaxCode> 

                    <BaseRate>100.00</BaseRate> 

                </TaxCodeDetails> 

                <TaxCodeDetails> 

                    <TaxCode>Norge Exp</TaxCode> 

                    <Description>NO - 12. Norge export försäljning</Description> 

                    <TaxPercentage>0.00</TaxPercentage> 

                    <Country>FI</Country> 

                    <StandardTaxCode></StandardTaxCode> 

                    <BaseRate>100.00</BaseRate> 

                </TaxCodeDetails> 

                <TaxCodeDetails> 

                    <TaxCode>Norge Exp</TaxCode> 

                   <Description>NO - 12. Norge export försäljning</Description> 

                    <TaxPercentage>0.00</TaxPercentage> 
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                    <Country>US</Country> 

                    <StandardTaxCode></StandardTaxCode> 

                    <BaseRate>100.00</BaseRate> 

                </TaxCodeDetails> 

                <TaxCodeDetails> 

                    <TaxCode>Norge Exp</TaxCode> 

                    <Description>NO - 12. Norge export försäljning</Description> 

                    <TaxPercentage>0.00</TaxPercentage> 

                    <Country>DE</Country> 

                    <StandardTaxCode></StandardTaxCode> 

                    <BaseRate>100.00</BaseRate> 

                </TaxCodeDetails> 

                <TaxCodeDetails> 

Note that in each instance, although the TaxCode is Norge Exp (Norge Export), there is no uniqueness 
as required by SKATT to differentiate each code.  

Requirements 

SKATT Requires that the TaxCode name can only be used once and it must be unique according to the 
SKATT technical guide referenced below: 

Repetitions (Rep) states how 

many times the element can or 

must be repeated. 0..1  

 The element can be used once.  

1..1   The element must be used once.  

0..U   The element can be used from 

none to an unbounded amount of 

times.  

1..U   The element must be used from 

one to an unbounded amount of 

times.  

 TaxCodeDetails 

Mandatory. Repetitions: 1..U 

XML Element Description Type Req/Rep. Example 

TaxCode Tax Code for lookup in 
tables. 

SAFmiddle1textType M 1..1 14 

EffectiveDate Representing the starting 
date for this entry. 

xs:date O 0..1 2005-01-01 

ExpirationDate Representing the ending 
date for this entry. 

xs:date O 0..1 
 

Description Description of the Tax 
Code. 

SAFlongtextType O 0..1 Inngående avgift, 
høy sats 

TaxPercentage Tax percentage. xs:decimal O 0..1 25 

FlatTaxRate Not in use. AmountStructure O 0..1 
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Country Two-letter country code 
according to ISO 3166-
1 alpha 2 standard. 

ISOCountryCode M 1..1 NO 

Region Not in use. SAFcodeType O 0..1 
 

StandardTaxCode Standard Tax Code. 
See attatched overview of 
standard codes. 

SAFmiddle1textType M 1..1 1 

Compensation Indicates if the Tax Code is 
used for compensation. 

xs:boolean O 0..U true 

According to Norwegian SKATT, the tax codes must be unique as noted above per the SKATT 
technical documentation. 

In order to file the SAF-T report, you must change your NO tax code setup to reflect a more unique 
set of codes (For example, NorgeExport0%1, NorgeExport0%2, etc.). 

This should be discussed with your business consultant as new codes need to be set up and assigned to 
the tax tables and then tagged to new transactions going forward.  

We understand this is not an easy undertaking but it is important from a compliance perspective. 

Reporting Structure for NSAFT 
The NSAFT report uses a reporting structure to group finance data. 

Setup in Maconomy 

To create a reporting structure for NSAFT: 

1. Go to Setup » System Setup » Parameters and Numbers » Option Lists. 

2. Click + New Option List. 

3. In the Option List No. field, enter Finance. 

4. Click Create. 

5. On the Options sub-tab, click Add Option or press Ctrl + M. 

6. In the Name and Description fields, enter NSAFT. 

7. Click Save Option (Enter), then click Save Option List (Enter). 

8. Go to Setup » Reporting » Reporting Structures. 

9. Click + New Reporting Structure. 

10. In the Create Reporting Structure dialog, enter the following setting: 

 Type — Accounts or Local Accounts 

 Option List — Finance 

 Selected Value — NSAFT 

11. Click Create. 

12. Insert group headers, sub-group headers to provide the desired account structure. 

13. Add accounts to the individual groups of the reporting structure. 
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Reporting and Account Structure Examples 

Customers: Please contact Customer Care for examples if needed.  

Standard Tax Codes Mapping 

NSAFT uses option list to map Maconomy tax codes with the Standard Tax Codes provided by the tax 
authority. 

Option List Setup in Maconomy 

To create the mapping, follow these steps: 

1. Go to Setup » System Setup » Parameters and Numbers » Option Lists. 

2. Click + New Option List. 

3. In the Option List No. field, enter NSAFT. 

4. Click Create. 

5. On the Options sub-tab, click Add Option or press Ctrl + M. 

6. In the Name fields, enter the tax code name (Name field from Tax Codes or G/L Tax Codes) 

7. In the Remarks 1 field, enter the corresponding standard tax code.  

8. Click Save Option (Enter), then click Save Option List (Enter). 

 

Sample configuration 

Override Tax Code Names 
NSAFT can use the option list to override the tax code to maintain unique tax code names within the 9-

character limit.  

https://github.com/Skatteetaten/saf-t/tree/master/Standard%20Tax%20Codes
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Spain 
See Statutory Reports Setup to begin. 

Revision History / What’s New 
The table below shows a quick reference of updates.  

Update  Version Description 

 

2.5.3 

 

Include Tax for Debtor Provisions System Parameter 
Set up the inclusion of tax in debt provisions for new customer entries or to update existing open 
customer entries. Enable this company-specific parameter to select whether tax should be included or 
excluded for debtor provisions. 

Enter or select a date to update existing open customer entries without approved or posted debtor 
provisions to include tax. If you do not choose a date, all open customer entries without approved or 
posted debtor provisions are updated to include tax. 

Note: Customer entries that already have approved debtor provisions are not affected by this parameter. 
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Sweden 
See Statutory Reports Setup to begin.  

Revision History / What’s New 
The table below shows a quick reference of updates.  

Update  Version Description 

Sweden SIE Setup 2.5.3  Change in Dimension Setup for Transactions 

Sweden SIE Setup 
The Finance universe of BPM Reporting use reporting structures to structure and filter accounts. Sweden 
BPM reports require the setup of reporting structures. Refer to the Reporting Structure for Finance 
Measures section for more information. 

Please contact your Customer Success Manager if you require assistance in reporting structures. 

Dimension Setup for Transactions 

Note the following behavior that occurs for #TRANS and #VER for transactions under the following 
scenarios: 

Scenario 1: Not Using Updated localspec1 in Transaction 

The following will behavior will occur when you change the setup in the dimension after creating a 
transaction but don’t use the upated localspec1: 

1. If no checkbox is selected, the transactions if the specific Fiscal Period are shown. 

2. If the localspec1 checkbox was selected, then #TRANS and #VER is blank. 

Scenario 2: Using Updated localspec1 in Transaction 

The following behavior will occur if you create a new transaction using the updated localspec1:  

1. Regardless if the checkbox is selected, #TRANS and #VER will be shown for a specific Fiscal 
Period. 

Sweden SIE Export 
It is standard in some countries, like Sweden, for companies to transfer accounting data to accountants 
and auditing systems in the SIE text file format. The purpose of the report is to show details of the 
accounts balances. The SIE report shows the opening and closing of the balance sheet accounts and 
balances of the profit and loss accounts.  

The SIE report exports the following information in two SIE file formats:  

 Year-end balance (SIE 1)  

 All recorded transactions and vouchers (SIE 4 and 4i)  
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Producing the Sweden SIE Report 
1. In the Workspace Client, go to Reporting » Statutory Reporting » Sweden. 

 

2. Enter the selection criteria for running the report and click Run Report. 

You will receive a message stating “Background task created.” The file is produced in the next 40 
minutes. 

3. To retrieve the file follow the steps in the next section. 

Retrieving the Sweden SIE Report 
1. For DFME clients — In the Workspace Client, go to Reporting » Statutory Reporting » 

Statutory Report Retrieval. 

For on-premise clients — Go to the path you indicated in the server.ini file. 

2. The report you produced will be listed in the Statutory reports available for retrieval tab (the report 
will take up to 40 minutes after you followed the production steps to appear in this list) 

3. Click on the report in the list and click Download report.  

4. Choose the location to which you want to save the report. 

Setup 
The Finance universe of BPM Reporting use reporting structures to structure and filter accounts. Sweden 
BPM reports require the setup of reporting structures.  

Please contact your Customer Success Manager if you require assistance in reporting structures. 

SIE Export 
The report is created as an SE file. The name of the file is based on the file type (“1” for SIE 1 and “4” for 
SIE 4). For every header it will create a new line. 

Field Description SIE Type 1 SIE Type 4 

#FLAGGA Flag item that specifies 
whether the file has 

Compulsory Compulsory 
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Field Description SIE Type 1 SIE Type 4 

been received by the 
recipient 

#PROGRAM The program that 
generated the file Compulsory Compulsory 

#FORMAT The character set that 
is used Compulsory Compulsory 

#GEN When and who 
generated the file. 
Dates are specified 
using the YYYYMMDD 
format Compulsory Compulsory 

#SIETYP The type of SIE format 
the file follows Optional Compulsory 

#ORGNR CIN of the exported 
company Optional Optional 

#ADRESS Company address 
information Optional Optional 

#FNAMN Complete name of the 
exported company Compulsory Compulsory 

#RAR Financial year from 
which the exported 
data is retrieved 

Compulsory 

Items for both current 

and previous financial 

years are to be present. 

Previous year items can 

be omitted where these 

figures are not 

available. 

4I - Optional 

 

4E - Compulsory 

Items for both current 

and previous financial 

years are to be present. 

Previous year items can 

be omitted where these 

figures are not 

available. 

Chart of Accounts Information 

#KONTO Account information 

Compulsory 

4I - Optional 

4E - Compulsory 

#SRU RSV code for 
standardized accounts 
extract Compulsory Optional 

#DIM Dimension Not Applicable Optional 
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Field Description SIE Type 1 SIE Type 4 

#UNDERDIM Sub-dimension Not Applicable Optional 

#OBJEKT Object Not Applicable Optional 

Balance Items/Verification Items 

#IB Opening balance for 
balance sheet account 

Compulsory 

Items for both current 

and previous financial 

years are to be present. 

Previous year items can 

be omitted where these 

figures are not 

available. 

4I - Not Applicable 

 

4E - Compulsory 

Items for both current 

and previous financial 

years are to be present. 

Previous year items can 

be omitted where these 

figures are not 

available. 

#UB Closing balance for 
balance sheet account 

Compulsory 

Items for both current 

and previous financial 

years are to be present. 

Previous year items can 

be omitted where these 

figures are not 

available. 

4I - Not Applicable 

 

4E - Compulsory 

Items for both current 

and previous financial 

years are to be present. 

Previous year items can 

be omitted where these 

figures are not 

available. 

#RES Balance item for a profit 
and loss account 

Compulsory 

Items for both current 

and previous financial 

years are to be present. 

Previous year items can 

be omitted where these 

figures are not 

available. 

4I - Not Applicable 

 

4E - Compulsory 

Items for both current 

and previous financial 

years are to be present. 

Previous year items can 

be omitted where these 

figures are not 

available. 

#VER Verification item Not Applicable Optional 

#TRANS Transaction item Not Applicable Optional 
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Prompts 

Prompt Title Description Mandatory 

Charts of Account Type Answering this prompt should restrict 
to only show accounts on the 
selected Charts of Account Type. 
Accepts single value. 

Yes 

Company No. Answering this prompt should restrict 
to only show accounts on the 
selected company.  

Accepts single value. 
 

Yes 

Fiscal Year-Period (YYYY-
MM) 

Restricts account transactions on the 
specified period. 

Yes 

Reporting Structure Name Answering this prompt should restrict 
to only use the reporting structure 
input. 

Accepts single value. 

Yes 

Number of Previous Year Shows comparative years. If the user 
selects “0” then only current year will 
be shown, while user selects “1” it 
will show current and previous year 
and so on. 

Yes 

Enter [1] for SIE 1 or Enter [4] 

for SIE 4 

Shows what file type should be 
created. (“1” for SIE 1 and “4” for SIE 
4) 

Yes 
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United Kingdom  
See Statutory Reports Setup to begin. 

Revision History / What’s New 
The table below shows a quick reference of updates.  

Update  Version Description 

UK MTD  2.5.3  Updated BREXIT 

 Updated Postponed VAT Accounting Rules 
(PVA) 

 Added Northern Ireland Protocols 

 Updated Server.ini setup 

Making Tax Digital (MTD) Tax Submission Report 
As of April 1, 2019, the UK HM Revenue and Customs (HMRC) tax authorities implemented the Making 
Tax Digital (MTD) process to use for various tax-related information, including submission of VAT returns. 

The report also includes fraud prevention headers, which are HTTP headers that help monitor and audit 
transactions to protect taxpayers’ data from fraudulent activities. The UK Tax Submissions workspace 
enables companies to send these particular types of user audit data to HMRC. 

Note: In 2021, several changes were made to the MTD filing to reflect BREXIT, the Northern Ireland 
Protocols, and Postponed VAT Accounting Rules (PVA). See the sections below for more details. 

Prerequisites 

This feature has a data prerequisite using the Popup Fields. The popup TaxPopup1 is used to distinguish 
transactions about goods from other kinds of transactions. This popup should already be assigned to GL 
Tax Codes and Tax Codes. For the UK MTD functionality to work, please ensure that in TaxPopup1 the 
Boolean1 field for Goods is checked and for Non Goods is unchecked. This setup ensures that Boxes 8-9 
of the VAT 100 form are populated appropriately. This setup is required because Maconomy does not 
otherwise delineate between goods and services on the GL and Tax Codes.  

1. Open the Workspace Client. 

2. Go to Setup » System Setup » Parameters and Numbers » Popup Fields, and find the Popup 
Tax Popup 1 and open the record. 

3. If needed, add the Boolean 1 column to the table. Right-click on that table and select Customize 
columns. 

4. For the line related to Goods, select the Boolean 1 checkbox. 

5. For the line not related to Goods, ensure the Boolean 1 checkbox is unchecked. 

6. Set up country codes for each country that will be included in the report.  

 Go to Setup » System Setup » Regional Settings » Countries Tab. 

 Select a country. 
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 In the Country Code field, enter the country code and click Save. 

 Repeat these steps for each country. 

Setup in Tax Authority 

 

Filers: https://www.gov.uk/guidance/use-software-to-submit-your-vat-returns 

Agents: https://www.gov.uk/guidance/agents-use-software-to-submit-vat-returns 

Note: Direct any questions about your filing status to your tax advisors or HMRC, as Deltek does not act 
in an advisory capacity in this area. 

HMRC Authentication 

Register Maconomy on the HMRC website to receive an access token to VAT information. The access 
token is valid for four hours and can be refreshed after an access token has expired. The tokens last for 
18 months so you will only need to repeat the authentication process every 18 months.  

HMRC API Authentication 

1. In Maconomy, go to Integrations » UK Tax Submissions » UK Tax Submission 

2. In the VAT Submission tab, click on an existing record or create a new record, then click the 
HMRC Login link.  

3. Enter your personal or company login credentials, and then click Sign In. 

4. Click Grant Authority. 

5. Click Copy to copy the code on the screen.  

Note: The code expires in about 10 minutes. If expired, see steps below.  

6. On the VAT Submission tab, paste the code in the Code field. 

7. Click Get Authentication Token. The Authenticated field in the dialog updates to show Yes.  

Note: You can refresh an expired token as needed.   

Refresh an Expired Authorization Token 

If the authorization token you applied in the HMRC section expires, you can refresh it.  

1. In the UK Tax Submissions workspace, click the Refresh authentication token action as 
needed to refresh your token.  

The workspace search window shows the token is refreshed, and will show a refresh code from 
HMRC to facilitate tracking. 

Request and Submit VAT Obligations  

To request and submit VAT obligations for the selected company for a specific time period: 

1. In the Selection Criteria island, enter the Tax Reporting Unit, From Date, and To Date to define 
the selection criteria.   

Note: The Tax Reporting Unit field is only used if you are using the Tax Settlement feature. If not, 
leave blank. 

2. Click Get VAT Obligations. The VAT Submission Entry tab populates with VAT information. 

If you have not done so already, you must register with HMRC as either a filer or an agent 
using the following links before you can use this functionality in Maconomy. 

https://urldefense.proofpoint.com/v2/url?u=https-3A__www.gov.uk_guidance_use-2Dsoftware-2Dto-2Dsubmit-2Dyour-2Dvat-2Dreturns&d=DwMFAg&c=PyZ6svOU8ZEqDHRgeCjSkA&r=i4pMjgWLFEkkOi1_TgO0wIRQcOHU5ip28HlycYJ6xHI&m=a6vARzpf82GCT7yYH_z5BmN63kYQcYTzicwnECM3hu0&s=jkQsc_-ybjehQKLQtLQNfLbQ4-R3xv_6Dd4g-bItYP0&e=
https://urldefense.proofpoint.com/v2/url?u=https-3A__www.gov.uk_guidance_agents-2Duse-2Dsoftware-2Dto-2Dsubmit-2Dvat-2Dreturns&d=DwMFAg&c=PyZ6svOU8ZEqDHRgeCjSkA&r=i4pMjgWLFEkkOi1_TgO0wIRQcOHU5ip28HlycYJ6xHI&m=a6vARzpf82GCT7yYH_z5BmN63kYQcYTzicwnECM3hu0&s=b6pGI3cx6D51t3bh9ghux3_YKb6a1V-lwQ9RzuJgOak&e=
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Note: You are not able to obtain or view any VAT obligations in the table dialog unless you follow 
steps 2-7 in the HRMC section above and received HMRC authentication. Otherwise, you will 
need to complete steps 2-7 and get an authorization code before continuing. 

3. Select a line in the table for which you would like to retrieve data (the obligation you wish to 
complete) and click Get VAT Data. This action connects to the BPM system and runs the VAT 
query. 

Note: Information populates in the line relating to the submission you are about to send to HMRC. 
If you believe that the information is incorrect, you may make any necessary corrections in 
Maconomy via the adjustment of client or vendor invoices, and click Get VAT Data to run this 
action again.   

Note that if you are using the Tax Settlement features and you do not fill in the Tax Reporting 
Unit field from step 2, an error occurs. 

4. Click Submit VAT Obligation to submit the selected obligation.  

Note: A given obligation can only be submitted once, trying to submit it again will return an error 
from HMRC. When an obligation has been submitted, it will be marked as “Finalized” in the table. 

Retrieve Previously Submitted VAT Obligations 

1. Click Get VAT Return to retrieve an already submitted VAT return. This should update the line to 
the values that were originally submitted. 

2. Select a line in the table for which you would like to retrieve an already submitted VAT return. 
Click Get VAT Return. This should update the line to the values that were originally submitted. 

Setup in Maconomy 

 

Enable MTD Integration 

To enable the MTD Integration feature: 

1. In Maconomy, go to System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the BPM Server REST API URL parameter. 

Notes: 

Workspace Not Default — The UK Tax Submissions workspace is not added to the Menu as 
default. Add the workspace per usual procedures, or engage Services as needed.  

Tax Settlement Setting — The required setting for the UK MTD functionality is to use the Tax 
Settlement functionality in Maconomy. Otherwise, UK MTD will be able to produce any data in the 
Table for submission. 

Period Change Keys — Period change keys are in alphanumeric format. They are in NNAN format 
for quarterly filing and NNAA for monthly/annual filing. The Date Submitted field is included in the 
table to check if the entry has been submitted to HMRC. 

Brexit and Northern Ireland Protocols – Following Brexit effective 1/1/2021, setup for Boxes 2, 8, 
and 9 are only applicable for companies from the Country of Northern Ireland or using the Tax Code 
setup for Northern Ireland. Furthermore, EU Tax Acquisition fields are only setup for tax codes used 
under this rule. 

Postponed VAT Accounting – Following Brexit effective 1/1/2021, Tax Popup 2 is utilized to be 
setup for transactions under the Postponed VAT Accounting rule. Tax Type is also recommended to 
be setup for PVA for auditing purposes. 
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3. On the System Parameter sub-tab, enter the URL to the server in the BPM Server REST API 
URL field. 

4. VAT data is calculated using Tax Settlements Period, by default. If you need to calculate VAT 
date using Entry Dates: 

a. Double-click the Use Entry Dates for UK Tax Submission (Making Tax Digital) 
parameter. 

b. On the System Parameter sub-tab, select the Use Entry Dates for UK Tax Submission 
(Making Tax Digital) check box. 

5. Go to Single Dialogs » Set-Up » Access Control » Groups to set up or confirm access to the 
VAT Submissions and VAT Submission Entries windows. 

6. Go to Single Dialogs » Integrations » Integration Line. Using the normal Extender process, 
add the following line to display in the GlobalMenu: 

<Workspace title="UK Tax Submissions" 

source="uktaxsubmission:UKTaxSubmissionVatSubmissions" /> 

7. Verify in the following binding to the couplingconfiguration.mcsl.xml file if the standard 
couplingconfiguration exists. Otherwise, add the following lines: 

<Binding namespace="mtd"> 

      <Fields> 

        <Field name="HmrcUrl" value="urlRef('mtdhmrcurl') defaultTo 

''" /> 

        <Field name="ClientId" value="urlRef('mtdclientid') defaultTo 

''" /> 

      </Fields> 

</Binding> 

 

8. To enable logging, add the following statement to the logback.xml file (<Path to Maconomy 
installation>\CouplingService\configuration\logback.xml): 

<logger name="com.deltek.maconomy.bpm.uktaxsubmission" 

additivity="false"> 

    <level value="TRACE" /> 

    <appender-ref ref="FILE" /> 

</logger> 

 

9. Add parameters to the Server.ini file as follows: 

a. Add the following parameters to the Server.ini file (<Path to Maconomy 
installation>\CouplingService\server.ini): 

   url.mtdhmrcurl = <URL for MTD API> 

Note: Ensure that there are no customized binding with the same namespace and fields as 
this result to an error when you run the report. 

Note: Other level values available for debugging the errors and fraud header values: 
ERROR, INFO. 
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  url.mtdservertoken = <Maconomy server token> 

  url.mtdclientid = <Maconomy client ID> 

  url.mtdclientsecret = <Maconomy client secret> 

Please reach out to PDM via Customer care for the values of these items.  

b. The following items must also be added to the server.ini file and can be found by running 
the DXDIAG (DirectX Diagnostic Tool) command on your machine. 

url.mtdsysmanufacturer = <Machine System Manufacturer in the 

Computer Information> 

url.mtdsysmodel = <Machine System Model in the Computer 

Information> 

To add these items: 

i. Go to Run in Windows. 

ii. Type DXDIAG and click OK. 

iii. In the System Information window that appears: 

1. Find the System Manufacturer and add it to the 

url.mtdsysmanufacturer item referenced above. 

2. Find the System Model number and add it to the url.mtdsysmodel 

item referenced above. 

 Example:  

 

url.mtdsysmanufacturer= LENOVO 

url.mtdsysmodel= 20NYS6C501 

Import Program for UK MTD Tables 

We have added an import program for customers who previously have used a customization to complete 
VAT submissions, which allows you to import rows into UK MTD history tables. Customers can now move 
from a customized to standard solution.  

The import is available for the following tables:  

VATSubmission 

VATSubmissionEntry 

To move from the customized solution to the standard solution, you have a one-time import where you 
must move old data from custom tables to the new standard tables to consolidate data it in one database 
table. Once you import the historic data, you need no further imports.  

Note: This program is intended for historic (submitted) entries only. Maconomy does not validate the 
correctness of the import data. 

To import data: 

1. Log in to the server.  

2. Create a new import folder and insert the import files (VATSubmissions and ImportVATSubmissions).  
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Example: C:\Import 

3. Ensure the path under VATSubmissions file is correct, based on the folder created above. 

4. Open the command prompt and enter: 

c:\maconomy\tpu.NTx86.21_0.p100f.dir\bin\MaconomyServerMSQL.exe -f -

iMaconomyServer.w_21_0.us-std-msql-1 -Sm21usst1 -xC:\maconomy\w_21_0.us-

std-msql-1\MaconomyDir\MSLPrograms\Import\Integration\VatSubmissions < 

C:\Import\ImportVATSubmissions.txt 

5. In Workspace Client, go to the UK Vat Submission workspace.  

6. Verify if records successfully imported.  

7. Verify the data in the records. 

8. Re-execute the steps 2 to 7 as needed. 

Northern Ireland Protocols 

Setup in Maconomy 

Determine Transactions for Northern Ireland Protocols 

The functionality assumes the ability to distinguish transactions received, sold to, from, or via Northern 
Ireland.  

 A new country is created named “Northern Ireland”.  

 It is assumed that a UK Company can have an office in Northern Ireland. This distinction is set 
with the Country field in Company Information. However, if a UK Company is needed to transact 
via the Northern Ireland protocol, this distinction is not available in Maconomy.  

 Therefore, it is assumed that the Country field in the Tax Code\ G/L Tax Code table is setup so 
that this will be used instead.  

 Northern Ireland is also assumed to be set up as an EU Member but with the same Country Code 
as the UK Country to distinguish interrelations between UK and Northern Ireland. 

In order to account for this, the following setup instructions include values needed for the Countries table. 

Set Up Countries Table 

For UK companies that sell and receive goods/services from an EU member state, such as Northern 
Ireland, set up a country code to specify this. 

1. Go to Single Dialogs » Set-Up » Set-up » Countries » Countries. 

2. Click +New County Code. 

3. In the Name field, enter Northern Ireland. 

4. In the Country Code field, use the same code for United Kingdom. 

5. Select the Member of EU check box. 

6. Click Save. 
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Set Up Tax Codes for Northern Ireland Protocols 

1. Go to General Ledger » Tax »Tax Codes (or G/L Tax Code). 

Note: For G/L tax codes, you must edit the layout of the MDML file. Please contact Services as 
needed for assistance. 

2. Under Country, select Northern Ireland. 

3. Click Save. 

 

Set Up EU Acquisition on Tax Codes 

Note: When setting up EU Acquisition, it is necessary to use the EU Tax Rate for the Tax Code instead of 
the normal Tax Rate field. 

To be able to report on MTD as well as changes for PVA and under the Northern Ireland Protocols, the 
EU Acquisition check box should be setup for transactions on either of the following conditions: 

 Transactions that should be included for the VAT Due Acquisitions field (Box 2) 

 Total Goods Supplied Excl. VAT field (Box 8) 

 Total Acquisitions Excl. VAT field (Box 9) 

 Transactions that are under the Northern Ireland Protocol 

Transactions that may or may not be for Reverse Charge Mechanism   

Note: Acquisition Tax for RCM will not be displayed in Box 2. Instead, see RCM Box definitions and uses 
in the Deltek Maconomy BPM Report Description Guide. 

To setup this up, follow the steps below: 

1. Go to Tax Code/G\L Tax Code 

2. Select the appropriate tax code that needs to be set up 

3. In the Card Pane for Tax Code, select the EU Acquisition checkbox 

UK PVA and RCM 

Setup in Maconomy 

Set up in Maconomy for UK PVA and RCM includes: 

 Popup Field Setup 

 Popup Type Setup 

 EU Acquisition Setup 

 System Parameter Setup 

Important: Country Code and Member of EU fields should be setup for all countries being utilized by 
UK MTD. 

Attention: For EU transactions, see Setup for EU Tax Acquisitions on Tax Code. 
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Popup Field Setup 

To be able to report and display the correct tax related information into UK MTD, you must set up the 
following popup fields with their corresponding values for PVA and RCM.  

This table is provided as an overview. Specific steps are provided below. 

Popup Field Name Value Boolean 1 Value 

Tax Popup 1 Goods true 

 Services/Non-Goods false 

 Gold RCM true 

 Services/Non-Goods RCM false 

 Mobile phones and Computer Chips RCM true 

 Telecom cellular service RCM false 

Tax Popup 2 PVA true 

Tax Type PVA  

 

Determining Transactions for Reverse Charge Mechanism 
The functionality assumes the ability to distinguish additional transactions for reverse charge mechanism. 
However, this distinction is not available in Maconomy, aside from determining as to which transaction is 
for goods or services. In order to account for this, the following setup instructions include values needed 
for Tax Popup 1. 

Determining Goods Transactions 
The functionality assumes the ability to distinguish transactions between goods and other kinds of 
transactions. This is needed for boxes 2, 8, and 9. However, this distinction is not available in Maconomy. 
This also considers transactions that are for reverse charge mechanism.  

To account for this, the following conditions should be setup depending on the transactions: 

Field Boolean 1 value 

Goods transactions 

(Goods, Gold RCM, Mobile phones and Computer 
chips RCM) 

true 

NonGoods transactions 

(Services/NonGoods, Services RCM, Telecom 
cellular service RCM) 

false 

Note: Tax Popup 1 should be set up correctly in Tax Codes that are intended to be included for the 
UK MTD filing. Otherwise, incorrect amounts on boxes display in the report. 
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Set Up Values for Tax Popup 1  

1. Go to Single Dialogs »Set-Up »Set-up » Popup Fields. 

2. Search for Tax Popup 1 and open it. 

3. Under Values, make sure that the following setup is in place: 

Name Boolean 1 

Goods ☒ 

NonGoods ☐ 

Gold RCM ☒ 

Mobile phones and Computer chips RCM ☒ 

Services RCM ☐ 

Telecom cellular service RCM ☐ 

4. Make any necessary changes and save. 

Note: Gold RCM value should also be used for transactions on Gold for PVA. 

Set Up Values for Tax Popup 2 

1. Go to Single Dialogs »Set-Up »Set-up » Popup Fields. 

2. Search for Tax Popup 2 and open it. 

3. Under Values, make sure that the following setup is in place: 

Name Boolean 1 

PVA ☒ 

4. Make any necessary changes and save. 

Set Up Values for Tax Type 

1. Go to Single Dialogs »Set-Up »Set-up » Popup Fields. 

2. Search for Tax Type and open it. 

3. Under Values, make sure that the following setup is in place: 

Name 

PVA 

4. Make any necessary changes and save. 

Set Up Tax Codes for Tax Popup 1 and 2 and Tax Type 

1. Go to General Ledger » Tax »Tax Codes (or G/L Tax Code). 

Note: For G/L tax codes, you must edit the layout of the MDML file. Please contact Services as 
needed for assistance. 
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2. Under the Extra Fields section of the Tax Code sub-tab, select the appropriate value from Popup 
1. This includes the Goods, NonGoods, and values related to RCM. 

3. Under Tax Type, select PVA for Tax Codes used under the PVA rule. Otherwise, leave blank. 

4. Perform the same steps for Popup 2. 

 

System Parameter Setup 

Note: This pertains to UK MTD as a whole. If you have not already enabled this, follow these steps. 

To enable using Entry Dates for MTD instead of Tax Settlement Periods, follow the steps below: 

1. Go to System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Use Entry Dates for UK Tax Submission (Making Tax Digital) parameter. 

3. On the System Parameter sub-tab, [select / deselect] the Use Entry Dates for UK Tax 
Submission (Making Tax Digital) check box. 

Parameter Description 

Use Entry Dates for UK Tax Submission 
(Making Tax Digital) 

Select this parameter to report on MTD 
based on Entry Dates. 

Deselect this parameter to report on MTD 
based on Tax Settlement Periods. 

  

Warning: Tax Codes set up for previously posted transactions are still displayed in the report 
historically. Only newly posted transactions will retrieve the new setup for these tax codes. 
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United States 
See Statutory Reports Setup to begin. 

1099 Misc Report 
Set up a 1099 Misc option list for vendors who need to report 1099-Misc income. 

Setup in Maconomy 

To configure Maconomy to use the 1099 report: 

1. Go to Setup » System Setup » PARAMETERS AND NUMBERS » OPTION LISTS to open the 
Option Lists workspace. 

2. Click New Option List. 

3. In the Option List No. field, enter "1099 Misc". 

4. In the Description field, enter a brief description for the option list. 

5. Click Create and then complete the required fields on the Option List tab. 

6. Double-click the created option list. 

7. In the Options sub-tab, add the options for the 1099 Misc option list. Each option represents a 
specific box number of the 1099 Misc form. Complete the following fields for each box: 
 
Name: Fill in the name of the box. 
Remark 1: Fill in the box number. 
Remark 2: Fill in an integer representing the amount limit. 
Remark 3: Fill in the G/L account used for Withholding tax. Note that the G/L account should have 
"Transfer to Vendor" enabled. 
 
Also note, that if employees are used as vendors, the activities they post on must have "Settle via 
Vendor" enabled. 

To set up vendors to include on the 1099 Misc report: 

Note: Vendor invoices should already be created.  

1. Go to Accounts Payable » Vendors. Select a vendor, then go to Information tab. 

OR 

Go to Single Dialogs » Accounts Payable » Set-up » Vendor Information Card to open the 
Vendor Information Card workspace. 

2. Select a vendor. 

3. In the General Information island of the Vendor Information Card sub-tab or Information tab, 
select the Disclosable check box. 

4. In the Print Control island, in the Statistics 1 Value field enter the name of the option defined 
above. 

5. In the Statistics 1 List field, select “Misc 1099”. 
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Setup in Tax Authority 

No setup required. 

1099 NEC Report 

Setup in Maconomy 

To configure Maconomy to use the 1099-NEC report: 

1. Go to Setup » System Setup » PARAMETERS AND NUMBERS » OPTION LISTS to open the 
Option Lists workspace. 

2. Click New Option List. 

3. In the Option List No. field, enter "1099 Nec". 

4. In the Description field, enter a brief description for the option list. 

5. Click Create and then complete the required fields on the Option List tab. 

6. Double-click the created option list. 

7. In the Options sub-tab, add the options for the 1099 Nec option list. Each option represents a 
specific box number of the 1099 Nec form. Complete the following fields for each box: 
 
Name: Fill in the name of the box. 
Remark 1: Fill in the box number. 
Remark 2: Fill in an integer representing the amount limit. 
Remark 3: Fill in the G/L account used for Withholding tax. Note that the G/L account should have 
"Transfer to Vendor" enabled. 
 
Also note, that if employees are used as vendors, the activities they post on must have "Settle via 
Vendor" enabled. 
 

See the 1099-NEC Option List Values section for information for specific values to enter for this report. 

1099-NEC Option List Values 

To populate the 1099-NEC Option list, enter the following details:  

LINE OPTION VALUE TO ENTER 

 

 

1 Name 

 

 

Nonemployee Compensation 

 
Description Nonemployee Compensation 

 
Remark1 1 (corresponds to the box on the 1099 form) 

 
Remark2 Number representing the amount limit (For example, 600) 

Note: A vendor can only be assigned to one option in the Statistics 1 field. This means that 
each vendor can only be defined for trades that goes into one 1099 Misc box. If this is not 
sufficient (e.g. if a vendor sends invoices related to e.g. Rent and invoices related to 
healthcare, it must be handled by defining two different vendors assigned to each of these 
categories. Also note that 1099 NEC report has a similar setup for vendors. 
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Remark3 G/L Account used for withholding tax 

2 Name Federal Income Tax Withheld 

 
Description Federal Income Tax Withheld 

 
Remark1 4 (corresponds to the box on the 1099 form) 

 
Remark2 Number representing the amount limit (For example, 600) 

 
Remark3 G/L Account used for withholding tax 

3 Name State Tax Withheld 

 

 

 
Description State Tax Withheld 

 
Remark1 5 (corresponds to the box on the 1099 form) 

 
Remark2 Number representing the amount limit (For example, 600) 

 
Remark3 G/L Account used for withholding tax 

4 Name 

 

 

State Payers State No. 

 Description State Payers State No. 

 Remark1 6 (corresponds to the box on the 1099 form) 

 Remark2 Number representing the amount limit (For example, 600) 

 Remark3 G/L Account used for withholding tax 

5 Name 

 

 

State Income 

 Description State Income 

 Remark1 7 (corresponds to the box on the 1099 form) 

 Remark2 Number representing the amount limit (For example, 600) 

Vendor Setup 

To set up vendors to include on the 1099-NEC report: 

Note: Vendor invoices should already be created.  

1. Go to Accounts Payable » Vendors. Select a vendor, then go to Information tab. 

OR 

Go to Single Dialogs » Accounts Payable » Set-up » Vendor Information Card to open the 
Vendor Information Card workspace. 

2. Select a vendor. 

3. In the General Information island of the Vendor Information Card sub-tab or Information tab, 
select the Disclosable check box. 

4. In the Print Control island, in the Statistics 1 Value field enter the name of the option defined 
above. 

5. In the Statistics 1 List field, select “Nec 1099”. 
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Note: A vendor can only be assigned to one option in the Statistics 1 field. This means that 
each vendor can only be defined for trades that goes into one 1099 Nec box. If this is not 
sufficient (e.g. if a vendor sends invoices related to e.g. Rent and invoices related to 
healthcare), it must be handled by defining two different vendors assigned to each of these 
categories. Also note that 1099 MISC report has a similar setup for vendors. 
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CUSTOMIZATIONS 

Workflow 
This process of customization is divided into four main sections, described in the following. 

 

All parts of BPM can in principle be customized in the sense that ETL, Universes, and Report Documents 
can all be modified to fit the needs of customers. 

However, such modifications may be overwritten when upgrading to a new version or service pack of 
BPM. Therefore it is recommended as a general rule that all customizations are done on copies of the 
instances. In the following we shall explain further what that means. 

Customizing ETL 

General Rules 
 All customizations to ETL (that is, jobs or transformations) should be done by new jobs and 

transformations dedicated to handle a certain customization. 

 These custom jobs and transformations must be placed in a folder called “custom” or “Custom” in 
the repository. 

 No standard jobs or transformations should be changed. 

 The folder structure (aside from that in the “custom” folder) should remain unchanged. 

 New jobs/transformations for loading custom-defined data should be scheduled or manually run 
after the standard LoadData or a custom version of LoadData can be made. 

 When upgrading, customizations may need to be reconsidered: 

 An upgrade may introduce standard functionality that previously has been implemented by 
customizations. It is recommended to include the standard functionality in favor of the 
customizations, if they fully satisfy the needs of the customer. 

1
• Customizing ETL

2
• Customizing Universes

3
• Customizing Report Documents

4
• Customizing BPM Dashboards
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 An upgrade may change field names or semantics of fields. Consequently, customizations 
need to be adjusted carefully. 

 An upgrade may declare fields or tables as deprecated (for example, if they are replaced by 
others or not included in Maconomy anymore). Customizations that rely on such fields and 
tables should be considered changed. In some situations it may be convenient for the 
customer to change the customizations such that they still rely on old functionality, for 
example, deprecated fields. Deprecated fields or tables that are removed by the upgrading 
process can then be reintroduced in custom tables. Note that a dump of the content of the 
deprecated table then must be done as part of the upgrade process. 

 Carefully document the steps performed in the customization such that these can easily be 
reconsidered and possibly redone after an upgrade. Primarily, document the following: 

 Which standard tables the custom tables are copies of. 

 Which fields have been added to the copies of the standard tables. 

 The links that have been made. 

Transaction Time Stamps for Customized ETL 
If the data warehouse ETL has been customized, additional tables may need to have transaction time 
stamps enabled. For example, if additional tables are maintained by the customized ETL, and incremental 
load is defined for these tables, the corresponding tables in Maconomy must have transaction time stamp 
triggers enabled. 

Check Enable Transaction Time Stamps in MConfig for the database short name. This action enables 
transaction time stamp triggers for all Maconomy tables, and thus also the tables used in the ETL 
customization. 

 

Customizing Universes 
To ensure that custom universes are not ruined when installing a new BPM package, it is best practice to 
always introduce a custom universe as a copy of a standard universe or a whole new universe. 
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To customize a standard universe, complete the following steps: 

1. In Information Design Tool, retrieve the desired universe to universe files (see Retrieve the 
Universe Files) 

2. Choose another project or folder than the one used for the universe files of the standard 
universes. 

3. The universe files can be edited freely to fit the customer's needs. 

4. Publish the universe. You can choose whether to overwrite the existing universe or publish it with 
another name or to another folder. If you overwrite the existing (Standard) universe, make sure 
that all documents that use that universe (for example, Standard documents) indeed should run 
on the custom universe; otherwise, choose another name or folder for the custom universe. 

When upgrading, custom universes that are stored with another name or in another folder are not 
overwritten. However, it is still recommended that you keep the universe files in case you need to publish 
the custom universes again. 

Customizing Report Documents 
This section describes how to complete report documents and universe customizations. 

You can create the following customizations: 

 Customize a single report 

 Customize multiple reports 

 Customize document styles 

Customizing a Single Report 

To customize a single standard report, complete the following steps: 

1. In Web Intelligence, locate the standard report to customize (in this example, AR Aging). 

 

2. Open the selected standard report and click Document » Save As, then select a custom folder. 
Click OK. 
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3. Make changes to the report and save the document. 

Customizing Multiple Reports 

To copy all or selected standard reports to a custom location, complete the following steps: 

1. In the Central Management Console, click Business Performance Management » Reporting » 
Standard to open the standard reports. 

 

2. Select the report documents that you need, then right-click and select Organize » Copy To. 

3. On the Copy To screen, select a Custom folder and click Copy. 

The selected standard reports are now available as copies in the Custom folder. 

Customizing Document Styles 
The standard report documents are prepared for customization concerning document style. Most of the 
layout elements use a default setting, which means that their style is taken from a cascading style sheet. 
An example is that font family, color, and border style in data tables follow the settings of the cascading 
style sheet. 

The cascading style sheet is built into each report document and is not read dynamically. 

If you want to use another style, you can import a new style sheet into each document. For convenience 
the cascading style sheet of the standard report documents is included in the RPU. This cascading style 
sheet is a good starting point for creating a custom one. 

You can do the following with custom cascading style sheets: 

 Modify 

 Apply the style 

 Export 

Note: Choose the Refresh on open option on the Save As dialog to refresh the report each 
time that you open it. 
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Modify the Style 

To modify a cascading style sheet, follow these steps: 

1. Copy the cascading style sheet from the RPU to the local machine from which WebIntelligence is 
run. 

2. Open the style sheet in a text editor. 

3. Modify the style sheet to the style that you want. 

4. Save the style sheet. 

Now you can apply the style sheet to your documents. 

Apply the Style 

To apply the style of a custom cascading style sheet, follow these steps: 

1. Open the WebIntelligence document to be modified. 

2. Click Properties. 

3. Click Document. 

4. In the window that appears, click Change Default Style... 

5. Click Import Style. 

6. Browse to and select the modified style sheet file. Click Close, OK, and Save. 

The styles of the cascading style sheet are now reflected in the document. 

Export the Style 

To export the cascading style sheet of a document, follow these steps: 

1. Open the WebIntelligence document that contains the style sheet that you want to export. 

2. Click Properties. 

3. Click Document. 

4. In the window that appears, click Change Default Style... 

5. Click Export Style. 

6. Browse to the location of the style sheet file that you want to export. 

7. Click Save. 

A cascading style sheet file that reflects the styles of the document is saved to the file system. 
You can use this as a foundation for customizing the styles, similar to using the cascading style 
sheet delivered in the RPU. 
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Customizing BPM Dashboards 
You can do the following to customize BPM dashboards: 

 Edit the JSP files 

Editing the JSP Files 
Each of the three BPM Dashboards has a JSP page that contains four iFrames that reference dashboard 
components (WebI Documents) in InfoViewApp. 

 

The three JSP pages that are found in the RPU are as follows: 

For Standard Dashboards: 

/dashboards/reporting/ 

 CompanyPerformance.jsp 

 CustomerPerformance.jsp 

 JobPerformance.jsp 

For CPA Dashboards: 

/dashboards/reporting/cpa/ 

 CustomerPerformance.jsp 

 JobPerformance.jsp 

 

Note: CompanyPerformance.jsp is also used in CPA solution dashboards as the document 
names used are the same in Standard. 
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You can see the layout of the iFrames in this part of the code in each JSP: 

out.println("<table>"); 

out.println("<tr>"); 

out.println("<td>"); 

out.println("<iframe src='" + ProductionRevenue + "' height='100%' width='100%'>" 

+"</iframe>"); 

out.println("</td>"); 

out.println("<td>"); 

out.println("<iframe src='" + CashReceipts + "' height='100%' width='100%'>" 

+"</iframe>"); 

out.println("</td>"); 

out.println("</tr>"); 

out.println("<tr>"); 

out.println("<td>"); 

out.println("<iframe src='" + ArAging + "' height='100%' width='100%'>" +"</iframe>"); 

out.println("</td>"); 

out.println("<td>"); 

out.println("<iframe src='" + WIPAging + "' height='100%' width='100%'>" 

+"</iframe>"); 

out.println("</td>"); 

out.println("</tr>"); 

out.println("</table>"); 

The src attribute contains the path to the dashboard component. 

The following figure shows a sample variable that contains the source path to the dashboard 
components. 

//OpenDocument URLs for each of the Job Dashboards Components 

 

String ProductionRevenue="http://" + cmsName + 

":8080/OpenDocument/opendoc/openDocument.jsp?sType=wid&sPath=[B

usiness+Performance+Management],[Reporting],[Dashboard+Componen

ts],[Job]&sDocName=Registered+Billing+Price,+Top+10+Jobs+%28Bar

+Chart%29&token=" + wscToken + … 

The sPath parameter indicates the location of the report/dashboard component. 

The sDocName indicates the name of the report. Note that the name of the report must be properly URL-
encoded with spaces converted to “+” instead of “%20”. 

You can also pass prompt values to the dashboard components via the URL by using the URL-encoded 
name of the prompt. Thus, if you want to pass a value to the prompt “Account Manager No:” add the 
following part to the URL: 

&lsSAccount+Manager+No%3A=" +  accountMgrVal 

 

 

An example of how to change the dashboard is shown in the following: 

Note: The name must be preceded by IsS. 
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1. Open the file to be changed. 

 

2. Scroll down to the section where the four dashboard components are referenced. 

 

3. Create a copy of the line to be changed and comment one out. 
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4. Change the name of the referenced component. 
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The following shows the result. 
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Localization 
In BPM, you perform tasks for localization using the BusinessObjects Translation Manager tool, which is 
part of BOE. The Translation Manager uses the standard XLIFF XML-schema that defines the word or 
term translation between all standard languages. You cannot create languages, but you can maintain 
several versions that represent different dialects. For example, for the language “English,” there are 
different kinds (dialects) such as US English and UK English. 

You can localize both universes and reports. 

This section includes the following material and procedures: 

 BPM translator tool overview 

 Perform a translation 

BPM Translator Tool Overview 
Maconomy uses simple text files that are called dictionaries that contain word-to-word translations. These 
dictionaries are translated to XLIFF format using BPM’s Translator tool. 

The Translator tool takes two input parameters: 

 A Maconomy dictionary 

 Initial XLIFF file 

The Maconomy dictionary is a text file that contains word combinations (terms) of items such as universe 
object names and descriptions. The dictionary associates these terms with corresponding terms in 
another language. The terms in the two languages are tab-separated. The Translator tool recognizes 
space symbols as part of the terms so that, for example, “good night” can be translated into “buenas 
noches.” 

The Translator tool takes the Maconomy dictionary and an initial XLIFF-file and generates another XLIFF-
file by substituting dictionary terms that occur before the tab symbol with dictionary terms that occur after 
the tab symbol. The initial XLIFF-file is generated from the universe and reports and thus contains all of 
the terms that are necessary for the translation. 

Perform a Translation 
This section describes how to perform a translation. To perform a translation, you must: 

 Generate the initial XLIFF file 

 Modify the initial XLIFF file 

 Perform the translation 

Generate the Initial XLIF File 

To generate the initial XLIF file, follow these steps: 

1. Run the BusinessObjects Translation Manager. 

2. Click File » Import from CMS. 

3. Browse to and select the universe to be localized, and then click Add. 
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4. Click Import. 

The following example shows selections for steps 3 and 4. 

 

5. Click Add. 

6. On the Language Management tab, select the From and To languages. 

The original language is already selected. You must select two additional languages. 

 Original language — Refers to the language of the universe (Maconomy W language). This 
is selected from the start. 

 From-language — The language to which the Maconomy W language refers in XLIF. This is 
usually English (United Kingdom), and terms are provided in UK English by default. 

 To-language — The language into which you want to translate, such as Spanish. 
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After you have designated the languages, the following is displayed. 
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7. Click File » Export to XLIFF. 

 

8. Select Source to designate one of the languages as the language in which the universe is 
provided. In the preceding example, it is English (United Kingdom). The source should be the 
same as the language from the first Dictionary-file column. 

9. Click Next. 

10. From the Available Languages list, select the From language for the XLIFF file. 
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11. Click the arrow to move the languages to the Selected Languages list. 

These are the To languages for translation. 

 

12. Click Finish. 

Two files are available in the XLIFF file folder: 

 AR Aging.unv_en_GB_en_GB.xlf 

 AR Aging.unv_en_GB_es_ES.xlf 

The file that has different languages in its name should be the initial XLIFF file that is used as one of 
the tool’s input files. 

Modify the Initial XLIFF File 
The initial XLIFF file contains all of the terms of the universe; however, you must incorporate the 
translation principles of the Maconomy dictionary. Therefore, you should apply this tool to modify the 
initial XLIFF file before continuing. 

 

Perform the Translation 

To perform the translation, follow these steps: 

1. Click File » Import from CMS and import the universe to the Translation Manager. 

2. Click File » Import from XLIFF and import the output file created in the previous steps. 

Tip: Refer to the readme.txt file that is provided with the tool for translating the Maconomy dictionary 
file into XLiff for information about how to run that tool. 
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3. After you import the XLIFF file, select the second language in the list as Ready for use. 

 

4. Export the universe to the CMS and run WebI to validate that the translation has been applied. 

 

Tip: It is recommended that you export a copy to another location, so that future upgrades of the 
standard delivery do not overwrite the changes. See the Business Performance Management 
Reporting Customization and Upgrade Guide. 
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SYSTEM MAINTENANCE and REGULAR USE 
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Data Warehouse Maintenance 
Data warehouse maintenance includes: 

 Creating ETL jobs 

 Scheduling loads 

 Processing manual loads 

Top-Level Jobs for Maintaining the Data Warehouse 
The following are top-level jobs for maintaining the data warehouse. The first two jobs are for loading 
data. The third is for upgrading. Once a data warehouse is successfully created, you want to load data 
regularly, such as once a day or once a week, using Incremental Load. Once a month or so, run Full Load 
to get any missing dependencies corrected. Run Upgrade when you install service packs or new 
versions. 

Use the following jobs for maintaining the data warehouse once it has been created: 

Full Load This job resets the fact tables and loads all data in again. 
Over time the data in incrementally loaded fact tables may become out of sync 
with some data in their dimension tables for certain scenarios. For example, a 
record in a dimension table may change without resulting in corresponding fact 
records to be adjusted. 
 

Therefore, it is recommended to do a full load, for example, once a month. 

 

Incremental Load This job loads data that have changed, been inserted or deleted, such as once 
the data warehouse has been created, new or modified data are retrieved by 
running this job.  

   It is recommended to schedule this job to run regularly. 

 

Upgrade  This job upgrades the data warehouse. 
  

Scheduling Loads 
For periodic updates of the BPM DWH, you must use incremental loads. The Kitchen tool, which is part of 
Pentaho Data Integration, allows you to launch jobs, such as Incremental Load, from the command line. 

 

The call may be displayed as follows: 

Kitchen.bat /rep: Pentaho repository /job: "Incremental Load" /dir:/ /user:admin 

/pass:admin /level:Basic 

 

Tip: For more information, see documentation about Pentaho Data Integrator. 

Note: Periodic updates are accomplished by writing a batch script that launches Kitchen and 
then schedules the launch of the script. 

file:///C:/Users/jennifercarr/Documents/1_Maconomy/2.5.1/BPM%20Restructuring/DeltekMaconomyBPMInstallandStatutorySetupGuide.docx%23_Pentaho_Data_Integrator
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Start a text editor, such as Notepad, paste the following text, and then save it as updateDWH.bat. 

@echo off 

rem remove '-' from the date 

for /F tokens=1-4 delims=-  %%i in ('date/t') do set filedate=%%i%%j%%k 

rem remove ':' from the date 

for /F tokens=1-4 delims=:  %%i in ('time/t') do set filetime=%%i%%j%%k 

rem set the log filename with date and time 

set logfilename=C:\Kettle-2[1].3.0\MyLogFiles\Log_%filedate%_%filetime%.log 

call Kitchen.bat /rep: Pentaho repository /job: "Incremental Load" /dir:/ 

/user:admin /pass:admin /level:Basic > %logfilename% 

echo Load finished. See the logfile %logfilename% 

To schedule loading of data through a Scheduled Task, follow these steps: 

1. Create a folder named MyLogFiles in the Kettle folder. 

2. Open a command prompt and make the Kettle folder the current directory. 

3. To test the script, write updateDWH.bat. This may take some time, since the script loads the 
data warehouse. 

4. Open the control panel and then open Scheduled Tasks. 

5. Click Add Scheduled Task, browse to select the script updateDWH.bat, and specify how often 
to perform the task (for example, daily or weekly). 

6. Go through the rest of the wizard. You must enter the password of the user for whom the task is 
scheduled. 

Process Manual Loads 

To process manual updates of data warehouse, follow these steps: 

1. On the repository, start Spoon. 

2. Log in as admin/admin. 

3. Open the Incremental Load job. 

4. Run the job (F9). 

 

 

Note: The tab Log view should display Success in the result column. If you cannot open the 
repository, it may be because a firewall is blocking the access. Deactivate the firewall or 
consult your network administrator. 
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Other Setup 

In this section… 
This section includes these additional procedures: 

 Install the Oracle Instant Client Drivers (Windows) 

 Set Up an ODBC Connection for SQL Server 

 Enable Unicode 

 Increase the Number of WebI Connections 

 Configure Characterset Settings if Using Oracle 

 User Setup and Single Sign-On 

 Configure Logon Token on BusinessObjects 

 Localization 

 Handling BusinessObjects Services 

 Use a Non-Standard Web Server Port 

 Set Templates for Web Intelligence 

 Burst Publishing 

 Materialized Views on Oracle  
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Install the Oracle Instant Client Drivers 
(Windows) 
If your Maconomy system uses Oracle DBMS, and the BPM server is different from the one that has the 
Maconomy database, you must install Oracle drivers to allow BusinessObjects access to the database 
and to prevent the following warning. 

 

To install the Oracle Instant Client Drivers, follow these steps: 

1. Navigate to: http://www.oracle.com/technology/software/tech/oci/instantclient/index.html. 

2. Select your operating system. 

3. Review and accept the license agreement and click Next. 

4. Download either Instant Client Package-Basic or Instant Client Package-Basic Lite. 

5. Unpack the drivers to a folder (for example, C:\Program Files\Oracle). 

 

http://www.oracle.com/technology/software/tech/oci/instantclient/index.html
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6. Add the path to the drivers to the PATH variable. 

 

7. Create the variable TNS_ADMIN with the path to the same folder. 

8. Create tnsnames.ora in the folder, for example: 

maconomy = 

(DESCRIPTION = 

(ADDRESS_LIST = 

(ADDRESS = (PROTOCOL = TCP)(HOST = MACONOMYSERVER)(PORT = 1521)) 

) 

(CONNECT_DATA = 

(SERVICE_NAME = maconomy) 

) 

) 

In this example, MACONOMYSERVER is the server that hosts the maconomy database, and 
maconomy is the SID of that database. 
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Set Up an ODBC Connection for SQL Server 
To set up the ODBC connection, follow these steps: 

1. Run Data Sources (ODBC) using the appropriate path: 

 For 32-bit Windows — Click Control Panel » Administrative Tools » Data Sources 
(ODBC). 

 For 64-bit Windows — Click All Programs » BusinessObjects XI 3.1 » BusinessObjects 
Enterprise » 32-bit Data Source (ODBC). 

2. Click Add. 

 

3. Select SQL Server and click Finish. 
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The Create a New Data Source to SQL Server wizard is displayed. 

4. Enter the Name, Description, and Server information, and click Next. 

 

5. Select the method to use for authentication and click Next. 

 

6. Enter the default database and ANSI information and click Next. 

The following dialog box is displayed. 
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7. Click Finish to complete the process. 
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Enable Unicode 
Beginning with version 16.0 (2.1), the Maconomy database and BPM must be Unicode-enabled. You do 
this as part of the installation or upgrade. 

To set up BPM for supporting Unicode, follow these steps: 

1. After you enable the Maconomy database for Unicode, follow the same steps for enabling the 
BPM Datawarehouse database for Unicode. See the documentation for information about how to 
enable Unicode on the Maconomy database. 

2. If you are upgrading BPM Analysis, perform the upgrade steps as described in the Upgrade 
section. 

3. If this is a new installation, perform the installation steps that are described in the BPM Analysis 
Installation Guide. Note that the database for the data warehouse must be Unicode-enabled. 

4. If you have BusinessObjects installed on Windows, perform the following steps: 

a. In the Windows registry set the following key: 

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_OraDb11g_home1\NLS_LANG 

to 

AMERICAN_AMERICA.AL32UTF8 

b. Create a system variable NLS_LANG and assign it the value: 

AMERICAN_AMERICA.AL32UTF8 

5. If you have BusinessObjects installed on Linux or AIX, perform the following steps: 

a. Set up an environment variable NLS_LANG with the value AMERICAN_AMERICA.AL32UTF8. 

b. Restart the BusinessObjects services. 

Ensure that universes have the parameter UNICODE_STRINGS set to YES (this is the default value). 

  

file:///C:/Users/jennifercarr/Documents/1_Maconomy/2.5.1/BPM%20Restructuring/DeltekMaconomyBPMInstallandStatutorySetupGuide.docx%23_Upgrade_the_ETL
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Increase the Number of WebI Connections 
In the solutions, the Workspace Client embeds various BPM Reporting reports. To support this, you must 
increase the default number of parallel connections. 

To increase the number of parallel connections, follow these steps: 

1. Log in to BusinessObjects Enterprise Central Management Console (CMC). 

2. Click Servers. 

3. Expand Server Categories and click Web Intelligence. 

4. Under Server name, double-click WebIntelligenceProcessingServer. 

The Properties window appears. 

5. In the Properties window, under Web Intelligence Processing Service, enter the appropriate 
number of parallel connections. 

The default value is 50. It is recommended that you increase the value to at least 100. 

Alternatively, add more servers. Adding one more server with the default of 50 parallel connections yields 
the same number of connections (100) as the preceding steps. 

On large production systems, it is recommended that you increase the number of servers and then lower 
the number of parallel connections on each of those servers. However, note that each user who runs the 
Workspace Client occupies a number of WebI connections. 

 

  

Note: It is recommended that you not have more than one Web Intelligence Report server per 
available CPU core. 
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Configure Characterset Settings if Using Oracle 
BusinessObjects needs to know the characterset of Oracle to correctly display characters. You should set 
the environment variable NLS_LANG on the BO server. 

To configure characterset settings, follow these steps: 

1. Determine the NLS_LANGUAGE and NLS_CHARACTERSET using the following statement: 

SELECT * FROM NLS_DATABASE_PARAMETERS WHERE PARAMETER IN 

('NLS_LANGUAGE','NLS_CHARACTERSET') 

 

2. Set the environment variable NLS_LANG to the concatenation of these two strings separated by 
a dot, for example, AMERICAN.WE8ISO8859P1. 

 

  

Tip: For the default setup, the result is AMERICAN, WE8ISO8859P1. 
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User Setup and Single Sign-On 
This section contains the following topics: 

 User setup and single sign-on overview 

 Active desktop and Maconomy configurations 

 USync 

 Configure a tenant in a multitenancy environment 

 Control which users to create 

 Error handling 

 Assign report and universe rights 

In Maconomy, access to data is controlled by the user name (NameOfUser). If single sign-on (SSO) is 
not defined and used, a user must log in to BusinessObjects using the same user name to be able to 
access data. 

However, most often SSO is defined both in Maconomy and BusinessObjects. 

 In Maconomy, a network user name is defined for each user. This network user name is equal to 
the active directory (AD) (Windows) user name. When you log in to the network, log-in is 
automatically performed in Maconomy using the network user name. Access to data is controlled 
by the user name with which the network user name is associated. 

 In BusinessObjects, the AD (Windows) user name is the normal user name and thus equal to the 
network user name. To have access to Maconomy data, you create an alias for that user name. 
This alias is equal to the user name (NameOfUser) in Maconomy. When you log in to the 
network, log-in is also automatically performed in BusinessObjects using the user name. Access 
to the Maconomy data is via the alias that matches the user name (NameOfUser) in Maconomy. 

The following figure illustrates this. 

 

Example 
 In Maconomy, Anders Hansen uses AH as the network user name (and thus also AD log-in). 

 Anders Hansen logs in to the network and automatically logs in to Maconomy as AH. 

 This gives Anders Hansen access to all of the Maconomy data that his user name is defined to 
have access to. 
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 When opening WebIntelligence in BusinessObjects, Anders Hansen is automatically logged in as 
AH. 

 The BusinessObjects user AH has the alias Anders Hansen. Therefore, the user has access to all 
of the Maconomy data that Anders Hansen is defined to have access to. 

 

Active Desktop and Maconomy Configurations 
Users must exist as AD (Windows) users on the domain. The mapping in Maconomy must be set up 
properly so that each Maconomy user has his or her AD (Windows domain) user name specified in the 
Network Username field in the Users workspace in Maconomy. 

For example, the person Anders Hansen might have the user name AHA on the domain. The Network 
user name for the Maconomy user Anders Hansen should therefore be filled in as AHA. 

USync 
You can use the USync tool to create users, user groups, and user aliases in BusinessObjects. USync 
creates BusinessObjects users and groups that correspond to the users in the Maconomy system. You 
can configure USync to create only users for which certain criteria are met. 

USync can also remove BusinessObjects users or groups. This is convenient if users and groups have 
been removed from Maconomy. 

Use the USync tool to complete the following tasks: 

 Create users and groups in BusinessObjects that correspond to the ones that are defined in 
Maconomy. This allows users to access Maconomy data when running reports. 

 Create aliases for each user so that, when logged in using another name by means of SSO, 
users can still access data. 

 Synchronize users and groups for a tenant in a multitenant environment. 

It is assumed that both Maconomy and BusinessObjects are set up for SSO. 

Install USync 

To install and prepare the USync tool: 

1. Log in to the Maconomy server system. 

2. Start MConfig and select the appropriate Maconomy application. 

3. Click Web products and select the web server. 

4. Click OK and apply the change with MConfig. 

5. On the Web Products screen, enable Web Services. 

6. Download the file USync.zip from the download server: 

\\dl\applications\Released\BPM\Tools\USync\BO 4.2\  

7. Extract the zip file to a folder on the server where BusinessObjects is installed. Make sure that 
both the USync.jar file and the “external” folder are within the same folder. 

Note: With multi-user roles, Maconomy passes the login name as the user name. 

file://///dl/applications/Released/BPM/Tools/USync/BO%204.2/
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Create Users and Groups 

To transfer users and groups from Maconomy with USync: 

1. Log in to the server on which BusinessObjects is installed. 

2. Open a command prompt. 

3. Run the USync java tool and enter the following parameters in the exact sequence as listed:  

 <Maconomy administrator username> – Enter the username of the Maconomy 
administrator to access the Web Service. 

 <Maconomy administrator password> – Enter the password of the Maconomy 
administrator to access the Web Service. 

 <URL to MaconomyWS executable on web server> – Enter the Maconomy web service 
URL from which USync derives the list of users to create in BusinessObjects. 

 <BO username> – Enter the username of the BusinessObjects user that has access to view, 
create, modify, and delete users in the CMS. 

 <BO password> – Enter the password of the BusinessObjects user that have the rights to 
view, create, modify and delete users in the CMS. 

 <BO Server name> - Enter the BusinessObjects server where users are created.  

 <BO Authentication Type> – Enter the authentication type that USync uses to log in the 
provided BO user above. It is recommended to use secEnterprise. 

 <Log level> – Set the value to 100 to show the minimum amount of information in the logs or 
to 500 to show a detailed trace of information. 

 <Path and file name of log file> – If there is no log file, the tool creates a new log file. If a 
log file already exists, the tool appends the logs to it. Note that USync does not create 
folders. 

 <Delete-user-data (true/false)> – This determines whether to allow USync to automatically 
delete a user in BusinessObjects that no longer matches with a user in Maconomy. 

 <Create named BO users (true/false)> – This determines the license type used to create 
the users. Set this to true to create named users (one license required per user) or false to 
create concurrent users (number of license pertains to the number of users that can login at 
the same time, no limit on the number of users that can exist in the CMS) 

 <Create AD aliases in BO (true/false)> – This determines whether BusinessObjects 
requires the configuration of the Windows AD plugin. Set this to true to automatically assign 
an alias to users that exists in Windows Active Directory. 

 <Domain name used for AD alias creation> – Enter the combined prefix and extension of 
the domain name used for AD alias creation (for example, trifolium.com). This is only 
necessary if the “Create AD aliases in BO” parameter is set to true. 

 <Default password for new BO users> – Enter a default password that all new created 
BusinessObjects users can use. This is only used for Enterprise authentication.  

 <Passwords never expire (true/false)> – To determine the expiration of passwords, enter 
true to ensure the user’s password will never expire. If you enter false, the user’s password 
expires according to the configured user restriction in CMC » Authentication » Enterprise. 
By default, this parameter’s value is set to false. 

 <Must change password (true/false)> – To determine whether the user must change the 
default password when first logging in,  enter true to force users to change password on first 
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log in. Note that you cannot set this parameter to true if the “Can’t change password” 
parameter is also set to true. 

 <Can’t change password (true/false)> – To determine whether who can set passwords, 
enter true to allow only the system administrators to set passwords. Note that you cannot set 
this parameter to true if the “Must change password” parameter is also set to true. 

 <Whitelisted group> – Use this parameter to determine which users should not be deleted 
by USync when the “delete-user-data” parameter is set to true. Leave this blank if no group 
needs to be whitelisted.  

 <Allow update of existing BO users> – This parameter controls whether the properties of 
an existing user in BusinessObjects is updated by USync. By default, this parameter’s value 
is set to false. 

For example, if you enter: 

java -jar USync.jar "Administrator" "123456" "http://BPMServer:20001/cgi-

bin/Maconomy/MaconomyWS.w15p2mc.US_MCS.exe/" "Administrator" "ppu" 

"macsrv.trifolium.com" "secEnterprise" "100" "C:\temp\usync.log" "false" 

"false" "true" "trifolium.com" "1234-Pass" "true" "false" "false" "" "true"  

This does the following: 

 Creates users and groups that correspond to users and groups that are set up in 
Maconomy. If only certain users are wanted, you can define criteria for them. 

 

 Creates aliases for these users to handle access control. 

 Does not remove existing users that are defined in BusinessObjects. The users that are 
created are in addition to the users that are already there. 

 Sets the default password of the new users to 1234-Pass. 

 Uses the web server executable (a 15.0 sp 2 MCS system in the preceding example) to 
determine the Maconomy system that is used. 

 Stores the log output from USync in the file C:\temp\usync.log. 

4. Open the Central Management Console and click Groups or Users to confirm that the 
synchronization succeeded. 

For each user, you can see the group memberships on the Member of tab. For each group, you 
can see the members of the group on the Users tab. If you chose to create AD aliases, you can 
see them under each user in the lower part of the window. 

Configuring a Tenant in a Multitenant Environment (Optional 
Installation) 
Multitenancy enables you to host multiple clients on one server where each client has their own access 
sites and properties. These additional steps are optional and not part of the Usync default installation.  

The setup of multitenancy includes the following steps: 

 Tenant configuration in the Maconomy Workspace client. 

 Set up corresponding tenant in BusinessObjects server. 

Note: See Configuring a Tenant in a Multitenant Environment (Optional 
Installation). 
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 Synchronize users using Usync. 

Set Up a Tenant Name in Maconomy 

To set up a tenant name in Maconomy: 

1. Open the System Information single dialog workspace. 

2. Scroll down to the Tenant Name island and enter a unique name in the Tenant Name field. 

 

Note: To check if a tenant name is already in use, go to BusinessObjects CMC » Multitenancy.  

3. Click Save. 

Validate the Tenant Name in Maconomy: 

To validate the tenant name in Maconomy: 

1. Log in to the Maconomy Workspace Client with the necessary rights to access system setup, 
preferably as Administrator. 

2. Open the Users workspace (Setup » Users) and expand the User Information tab. 

3. Add the Tenant Name column to the Roles tab. 

a. Right-click any column on the Roles tab and click Customize columns. 

b. In the Available Columns section, select Tenant Login Name. 

c. Click Add and move the column up or down, depending on the desired location. 

d. Click OK. 

4. In the Tenant Login Name column, verify that the tenant name is prefixed in the login name with 
the format tenantName#LoginName. 
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Register Tenant with BusinessObjects 4.2 Multitenancy Management Tool (Windows) 

BusinessObjects 4.2 Business Intelligence Platform comes pre-installed with the Multitenancy 
Management Tool (MTM). This tool handles the registration of a tenant and other configurations 
controlled through a template definition file.  

 

To define MTM properties: 

1. Open the tenant_template_def.properties file in a text editing application. The file is located in 
the same directory as the BusinessObjects 4.2 Multitenancy Management Tool. 

Note: The default location and file name is <InstallDir>\SAP BusinessObjects Enterprise XI 
4.0\java\apps\multitenancyManager\jars\multitenancymanager.jar. 

2. In the tenant_template_def.properties file:  

a. Add the desired tenant name to the tenantName parameter. For example, 
tenantName=XXX. 

b. Add the mandatory login information: 

 cms 

 auth 

 user 

 pwd (Optional. If left blank, user is prompted for password to proceed.) 

3. Save the file. 

Run the MTM tool 

To run the MTM tool: 

1. Open a command prompt. It is recommended that you run this as Administrator to avoid 
permission conflicts. 

2. Change the directory to the location of the multitenancymanager.jar file (<InstallDir>\SAP 
BusinessObjects Enterprise XI 4.0\java\apps\multitenancyManager\jars) 

3. Run the  following command: 

 
 java -jar multitenancymanager.jar -configFile 
tenant_template_def.properties 

Tip: Refer to the SAP Multitenancy Guide for more information. 

https://help.sap.com/doc/businessobject_product_guides_sbo42_en_sbo42_bip_mtm_en_pdf/4.2/en-US/sbo42_bip_mtm_en.pdf
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Verify the Tenant is Created Successfully 

To verify the tenant is created successfully: 

1. Log in to the Central Management Console. 

2. On the Multitenancy tab, verify the tenant name is listed in the Name column. 

Synchronize Users with USync 

To synchronize users with USync: 

1. Download the USync.zip from the dl server at   \\dl\applications\Released\BPM\Tools\USync\BO 

4.2 Multitenancy\. 

2. Extract the zip files. 

3. Open a command prompt (run as Administrator). 

4. Change the directory to the location of the extracted zip file, USync.jar. 

5. Run the command: java -jar USync.jar with the following parameters: 

PARAMETER VALUE 

Maconomy Username Maconomy Admin username 

Maconomy Password Maconomy Admin password 

Web Service URL MaconomyWS URL found in ..\maconomy\index.html 

BO Username BO Admin username 

BO Password BO Admin password 

CMS BO Server 

BO Authentication secEnterprise, secWinAD, etc. 

Log Level 0 = no message, 500 = debug mode 

Log File Name File for the log file including directory 

Delete User Data delete users that does not exist in Maconomy 

Named Users Boolean, true=named user or false=concurrent user 

Create AD Aliases Boolean, create AD Alias for SSO 

AD Domain used for AD Alias Creation 

Default Password Password assigned to created BO users 

Passwords Never Expire Boolean, user attribute 

Must Change Password Boolean, user attribute 

Can’t Change Password Boolean, user attribute 

White List Groups Groups ignored by delete user data parameter 
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PARAMETER VALUE 

Allow Update Allows USync to update existing users 

Example: 

 

6. When completed, verify that the users and groups are created in BusinessObjects CMC. 

a. Log in to Central Management Console. 

b. On the Users and Groups tab, verify both users and groups are prefixed with the tenant 

name. 

Control which Users to Create 
To create only specific users, or users that satisfy certain conditions, configure USync. 

To configure USync, follow these steps: 

1. In the Maconomy web server folder \MaconomyWS\Services\Standard locate the 
USyncSQL.txt file. 

2. Edit the file so that it contains an SQL-like expression that selects the users. 

Examples 

Example 1: Select Users by Means of Popup 1 

You want to control which user to import by using Popup 1 on the employee who is associated with the 
user. If you set up this pop-up with one value, BusinessObjects, so that it either has this value or is blank 
on each employee, you can insert the following additional condition in the WHERE clause for the import 
of user data and role membership data. 

0 = (select EmployeePopup1 from Employee  

   where EmployeeNumber = UserInformation.EmployeeNumber) 

If there is no employee on the user, the selected value is null. If Popup 1 is blank on the employee, the 
selected value is -1. 

Example 2: Select Users Based on Roles 

You want to import only those users who have certain roles. In this case, use the following additional 
condition: 

EXISTS (SELECT 'OK' FROM EXUserDialogGroup  

    WHERE NameOfUser = UserInformation.NameOfUser  

       AND GroupName IN ('FinancialManagement', 'LineManagement')) 

In an MAS solution, this imports 19 users, including Andy Polansky, Lisa Welsh, and Sue French. In the 
MCS solution you could change the restriction on the group name to GroupName IN 
(FinancialManagement, DepartmentManagement, AccountManagement), and then you would get 17 
users, including Edward Powers and Micho Spring. 

Error Handling 
The output message may contain errors. 
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 If the output message contains: 

 “This user does not exist” — You did not enter a valid Maconomy user name. 

 “Password is not correct” — You did not enter a correct password for the Maconomy user. 

 “Enterprise authentication could not log you on” — There is a problem with the 
BusinessObjects username or password. 

 If you cannot open the http://localhost/index.html page, there may be an error in the global 
parameters in M-Config. Open M-Config, click the Global settings button and make sure that 
the Export HTML index file to field has the correct value (for example: 
C:\Apache\Apache2\htdocs). 

(404) Not Found 

 If the output message contains “(404) Not Found,” there is a problem with the URL in the Web 
service URL field. This is also the case if the output message refers to SAXParseException, 
ConnectException, UnknownHostException, or “unknown protocol.” 

One possible reason for the 404 error could be that the Webserver URL in M-Config is incorrect. 

To fix the 404 error, follow these steps: 

1. Open M-Config. 

2. Select the relevant application. 

3. Click Web products. 

4. Select the appropriate web server. 

5. Click Web server parameters and make sure that the Webserver URL (host and port) field has 
the correct value. 

For example, if the installation uses a virtual web server, the field should be http:// followed by 
the name of the server, followed by the virtual web server port number (separated by a colon), 
with a / (slash) at the end. If you make a change in M-Config, you may need to restart the web 
daemon before the changes take effect. 

Assign Report and Universe Rights 
Before you perform this procedure, you must consider which users or groups should be given access to 
which reports and universes. 

To manually set up access rights in BusinessObjects, follow these steps:  

1. Open the Central Management Console. 

2. Click Folders and then locate the reports in the Maconomy folder. 

3. For each report, set up the access rights by clicking on the report and opening the Rights tab. 

4. Make sure that the rights for the group Everyone are set to No Access, click Add/Remove to 
insert a line (for example, a new group), and then click OK. 

5. Change the rights to a different setting, for example, View On Demand. 

http://localhost/index.html
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Note: You must grant each universe and connection to the specific groups of users. This may 
take some time if there are many groups and many reports. 

It is recommended that you assign rights to groups (containing users), rather than directly to 
users. 
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Configure Logon Token in BusinessObjects 
With the Dashboard Components iFrames installed, an “obsolete token error” might occur if the token that 
is used for signing in to BusinessObjects has expired. 

There are two ways to avoid this error, both of which involve changing the files that are deployed in 
BusinessObjects: 

 Increase available document instances 

 Prevent users from using outdated tokens 

Increase Available Document Instances 
To increase the number of document instances that are available on the system, modify the parameters 
in the webi.properties file. 

To modify the webi.properties file appropriately, follow these steps: 

1. Locate the webi.properties file at C:\Program Files(x86)\Business 
Objects\Tomcat55\webapps\AnalyticalReporting\WEB-INF\classes\webi.properties. 

2. Uncomment the WID_FAILOVER_SIZE=11 and WID_STORAGE_TOKEN_STACK_SIZE=11. 

3. Save and close the file. 

4. Restart the web application server. 

Prevent Users from Using Outdated Tokens 
To prevent users from using outdated tokens, set the logontoken.enabled parameter in the web.xml file. 

To modify the web.xml file appropriately, follow these steps: 

1. Locate the web.xml file at C:\Program Files(x86)\Business 
Objects\Tomcat55\webapps\InfoViewApp\WEB-INF\web.xml. 

2. Find the logontoken phrase and change the parameter value from true to false. 

<context-param> 

<param-name>logontoken.enabled</param-name> 

<param-value>false</param-value> 

</context-param> 

3. Save and close the file. 

4. Restart the web application server to apply the changes. 
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Handling BusinessObjects Services 
The standard BusinessObjects Enterprise installation has several services that are set up to start 
automatically. For this reason, the server startup is slower. However, if you do not need all of the 
services, the following information explains how to change the startup type on some of them, including: 

 Changing the start-up type 

 Removing Performance Manager 

Change Start-Up Type 
To change the start-up type, follow these steps: 

1. Click the Windows Start button, then click All programs » SAP Business Intelligence » SAP 
BusinessObjects BI platform 4 » Central Configuration Manager » Manage Servers. 

 

2. Log in to the CMS. 

A list of the BusinessObjects servers is displayed. 
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3. You might want to stop the following list of servers and change their startup type to Manual in 
their properties: 

 Crystal Reports Cache Server 

 Crystal Reports Job Server 

 Crystal Reports Processing Server 

 Desktop Intelligence Cache Server 

 Desktop Intelligence Job Server 

 Desktop Intelligence Processing Server 

Remove Performance Manager 
To restrict access to Performance Manager, follow these steps: 

1. Click the Windows Start button, then click All programs » SAP Business Intelligence » SAP 
BusinessObjects BI platform 4 » SAP » BusinessObjects Enterprise Central Management 
Console. 
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2. Click the Applications tab. 

 

3. Right-click Performance Management. 

 

4. Choose a group and click Assign Security. 
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5. Click the Advanced tab, and then click add/remove rights. 

 

6. Clear all options, including Use Performance Management. 

7. Click Apply and then click OK to save your entries. 
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Use a Non-Standard Web Server Port 
If the port specified for the Tomcat server is already in use, you cannot log in to InfoView. You must 
reconfigure the Tomcat server by changing the port number in …\Tomcat\conf\server.xml under the 
Connector tag and restart the Apache Tomcat service. 

To avoid this issue, follow these steps: 

1. Open a Command Prompt and enter the following: 

netstat -a > netstat.txt 

This displays an etstat.txt text file in the current directory that contains, among other information, 
a list of the port numbers that are currently in use. 

2. Open this text file and search for 8080. 

3. If 8080 is already in use, insert a unique number and use that port number, instead of 8080, 
throughout this section. 
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Set Templates for Web Intelligence 
You must change the template for Webl when there is a new document. This is not an option for existing 
documents. The Maconomy standards are implemented in the defaultConfig.xml released file. 

To set templates for WebI, follow these steps: 

1. Make a backup copy of the AnalyticalReporting.war file from (default) C:\Program 
Files\Business Objects\BusinessObjects Enterprise 12.0\java\applications. 

2. Open the AnalyticalReporting.war file and replace the three versions of defaultConfig.xml with 
the changed versions. Note the original paths: 

 webiApplet\AppletConfig\defaultConfig.xml 

 webiApplet\AppletConfig\AppletConfig\defaultConfig.xml 

 WEB-INF\classes\defaultConfig.xml 

3. From services, Stop tomcat. 

4. From a command-line prompt, change the current directory to C:\Program Files\Business 
Objects\deployment. 

5. Enter the command wdeploy tomcat55 predeployall. 

6. If no errors are displayed, enter the command wdeploy tomcat55 deployall. 

7. From services, Start tomcat. 

8. Create a WebI document to check the template’s performance. 

9. Restart the server if necessary. 

Enabling Cache and Pre-Load of Cache in ETL 
Enabling cache on ETL effectively improves the load speed of both incremental and full loads in the data 
warehouse. It stores the values of keys that had been looked up at least once and returns these values 
the next time that these are looked up again. This reduces the need to do a database call every time a 
lookup step is processed. 

 

You can enable cache: 

 Manually 

 Using an SQL Script 

Enable Caching Manually 

To enable caching manually, follow these steps: 

1. Open the transformations that contain dimensional  or database lookup  steps. 

2. Right-click the lookup step and select Edit Step or double click it. 

3. Select the Enable the cache? check box. 

Note: Cache uses memory to store the looked-up key, and you risk running out of memory when it 
is enabled on very large tables. 
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4. If Pre-load the cache? is enabled, select it as well. This check box is disabled if the Update the 
dimension? check box is selected. 

5. Set Cache size in rows to 0 to enable caching of all rows. 

6. Click OK to apply changes. 

7. Apply these changes to all other lookup steps except Pre-load the cache? on TASK_ID because 
this is typically a very large table and will result in an out of memory error. Set Cache size in 
rows to 1 for this lookup and then append ORDER BY TASK_LIST, TASK_NAME on the SQL 
statement of the Table Input step. TASK_ID lookup step is present on the following 
transformations: 

 Job Entry 

 Purchase Order Line 

 Job Invoice Line 

 Budget Entry 

 Finance Entry 

 Job Budget Line 
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Enable Caching Using an SQL Script 
Another way to enable the cache and pre-load the cache is by using an SQL script. 

To enable caching using an SQL script, complete the following steps: 

1. Log in to the database repository for your ETL and run the following SQL statements. 

-- enables cache for Dimensional Lookup steps except TASK_ID 

UPDATE R_STEP_ATTRIBUTE 

SET VALUE_NUM = 0, VALUE_STR = NULL 

WHERE ID_STEP_ATTRIBUTE IN ( 

SELECT ID_STEP_ATTRIBUTE 

FROM R_STEP_ATTRIBUTE 

WHERE ID_STEP IN ( 

SELECT ID_STEP 

  FROM R_STEP 

  WHERE ID_STEP_TYPE IN 

   (SELECT ID_STEP_TYPE 

      FROM R_STEP_TYPE 

     WHERE CODE IN ('DimensionLookup')) AND 

     NAME <> 'TASK_ID') AND 

CODE IN ('cache_size') 

); 

--enables pre-load cache for Dimensional Lookups except TASK_ID 

UPDATE R_STEP_ATTRIBUTE 

SET VALUE_STR = 'Y' 

WHERE ID_STEP_ATTRIBUTE IN ( 

SELECT ID_STEP_ATTRIBUTE 

FROM R_STEP_ATTRIBUTE 

WHERE ID_STEP IN ( 

SELECT ID_STEP 

  FROM R_STEP 

  WHERE ID_STEP_TYPE IN 

   (SELECT ID_STEP_TYPE 

      FROM R_STEP_TYPE 

     WHERE CODE IN ('DimensionLookup')) AND 

     NAME <> 'TASK_ID') AND 

     CODE IN ('preload_cache') 

); 

--set cache-size to 1 for Dimensional Lookup TASK_ID 

UPDATE R_STEP_ATTRIBUTE 

SET VALUE_NUM = 1, VALUE_STR = NULL 

WHERE ID_STEP_ATTRIBUTE IN ( 

SELECT ID_STEP_ATTRIBUTE 

FROM R_STEP_ATTRIBUTE 

WHERE ID_STEP IN ( 

SELECT ID_STEP 

  FROM R_STEP 

  WHERE ID_STEP_TYPE IN 

   (SELECT ID_STEP_TYPE 

      FROM R_STEP_TYPE 

     WHERE CODE IN ('DimensionLookup')) AND 

     NAME = 'TASK_ID') AND 

     CODE IN ('cache_size') 

); 

--disables pre-load cache for TASK_ID Dimensional Lookup steps 

UPDATE R_STEP_ATTRIBUTE 

SET VALUE_NUM = 0, VALUE_STR = 'N' 

WHERE ID_STEP_ATTRIBUTE IN ( 

SELECT ID_STEP_ATTRIBUTE 
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FROM R_STEP_ATTRIBUTE 

WHERE ID_STEP IN ( 

SELECT ID_STEP 

  FROM R_STEP 

  WHERE ID_STEP_TYPE IN 

   (SELECT ID_STEP_TYPE 

      FROM R_STEP_TYPE 

     WHERE CODE IN ('DimensionLookup')) AND 

     NAME = 'TASK_ID') AND 

     CODE IN ('preload_cache') 

); 

--enables cache for Database Lookup Steps (VALUE_STR = 'Y') 

UPDATE R_STEP_ATTRIBUTE 

SET VALUE_STR = 'Y' 

WHERE ID_STEP_ATTRIBUTE IN ( 

SELECT ID_STEP_ATTRIBUTE 

FROM R_STEP_ATTRIBUTE 

WHERE ID_STEP IN ( 

SELECT ID_STEP 

  FROM R_STEP 

  WHERE ID_STEP_TYPE IN 

   (SELECT ID_STEP_TYPE 

      FROM R_STEP_TYPE 

     WHERE CODE IN ('DBLookup'))) AND 

CODE IN ('cache') 

); 

--set cache size to 0 for Database Lookup Steps (VALUE_NUM = 0) 

UPDATE R_STEP_ATTRIBUTE 

SET VALUE_NUM = 0, VALUE_STR = NULL 

WHERE ID_STEP_ATTRIBUTE IN ( 

SELECT ID_STEP_ATTRIBUTE 

FROM R_STEP_ATTRIBUTE 

WHERE ID_STEP IN ( 

SELECT ID_STEP 

  FROM R_STEP 

  WHERE ID_STEP_TYPE IN 

   (SELECT ID_STEP_TYPE 

      FROM R_STEP_TYPE 

     WHERE CODE IN ('DBLookup'))) AND 

CODE IN ('cache_size') 

); 

COMMIT; 

After running the provided SQL statement, commit the changes. Then you must manually update 
transformations that contain TASK_ID (see step 7 on how manually enable cache.) 

Servers with Low Memory (RAM)  
Pentaho Data Integration 5.4 has a high memory consumption. This is due to Pentaho Data Integration 
5.4 installation, as well as installing Tomcat 6 as a necessary component to run the Data Integration 
Server. However, it consumes a steadily increasing amount of memory, which could be detrimental to 
systems with low memory. 

Data Integration Server is mainly used for scheduling, execution, security, and content management. 
Since Deltek currently uses a different method of scheduling ETL loads, you can disable it. 

 
Note: This process is optional and is only necessary for servers with low memory (RAM). 
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To disable Data Integration Server, complete the following steps: 

1. Click Start, then type Services.msc. 

2. The Services window is displayed. Locate a service called Data Integration Server. 

 

3. Right-click and select Properties. The Date Integration Server Properties dialog is displayed. 

4. In the Startup type field, change the selection to Manual so that the service does not run 
automatically when you restart the system. 

 

5. Click Stop to disable the service, then OK. 
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Burst Publishing 
Burst Publishing is the ability to schedule documents to refresh and then automatically distribute them out 
to receivers. The main benefit is that the recipients (Maconomy users) can get the refreshed documents 
automatically in their in boxes, and that the documents are only run once. 

For information about how to set up burst publishing of documents in SAP BusinessObjects, see 
http://scn.sap.com/docs/DOC-56056 

  

http://scn.sap.com/docs/DOC-56056
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Materialized Views on Oracle 
A materialized view on Oracle is a database view that is stored physically and provides a view on which 
indexes and keys can be defined. BPM Reporting uses one materialized view in the Job Information 
universe because the Maconomy transaction database lacks a table that combines job entries (JobEntry) 
with corresponding invoice lines (JobInvoiceLine). 

This section describes how materialized views on Oracle work and how to manage them. 

JobEntryJobInvoiceLinePV 
The materialized view that is used in BPM Reporting is called JobEntryJobInvoiceLinePV. It consists of 
the following elements: 

 Two view logs, one on JobEntry and one on JobInvoiceLine 

 Materialized view JobEntryJobInvoiceLinePV 

 EX view EXJobEntryJobInvoiceLinePV 

When records change in the JobEntry table, the changes are recorded in the view log. Similarly, if records 
are inserted or deleted, changes are recorded in the JobInvoiceLine table. 

The Materialized View 
The materialized view is set to update on commit. This means that when a transaction changes, inserts, 
or deletes records in JobEntry or JobInvoiceLine, the changes that are recorded in the view logs are 
transferred as changes that update the materialized view. The view is designed to perform a fast refresh 
because only delta changes are considered; it is not the whole view that is updated. In addition, the view 
does not use the query rewrite mechanism in Oracle. 

The EX View 
The EX view is a database view that is on top of the materialized view. The EX view provides meaningful 
values for pop-up numbers (enumerated data types) and date values of data types (in addition to the 
string format). 

For technical reasons, the date definitions are done in the materialized views, and only pop-up value 
fields are handled in the EX views (in other EX views, date fields are also handled in the EX views). 

Explain the View Definition 
This section provides the view definition file and explains what each statement does. 



Materialized Views on Oracle 

BPM Admin Guide 191 

 

Statement/Section Definition 

ALTER SYSTEM SET "_mv_refresh_use_stats =TRUE"

  
This statement tells Oracle to use statistics 
when refreshing materialized views. 

CREATE MATERIALIZED VIEW LOG ON JOBENTRY This statement creates the view log on 
JobEntry. 

WITH ROWID The reference of ROWID is important 
because it is used for unique identification. 

INCLUDING NEW VALUES;       

  

CREATE MATERIALIZED VIEW 

JOBENTRYJOBINVOICELINEPV  

This statement creates the actual 
materialized view. 

REFRESH ON COMMIT AS   This is the definition of “refresh on commit.” 

SELECT 

 

This statement starts the select statement 
that defines the view. 

  -- Technical fields   

  JOBENTRY.ROWID JOBENTRYROWID  

Both parts of the union that make the select 
statement use the ROWID internally for 
unique identification. 

,NULL JOBINVOICELINEROWID   

    ,1 MARKER  

This field is used to distinguish the upper 
and lower union parts. 

-- Shared Dimensions    

  ,JOBENTRY.INSTANCEKEY  

This starts the field list. 

 

CREATE VIEW EXJOBENTRYJOBINVOICELINEPV AS 

: 

SELECT  

  INSTANCEKEY 

   ,JOBNUMBER  

 ,ENTRYNUMBER 

This defines the EX view on the 
materialized view. 

Check the Materialized View 
Use the following select statements to check the view. 

SELECT MVIEW_NAME, REFRESH_MODE, REFRESH_METHOD, LAST_REFRESH_TYPE, LAST_REFRESH_DATE 

FROM USER_MVIEWS; 

This lists a record for the materialized view that is defined. The last_refresh_date provides the date 
when the view was last refreshed, and the other fields indicate how it was refreshed. 

SELECT LOG_OWNER, MASTER, LOG_TABLE FROM DBA_MVIEW_LOGS; 

This lists two records, one for each view log. 

SELECT COUNT(*) FROM MLOG$_JOBENTRY; 

SELECT COUNT(*) FROM MLOG$_JOBINVOICELINE; 
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These statements display the number of changes currently recorded in the view logs. Under normal 
circumstances, they should display zero. If they do not, it is because they currently store changes that are 
not transferred to the materialized view. 

If it appears that the preceding tables are not emptied at any time, it can be because the materialized 
view is not able to empty them as it should. One reason can be that more than the two view logs have 
been installed, but without the corresponding materialized views to empty them. 

To check that _mv_refresh_use_stats system parameter is set up, use the following command: 

SHOW PARAMETER _mv_refresh_use_stats; 

It should display the following. 

NAME                  TYPE    VALUE 

————————————————————— ——————— —————— 

_mv_refresh_use_stats boolean TRUE 

If no data is displayed, the parameter is not set up. 

Flush the Shared Pool 
Over time, SQL statements for updating the materialized view compile in the shared pool. This is a known 
issue in Oracle and requires that you empty the shared pool. A stored procedure has been developed for 
flushing the shared pool every night. 

 

To check that the flushing procedure runs as expected, execute the following command. FAILED should 
be zero and BROKEN should be “N.” 

select job, what, last_date, next_date, failures, broken from dba_jobs where what like 

'%maconomy_flush_shared_pool%'; 

To check that the flushing procedure cleaned the shared pool, execute the following command. If it is 
successful, it should return no entries. 

SELECT sql_text FROM v$sql WHERE sql_text LIKE '/* MV_REFRESH%'; 

Handling Issues 
If the Maconomy database performs poorly, it may be because of an incorrect installation of the 
materialized view. 

To resolve this issue, follow these steps: 

1. Run the select statements mentioned in Check the Materialized View. Check the results to find 
out whether the view is updated at all, and whether it is refreshed quickly. 

2. Run the select statements mentioned in Flush the Shared Pool to find out whether the stored 
procedure is not flushing correctly and how many entries there are in the shared pool. 

3. Drop the view. Use the drop statements of the view definition file. Start with dropping the actual 
materialized view and then drop the view logs. There is no need to drop the indexes. 

4. Apply the view again and check its installation. 

5. Install the flushing mechanism again and check its installation. 

Tip: See Performance Views for instructions on how to install the stored procedure. 

file:///C:/Users/jennifercarr/Documents/1_Maconomy/2.5.1/BPM%20Restructuring/DeltekMaconomyBPMInstallandStatutorySetupGuide.docx%23_Check_the_Materialized
file:///C:/Users/jennifercarr/Documents/1_Maconomy/2.5.1/BPM%20Restructuring/DeltekMaconomyBPMInstallandStatutorySetupGuide.docx%23_Flush_the_Shared
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TROUBLESHOOTING 

Determine BPM Version and Solution 
The internal version number, the external version number, and the solution appear in universes and 
documents of a BPM release. In universes, the version numbers and solution are stated as custom 
properties of the data foundations (DFX files). In documents, they are stated in variables. 

The format of internal version numbers is: 

<version>.<sub-version>.<service pack>.<fix pack> 

For example: 17.0.102.0 

Problem with Login to Infoview through the Portal 
You cannot log in to BusinessObjects in the Portal using Internet Explorer (ID). The Login screen is 
displayed, but nothing happens when you try to log in (you stay on the same page). Instead, you can log 
in directly in infoview. 

The reports are embedded into the Maconomy Portal using IFrame. IE gives a lower level of trust to 
IFRAME pages (IE calls this "third-party" content). If the page inside the IFRAME does not have a Privacy 
Policy, its cookies are blocked. This is indicated by the eye icon in the status bar. When you click this 
icon, it lists the blocked URLs. The cookies are used to store the BusinessObjects session. Because the 
session cannot be saved, the user cannot log in. 

To resolve the login problem, follow these steps: 

1. Create a folder named w3c in [Business Objects]\Tomcat55\webapps\ 

2. Create a file called p3p.xml in the same folder with the following code: 

<META> 

<POLICY-REFERENCES> 

<POLICY-REF about="/w3c/policy.xml"> 

<INCLUDE>/</INCLUDE> 

<COOKIE-INCLUDE/> 

</POLICY-REF> 

</POLICY-REFERENCES> 

</META> 

 

 

 

 

Note: This procedure does not work when you use an IP instead of a server name in the 
OpenDocument link. 



 

 

About Deltek 
Better software means better projects. Deltek is the leading global provider of enterprise software and 
information solutions for project-based businesses. More than 23,000 organizations and millions of users 
in over 80 countries around the world rely on Deltek for superior levels of project intelligence, 
management and collaboration. Our industry-focused expertise powers project success by helping firms 
achieve performance that maximizes productivity and revenue. www.deltek.com 
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